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Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your 
Xerox® printer. 

 
 

 1 Safety 



Safety 

 

10 WorkCentre 7500 Series Multifunction Printer 
 User Guide 
 

Notices and Safety 

Please read the following instructions carefully before operating your printer. Refer to these instructions 
to ensure the continued safe operation of your printer. 

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These 
include safety agency evaluation and certification, and compliance with electromagnetic regulations and 
established environmental standards. 

The safety and environment testing and performance of this product have been verified using Xerox® 
materials only. 

Note: Unauthorized alterations, which can include the addition of new functions or connection of 
external devices, can affect the product certification. Please contact your Xerox® representative for 
more information. 

 
 

General Guidelines 
 

 WARNINGS:  

 Do not push objects into slots or openings on the printer. Touching a voltage point or 
shorting out a part could result in fire or electrical shock. 

 Do not remove the covers or guards that are fastened with screws unless you are 
installing optional equipment and are instructed to do so. Turn off the printer when 
performing these installations. Disconnect the power cord when removing covers and 
guards for installing optional equipment. Except for user-installable options, there are 
no parts that you can maintain or service behind these covers. 
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Electrical Safety 

Power Cord 
 Use the power cord supplied with your printer. 

 Plug the power cord directly into a properly grounded electrical outlet. Make sure that each end of 
the cord is securely connected. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

 Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

 

 WARNING: Avoid the potential of electrical shock by ensuring that the printer is properly grounded. 
Electrical products can be hazardous if misused. 

 

 Do not use an extension cord or power strip. 

 Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

 Do not place the printer in an area where people can step on the power cord. 

 Do not place objects on the power cord. 
 

Emergency Turn Off 

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord 
from the electrical outlet. Contact an authorized Xerox® Service Representative to correct the problem: 

 The equipment emits unusual odors or makes unusual noises. 

 The power cable is damaged or frayed. 

 A wall panel circuit breaker, fuse, or other safety device has been tripped. 

 Liquid is spilled into the printer. 

 The printer is exposed to water. 

 Any part of the printer is damaged. 
 

Telephone Line Cord 
 

 CAUTION: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger 
telecommunication line cord. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Printer Location 
 Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer. 

 Place the printer in an area where there is adequate space for operation and servicing. 

 Place the printer in a dust-free area. 

 Do not store or operate the printer in a hot, cold, or humid environment. 

 Place the printer on a level, solid non-vibrating surface with adequate strength to hold the weight of 
the product. The base printer weight without any packaging materials is approximately 140.2 Kg 
(308.4 lb.) 

 Do not place the printer near a heat source. 

 Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 

 Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 
system. 

 

Operational Guidelines 
 Do not remove the paper source tray that you selected in either the print driver or control panel while 

the printer is printing. 

 Do not open the doors when the printer is printing. 

 Do not move the printer when it is printing. 

 Keep hands, hair, neckties, and so on away from the exit and feed rollers. 

 Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 
the protective covers. 

 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox® representative or go to www.xerox.com/environment_europe. 
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Printer Supplies 
 Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 

 Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 

 Store all consumables in accordance with the instructions given on the package or container. 

 Keep all consumables away from the reach of children. 

 Never throw toner, print/drum cartridges, or toner containers into an open flame. 

 When handing cartridges, for example toner, fuser, and such, avoid skin or eye contact. Eye contact 
can cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can 
increase the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of 
performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this 
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage 
could vary outside these areas. Please contact your Xerox representative for details. 
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Maintenance Safety 

 Do not attempt any maintenance procedure that is not specifically described in the documentation 
supplied with your printer. 

 Do not use aerosol cleaners. Clean with a dry lint-free cloth only. 

 Do not burn any consumables or routine maintenance items. For information on Xerox® supplies 
recycling programs, go to www.xerox.com/gwa. 
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Printer Symbols 

Symbol Description 

 

Warning or Caution: 
Ignoring this warning could cause serious injury or even death. 
Ignoring this caution could cause injury or damage to property. 

 

Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Do not burn the waste toner container. 

 

Do not expose the drum cartridge to light for more than 10 minutes. 

 

Do not touch the drum cartridge. 

 

Hot surface. Wait the indicated time before handling. 

 

Warning: 
Moving parts. Use caution to avoid personal injury. 
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox® product and supplies, 
contact the following customer help lines: 

United States: 1-800 828-6571 

Canada: 1-800 828-6571 

Europe: +44 1707 353 434 

For product safety information in the United States, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
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1. Adjuster foot 

2. Tray 5 (bypass tray) 

3. Left Tray 

4. USB port 

5. Document cover 

6. Document glass 

7. Control panel 

8. Center tray 

9. Center bottom tray 

10. Power switch 

11. Front cover 

12. Tray 1 and optional trays 2–4 

13. Locking casters 

 
 

Control Panel 

The control panel consists of a USB port, the touch screen, and buttons you press to control the functions 
available on the printer. The control panel: 

 Displays the current operating status of the printer. 

 Provides access to copy, print, scan, and fax features. 

 Provides access to information pages. 

 Prompts you to load paper, replace supplies, and clear jams. 
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 Displays errors and warnings. 

 Connects to a USB Flash Drive for scan and print access. 
 

65 7 8 9 10

1617

11

1
2
3
4

12
13
14

15  
1. Machine Status displays the status of the printer on the touch screen. 

2. Job Status displays lists of the active or completed jobs on the touch screen. 

3. Services provides access to the options for the selected copy, scan, or fax function on the touch 
screen. 

4. USB port provides USB Flash Drive connection for storage use in Scan to USB and Print from USB 
functions. 

5. Services Home provides access to printer features, such as copy, scan, and fax, on the touch screen. 

6. Touch Screen displays information, and provides access to printer functions. 

7. Log In/Out provides access to password-protected features. 

8. Help displays information about the current selection on the touch screen. 

9. Language changes the touch screen language and keyboard settings. 

10. Energy Saver enters and exits the low-power mode. 

11. Interrupt Print interrupts and resumes the current print, copy, or fax job. 

12. Clear All resets to the default settings, if pressed once, and displays the first screen for the current 
selection. If pressed twice, Clear All resets all the features to their default settings. 

13. Stop temporarily stops the current job. Follow the onscreen message to cancel or resume your job. 

14. Start starts the selected copy, scan, fax, or Print From job, such as Print from USB. 

15. Alphanumeric keypad enters alphanumeric information. 

16. C (clear) deletes numeric values or the last digit entered using the alphanumeric keys. 

17. Dial Pause inserts a pause in a telephone number when transmitting a fax. 
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Left-Rear View 
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1. Circuit breaker 

2. SIM slot 

3. Status indicator lights 

4. Ethernet connection 

5. USB memory card connections 

6. USB connection 

7. Fax connections (optional) 

8. Top left cover D release button 

9. Top left cover A release button 

10. Duplex unit cover B release button 

11. Bottom left cover C release lever 

 
 

Document Feeder 

1

2 3 4 65
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1. Confirmation indicator 

2. Top cover 

3. Inner cover release lever 

4. Inner cover 

5. Document guides 

6. Document feeder tray 

7. Document output tray 

8. Document glass 
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Internal Components 
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1. Second bias transfer roll 

2. Fuser assembly 

3. Drum cartridge release lever 

4. Toner cartridges 

5. Main power switch 

6. Transfer belt cleaner 

7. Waste toner container 

8. Drum cartridges 

9. Drum cartridge cover 

 
 

Office Finisher LX 

12

4
3
2

1
14

13

5

6

7

8
9
10
11
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1. Front transport cover 

2. Hole punch waste container 

3. Hole punch unit (optional) 

4. Center tray 

5. Right tray extension 

6. Booklet maker (optional) 

7. Booklet maker side cover (optional) 

8. Booklet maker staple cartridge (optional) 

9. Finisher top cover 

10. Right tray 

11. Creaser unit 

12. Staple cartridge 

13. Finisher front cover 

14. Office Finisher LX 

 
 

Professional Finisher 

89

6

7

2 3 41 5

 

1. Center tray 

2. Finisher front cover 

3. Right top tray 

4. Exit cover 

5. Right middle tray 

6. Staple cartridge 

7. Booklet maker bin 

8. Booklet staple unit 

9. Booklet maker unit 
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Information Pages 

Your printer has a printable set of information pages stored on its internal hard drive. Information pages 
include configuration and font information, demonstration pages, and more. 

1. At the printer control panel, press the Machine Status button. 

2. On the Machine Information tab, touch Information Pages, then touch the desired information 
page. 

3. Touch Print. 
 

Note: Information pages can also be printed from CentreWare Internet Services. 
 
 

Printing the Configuration Report 
1. At the printer control panel, press the Machine Status button. 

2. On the Machine Information tab, touch Information Pages > Configuration Report > Print. 

3. Touch Close after the report prints. 
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Energy Saver Mode 

You can set the time the printer spends idle in ready mode before the printer transitions to a lower power 
level. 

1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 

2. Touch Device Settings > General > Energy Saver. 

3. Touch an option: 

 Intelligent Ready: The printer wakes and sleeps based on previous usage. 

 Job Activated: The printer wakes when it detects activity. 

 Scheduled: The printer wakes and sleeps according to a schedule you specify. 

4. Under Fast Resume, touch On to reduce the wake time. This option changes the default sleep and 
low-power timeout periods, and increases energy usage. 

5. If you selected Scheduled as the Energy Saver Mode, touch Scheduled Settings to select the times 
that you want the printer to wake or sleep. 

6. Touch a day of the week in the list. 

7. Under Schedule Based On, touch Activity to allow the printer to wake on activity for that day. Touch 
Time to wake the printer at a certain time. 

8. If you selected Time, touch Warm Up Time, and select the time that the printer wakes on that day. 
Touch Energy Saver Time, and select the time that the printer sleeps on that day. 

9. Touch Save. 
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Administration Features 

This section includes: 

 CentreWare Internet Services......................................................................................................................................... 25

 Billing and Usage Information ....................................................................................................................................... 25

 Accounting .............................................................................................................................................................................. 26

For details, see the System Administrator Guide at www.xerox.com/office/WC75xxdocs. 

 
 

CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

CentreWare Internet Services requires: 

 A TCP/IP connection between the printer and the network in Windows, Macintosh, or UNIX 
environments. 

 TCP/IP and HTTP enabled in the printer. 

 A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in CentreWare Internet Services or the System Administrator Guide. 
 

Accessing CentreWare Internet Services 

At your computer, open a Web browser, type the IP address of the printer in the address field, then press 
Enter or Return.  
 

Finding the IP Address of the Printer 

1. At the printer control panel, press the Machine Status button. 

2. On the Machine Information tab, touch Information Pages > Configuration Report > Print. 

3. Touch Close after the report prints. 

The IP address of the printer appears in the Common User Data section of the report, in the upper 
left of the page. 

 

Billing and Usage Information 

Billing and printer usage information appears on the Billing Information screen. 
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1. At the printer control panel, press the Machine Status button. 

2. Touch the Billing Information tab to see basic impression counts. 

3. Touch Usage Counters, then touch the Impression Counters drop-down list to see detailed usage 
information. 

4. Touch Close. 
 
 

Accounting 

Accounting allows you to track billing and the amount of copy, print, scan, and fax jobs for each user. All 
jobs require authentication of User ID and Account ID. The system administrator must create user 
accounts and enable the Accounting feature. 

For details, see the System Administrator Guide at www.xerox.com/office/WC75xxdocs. 
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Xerox® Welcome Center 

If you need assistance during or after printer installation, visit the Xerox® website for online solutions and 
support at www.xerox.com/office/worldcontacts. 

If you require further assistance, contact the experts at the Xerox® Welcome Center. If a local 
representative telephone number was provided during printer installation, record the telephone number 
in the following space. 

#_________________________________ 

Xerox® Canada Welcome Center: 1-800-93-XEROX (1-800-939-3769) 

If you need additional help using your printer: 

1. Refer to this User Guide. 

2. Contact the Key Operator. 

3. Visit our customer website at www.xerox.com/office/WC75xxsupport. 

The Welcome Center wants to know the following information: 

 The nature of the problem. 

 The serial number of the printer. 

 The fault code. 

 The name and location of your company. 
 

Locating the Serial Number 

You need the printer serial number to order supplies or to contact Xerox® for assistance. The serial 
number is located on the left side of the printer frame under cover A. The serial number also appears on 
the control panel. Press the Machine Status button to view the serial number on the control panel. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with printer 

Quick Use Guide Packaged with printer 

System Administrator Guide www.xerox.com/office/WC75xxdocs  

Video Tutorials www.xerox.com/office/WC75xxdocs  

Recommended Media List United States: www.xerox.com/paper  
Europe: www.xerox.com/europaper  

Technical support information for your printer; includes 
online Technical Support, Online Support Assistant, and 
driver downloads. 

www.xerox.com/office/WC75xxsupport  

Information about menus or error messages Control panel Help (?) button 

Information pages Print from the control panel menu 

Order supplies for your printer www.xerox.com/office/WC75xxsupplies  

A resource for tools and information, such as interactive 
tutorials, printing templates, helpful tips, and customized 
features to meet your individual needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and support center www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
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This chapter includes: 

 Installation and Setup Overview ................................................................................................................................... 30

 Installing the Software ...................................................................................................................................................... 32
 

See also:  

Installation Guide packaged with your printer. 

System Administrator Guide at www.xerox.com/office/WC75xxdocs. 
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Installation and Setup Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected to an active 
network. The system administrator must configure the initial settings of the printer before installing the 
driver software. The driver software and utilities must be installed on your computer. 

For details on configuring the printer network settings, see the System Administrator Guide at 
www.xerox.com/office/WC75xxdocs. 
 

Physical Connection 

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is 
used for one or more computers and supports many printers and systems simultaneously. An Ethernet 
connection is typically faster than a USB connection and provides direct access to printer settings using 
CentreWare Internet Services. 

To connect the printer: 

1. Connect the power cord to the printer, and plug the cord into an electrical outlet. 

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer. 
Connect the other end of the Ethernet cable to the network port. 

3. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the printer and to a 
functioning telephone line to support Faxing. 

 
 

Turning the Printer On 

This printer has two power switches. The switch located on the top of the printer, beneath the control 
panel, controls power only to the electronic components of the printer. The second switch, located behind 
the front cover, controls the power into the printer. Turn on both switches to operate the printer. First turn 
on the power switch behind the front cover, then turn on the top switch. 
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Initial Printer Setup 

Make sure that the printer is set up before installing the printer software. Setup includes enabling the 
optional features and assigning an IP address for the Ethernet network connection. If the printer has not 
been previously turned on and configured, see the System Administrator Guide at 
www.xerox.com/office/WC75xxdocs. 
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Installing the Software 

This section includes: 

 Operating System Requirements .................................................................................................................................. 32

 Installing Drivers and Utilities for Windows ............................................................................................................. 32

 Installing Drivers and Utilities for Macintosh OS X Version 10.4 and Later ............................................... 33

 Installing Drivers and Utilities for UNIX and Linux ............................................................................................... 34

 Other Drivers .......................................................................................................................................................................... 35

Before installing driver software, verify that the printer is plugged in, turned on, connected to an active 
network, and has a valid IP address. Ask the system administrator if you do not know the IP address, or 
see Finding the IP Address of the Printer on page 25. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/WC75xxdrivers. 

 
 

Operating System Requirements 
 Windows XP SP1, Windows Vista, Windows Server 2003 or later 

 Macintosh OS X version 10.4 or later 

 UNIX and Linux: Your printer supports connection to a variety of UNIX platforms through the 
network interface. For details, see www.xerox.com/office/WC75xxdrivers. 

 

Installing Drivers and Utilities for Windows 

Install the Xerox® print driver and the Xerox® scan driver to access all the features of your printer. 

To install the print and scan driver software: 
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1. Insert the Software and Documentation disc into the appropriate drive on your computer. The 
installer starts automatically. If the installer does not start, navigate to the drive on your computer 
and double-click Setup.exe. 

2. To change the language, click Language, select your language, then click OK. 

3. Click Install Drivers, then click Install Print and Scan Drivers. 

4. Click Agree to accept the license agreement. 

5. Select your printer from the list of discovered printers, then click Install. 

6. If your printer does not appear in the list of discovered printers, click Extended Search. 

7. If the printer still does not appear in the list of discovered printers, and you know the IP address: 

a. Click the Network Printer Icon (right) at the top of the gray window. 

b. Enter the IP Address or the DNS name for the printer. 

c. Click Search, then select your printer from the list of discovered printers. 

d. Click Next when the printer appears in the window. 

8. If the printer still does not appear in the list of discovered printers, and you do not know the IP 
address: 

a. Click Advanced Search. 

b. If you know the gateway address and subnet mask, click the top button and enter the addresses 
into the Gateway and Subnet Mask fields. 

c. If you know the IP address of another printer on the same subnet, enter the address in the IP 
Address field. 

d. Click Search, then select your printer from the list of discovered printers. 

e. Click Next when the printer appears in the window. 

9. Select the desired print driver: 

 PostScript (recommended) 

 PCL 5 

 PCL 6 

 XPS 

10. Select the desired scan driver: 

 TWAIN 

 WIA 

 Enable Xerox® Scan Utility 

11. Click Install. 

12. Click Finish when the installation completes. 
 
 

Installing Drivers and Utilities for Macintosh OS X Version 10.4 and Later 

Install the Xerox® print driver and the Xerox® scan driver to access all the features of your printer. 

To install the print and scan driver software: 
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1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

2. Open the Mac folder, then open Mac OS 10.4+Universal PS folder. 

3. Open Xerox® WorkCentre WC75xx CD.dmg. 

4. Double-click to run WorkCentre WC75xx CD.mpkg. 

5. Click Continue for the next three windows. 

6. Click Agree to accept the license agreement. 

7. Click Install to accept the current installation location, or select another location for the installation 
files, then click Install. 

8. Enter your password, then click OK. 

9. Select your printer in the list of discovered printers, then click Continue. 

10. If your printer does not appear in the list of discovered printers: 

a. Click the Network Printer Icon. 

b. Type the IP address of your printer then click Continue. 

c. Select your printer in the list of discovered printers, then click Continue. 

11. Click OK to accept the print queue message. 

12. Select or clear the Set Printer as Default and Print a Test Page check boxes. 

13. Click Continue, then click Close. 
 

Note: The printer is automatically added to the printer queue in Macintosh OS X version 10.4 and 
later. 

 

To verify the installation of printer options with the print driver: 

1. From the Apple menu, open System Preferences > Print & Fax. 

2. Select the printer in the list, then click Options and Supplies. 

3. Click Driver, then confirm that your printer is selected. 

4. Confirm that all of the options installed on the printer appear correct. 

5. If you change settings, click Apply Changes, close the window, and quit System Preferences. 
 
 

Installing Drivers and Utilities for UNIX and Linux 

Xerox® Services for UNIX Systems is a two part installation process. It requires the installation of a Xerox® 
Services for UNIX Systems code package and a printer support package. The Xerox® Services for UNIX 
Systems code package must be installed before installing the printer support package. 
 

Note: You must have root or superuser privileges to perform the UNIX print driver installation on your 
computer. 

 

1. At the printer, do the following: 

a. Verify that both the TCP/IP protocol and the proper connector are enabled. 

b. On the printer control panel, do one of the following for the IP address: 

 Allow the printer to set up a DHCP address. 

 Enter the IP address manually. 
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c. Print the Configuration Report and keep it for reference. For details, see Configuration Report on 
page 23. 

2. At your computer, do the following: 

a. Go to www.xerox.com/office/WC75xxdrivers and select your printer model. 

b. From the Operating System menu, select UNIX, then click Go. 

c. Select the Xerox® Services for UNIX Systems package for the correct operating system. This 
package is the core package and must be installed before the printer support package. 

d. Click the Start button to begin downloading. 

e. Repeat steps a and b, then click the printer package for use with the Xerox® Services for UNIX 
Systems package that you selected earlier. The second part of the driver package is ready for 
download. 

f. Click the Start button to begin downloading. 

g. In the notes below the driver package that you selected, click the link for the Installation Guide, 
then follow the installation instructions. 

 

Notes: 

 To load Linux print drivers, perform the preceding procedures but select Linux as the operating 
system. Select Xerox® Services for Linux Systems driver or the Linux CUPS Printing Package. 
You can also use the CUPS driver included in the Linux package. 

 Supported Linux drivers are available at www.xerox.com/office/WC75xxdrivers. 

 For details about UNIX and Linux drivers, see the System Administrator Guide at 
www.xerox.com/office/WC75xxdocs. 

 
 

Other Drivers 

The following drivers are available for download at www.xerox.com/office/WC75xxdrivers. 

 The Xerox® Global Print Driver works with any printer on your network, including those printers made 
by other manufacturers. It configures itself for your individual printer upon installation. 

 The Xerox® Mobile Express Driver™ works with any printer available to your computer that supports 
standard PostScript. It configures itself for the printer you select every time you print. If you travel 
frequently to the same sites, you can save your favorite printers in that location and the driver saves 
your settings. 
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This chapter includes: 

 Supported Paper ................................................................................................................................................................... 38

 Loading Paper ........................................................................................................................................................................ 44

 Printing on Special Paper .................................................................................................................................................. 52
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Supported Paper 

This section includes: 

 Recommended Media ........................................................................................................................................................ 38

 Ordering Paper ...................................................................................................................................................................... 38

 General Paper Loading Guidelines................................................................................................................................ 38

 Paper That Can Damage Your Printer ........................................................................................................................ 39

 Paper Storage Guidelines ................................................................................................................................................. 39

 Supported Paper Types and Weights .......................................................................................................................... 40

 Supported Standard Paper Sizes ................................................................................................................................... 40

 Supported Paper Types and Weights for Automatic 2-Sided Printing .......................................................... 41

 Supported Paper Sizes for Automatic 2-Sided Printing ....................................................................................... 42

 Supported Custom Paper Sizes ...................................................................................................................................... 42

 Supported Paper Sizes for the Envelope Tray .......................................................................................................... 43

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
to ensure the best print quality and to avoid jams. 

For best results, use Xerox® paper and media recommended for your printer. 

 
 

Recommended Media 

A list of paper and media recommended for your printer is available at: 

 www.xerox.com/paper Recommended Media List (United States) 

 www.xerox.com/europaper Recommended Media List (Europe) 
 

Ordering Paper 

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/WC75xxsupplies. 
 
 

General Paper Loading Guidelines 
 Use only recommended Xerox® transparencies; print quality could vary with other transparencies. 

 Do not print on label media once a label has been removed from a sheet. 

 Use only paper envelopes. Print envelopes 1-sided only. 

 Do not overload the paper trays. 

 Adjust the paper guides to fit the paper size. 
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage your 
printer. Do not use the following: 

 Rough or porous paper. 

 Inkjet paper. 

 Non-laser gloss or coated paper. 

 Paper that has been photocopied. 

 Paper that has been folded or wrinkled. 

 Paper with cutouts or perforations. 

 Stapled paper. 

 Envelopes with windows, metal clasps, side seams, or adhesives with release strips. 

 Padded envelopes. 

 Plastic media. 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 

 Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

 Reduce the exposure of paper to strong lights for long periods of time. 

 Maintain constant temperatures and relative humidity. 

 Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect 
moisture. 

 Store paper flat, either on pallets, cartons, shelves, or in cabinets. 

 Avoid having food or drinks in the area where paper is stored or handled. 

 Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored 
paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain. 

 Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 
you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Paper Types and Weights 
 

Trays Types and Weights 

Trays 1–6 Plain (60–105 g/m2) 
Plain Reload (60–105 g/m2) 
Bond (60–105 g/m2) 
Hole Punched (60–105 g/m2) 
Pre-Printed (60–105 g/m2) 
Letterhead (60–105 g/m2) 
Recycled (60–105 g/m2) 
Heavyweight (106–169 g/m2) 
Heavyweight Reload (106–169 g/m2) 
Gloss (106–169 g/m2) 
Gloss Reload (106–169 g/m2) 
Extra-Heavyweight (170–256 g/m2) 
Extra-Heavyweight Reload (170–256 g/m2) 
Heavyweight Gloss (170–256 g/m2) 
Heavyweight Gloss Reload (170–256 g/m2) 
Labels (106–169 g/m2) 
Transparency 

Tray 5 (bypass tray) and Envelope Tray (Tray 
1) only 

Envelopes 

Trays 5 (bypass tray) and Tray 6 
(High-Capacity Feeder) only 

Lightweight (55–59 g/m2) 

Tray 5 (bypass tray) only Extra Heavyweight Plus (257–300 gm2) 
Extra Heavyweight Plus Reload (257–300 g/m2) 
Extra Heavyweight Gloss (257–300 g/m2) 
Extra Heavyweight Gloss Reload (257–300 g/m2) 

 
 

Supported Standard Paper Sizes 
 

Tray Number European Standard Sizes North American Standard Sizes 

Printer Tray 1 A5 (148 x 210 mm) 
A4 (210 x 297 mm) 
A3 (297 x 420 mm) 
JIS B5 (182 x 257 mm) 
JIS B4 (257 x 364 mm) 

Statement (5.5 x 8.5 in.) 
Executive (7.25 x 10.5 in.) 
Letter (8.5 x 11 in.) 
US Folio (8.5 x 13 in.) 
Legal (8.5 x 14 in.) 
Tabloid (11 x 17 in.) 

Trays 2–4 of the 3-Tray A5 (148 x 210 mm) Statement (5.5 x 8.5 in.) 
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Module 
 

Tray 2 of the High-Capacity 
Tandem Tray Module 
 

Tray 2 of the 1-Tray Module 

A4 (210 x 297 mm) 
A3 (297 x 420 mm) 
JIS B5 (182 x 257 mm) 
JIS B4 (257 x 364 mm) 
SRA3 (320 x 450 mm) 

Executive (7.25 x 10.5 in.) 
Letter (8.5 x 11 in.) 
US Folio (8.5 x 13 in.) 
Legal (8.5 x 14 in.) 
Tabloid (11 x 17 in.) 
Tabloid Extra (12 x 18 in.) 

 

Trays 3 and 4 of the 
High-Capacity Tandem Tray 
Module 
 

Tray 6 of the High-Capacity 
Feeder 

A4 (210 x 297 mm) 
JIS B5 (182 x 257 mm)  

Executive (7.25 x 10.5 in.) 
Letter (8.5 x 11 in.) 

 

Tray 5 (bypass tray) only Postcard (100 x 148 mm) 
Postcard (148 x 200 mm) 
A6 (105 x 148 mm) 
A5 (148 x 210 mm) 
A4 (210 x 297 mm) 
A4 Oversized (223 x 297 mm) 
A3 (297 x 420 mm) 
JIS B6 (128 x 182 mm) 
JIS B5 (182 x 257 mm) 
215 x 315 mm 
JIS B4 (257 x 364 mm) 
SRA3 (320 x 450 mm) 
DL envelope (110 x 220 mm) 
C4 envelope (229 x 324 mm) 
C5 envelope (162 x 229 mm) 

Photo (3.5 x 5 in.) 
Postcard (3.5 x 5 in.) 
Postcard (4 x 6 in.) 
Postcard (5 x 7 in.) 
Postcard (6 x 9 in.) 
Statement (5.5 x 8.5 in.) 
8 x 10 in. 
Executive (7.25 x 10.5 in.) 
Letter (8.5 x 11 in.) 
9 x 11 in. 
US Folio (8.5 x 13 in.) 
Legal (8.5 x 14 in.) 
Tabloid (11 x 17 in.) 
Tabloid Extra (12 x 18 in.) 
12 x 19 in. 

 

 
 

Supported Paper Types and Weights for Automatic 2-Sided Printing 
  

Paper Types Weights 

Plain 
Bond 
Hole Punched 
Pre-Printed 
Letterhead 
Recycled 
Heavyweight 
Gloss 
Extra-Heavyweight 
Heavyweight Gloss 

60–105 g/m2 
60–105 g/m2 
60–105 g/m2 
60–105 g/m2 
60–105 g/m2 
60–105 g/m2 
106–169 g/m2 
106–169 g/m2 
170–220 g/m2 
170–220 g/m2 
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Notes: 

 Do not use Reload paper of any weight for automatic 2-sided printing. Reload is paper 
previously laser printed or copied. 

 Paper weight is limited to 220 g/m2 for automatic 2-sided printing. 
 
 

Supported Paper Sizes for Automatic 2-Sided Printing 
 

Standard European Sizes Standard North American Sizes 

Postcard (148 x 200 mm) 
A5 (148 x 210 mm) 
A4 (210 x 297 mm) 
A4 Oversized (223 x 297 mm) 
A3 (297 x 420 mm) 
JIS B6 (128 x 182 mm) 
JIS B5 (182 x 257 mm) 
215 x 315 mm 
JIS B4 (257 x 364 mm) 
SRA3 (320 x 450 mm) 

Postcard (6 x 9 in.) 
Statement (5.5 x 8.5 in.) 
8 x 10 in. 
Executive (7.25 x 10.5 in.) 
Letter (8.5 x 11 in.) 
9 x 11 in. 
US Folio (8.5 x 13 in.) 
Legal (8.5 x 14 in.) 
Tabloid (11 x 17 in.) 
Tabloid Extra (12 x 18 in.) 
12 x 19 in. 

In addition to the standard sizes, you can use custom size paper for 2-sided printing as follows: 

 Minimum size 128 x 140 mm (5 x 5.5 in.) 

 Maximum size 320 x 483 mm (12 x 19 in.) 
 

Supported Custom Paper Sizes 
 

Tray Number Paper Sizes 

Printer Tray 1 Minimum: 140 x 182 mm (5.5 x 7.2 in.) 
Maximum: 297 x 432 mm (11.7 x 17 in.) 

Trays 2–4 of the 3-Tray Module 
 

Tray 2 of the High-Capacity Tandem Tray 
Module 
 

Tray 2 of the 1-Tray Module 

Minimum: 140 x 182 mm (5.5 x 7.2 in.) 
Maximum: 320 x 457 mm (12.6 x 18 in.) 

 

Tray 5 (bypass tray) only Minimum: 89 x 98 mm (3.5 x 3.9 in.) 
Maximum: 320 x 483 mm (12.6 x 19 in.) 
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Supported Paper Sizes for the Envelope Tray 
 

Standard Sizes Custom Sizes 

C4 (229 x 324 mm, 9 x 12.75 in.) 
C5 (162 x 229 mm, 6.4 x 9.0 in.) 
DL (110 x 220 mm, 4.33 x 8.66 in.) 
152 x 203 mm, 6 x 9 in. 
229 x 305 mm, 9 x 12 in. 
Monarch (88 x 191 mm, 3.9 x 7.5 in.) 
Number 10 Commercial (241 x 105 mm, 9.5 x 4.125 in.) 

Minimum: 148 x 98 mm (5.8 x 3.9 in.) 
Maximum: 241 x 162 mm (9.5 x 6.4 in.) 
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Loading Paper 

This section includes: 

 Loading Paper in Trays 1–4 ............................................................................................................................................. 44

 Loading Paper in Trays 3 and 4 of the Tandem Tray Module .......................................................................... 46

 Configuring Tray 6 in the High-Capacity Feeder .................................................................................................... 47

 Loading Paper in Tray 6 (High-Capacity Feeder) ................................................................................................... 49

 Loading Paper in Tray 5 (Bypass Tray) ....................................................................................................................... 50

For faster print speeds, load paper 305 mm (12 in.) or shorter for long-edge feed (LEF). Load paper longer 
than 305 mm (12 in.) for short-edge feed (SEF). 

 
 

Loading Paper in Trays 1–4 
1. Pull out the tray until it stops. 

 
2. If necessary, move the paper tray guides further out to load the new paper. 

To adjust the guides, pinch the guide lever on each guide and slide the guide to the new position. 
To secure the guides in position, release the levers. 
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3. Fan the edges of the paper before loading it into the paper trays. This procedure separates any 
sheets of paper that are stuck together and reduces the possibility of paper jams. 

 

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary. 

 
 

4. Load the paper against the left side of the tray. 
 

Note: Do not load paper above the maximum fill line. Doing so can cause paper jams. 

 
5. Slide the guides so they touch the edges of the paper. 
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6. Close the tray. A message appears on the control panel. 

7. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 

8. On the printer touch screen, touch Confirm. 

 

 
 

Loading Paper in Trays 3 and 4 of the Tandem Tray Module 

The Tandem Tray Module holds larger amounts of paper for fewer printing interruptions. It contains 
three trays. Tray 2 holds paper sizes up to SRA3/12 x 18 in. Trays 3 and 4 hold A4/letter size paper only. 
 

Note: Do not load custom size paper into Tray 3 or Tray 4 of the Tandem Tray Module. 
 

To load tray 2, see Loading Paper in Trays 1-4 on page 44. 

1. Pull tray 3 or tray 4 out until it stops. 

2. Fan the edges of the paper before loading it into the paper trays. This procedure separates any 
sheets of paper that are stuck together and reduces the possibility of paper jams. 

 

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary. 
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3. Stack the paper against the left rear corner of the tray as shown. 

 
4. Adjust the guides so that they touch the edges of the stack. 

5. Close the tray. 

6. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 

7. On the printer touch screen, touch Confirm. 

 
 
 

Configuring Tray 6 in the High-Capacity Feeder 

Tray 6 is a dedicated high-capacity feeder. It must be configured to support the paper in use. If the tray 
has never been used, it must be configured for the desired paper size. If you are changing the paper size, 
you must reconfigure the tray for the new paper size. For details on supported paper sizes, see Supported 
Paper on page 38. 

Before changing the drawer configuration, always compare the paper size to the Tray 6 configuration. If 
the paper size matches, no adjustment is needed. 
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1. Remove the screw that holds the spacer plate at the back of the tray. 

2. Lift the spacer plate to remove it. 

3. Place the tabs at the bottom of the plate into the slots in the bottom of the drawer that correspond 
with the paper size. 

4. Slide the top of the spacer plate to engage the peg on the back of the tray into the matching hole in 
the plate. 

5. Install the screw to secure the spacer plate. 

6. Repeat steps 1–5 for the spacer plate at the front of Tray 6. 

7. Locate the pin at the top of the side gate. 

8. Lift the pin and guide it to the desired paper size in the slot on top of the side gate. 

9. Release the pin to lock it into place. 
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Loading Paper in Tray 6 (High-Capacity Feeder) 
1. Pull Tray 6 out of the feeder until it stops. 

2. Open the side gate until it stops. 

3. Fan the edges of the paper before loading it into the paper trays. This procedure separates any 
sheets of paper that are stuck together and reduces the possibility of paper jams. 

 

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary. 

 
 

4. Load the paper against the right side of the tray. 

For 1-sided printing: 

 Place the print side face down. 

 Place pre-punched paper with the holes toward the left side of the tray. 

 Place letterhead or the top of the page toward the front of the tray. 

XEROX

XEROX

 
 

Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams. 
 

For 2-sided printing: 

 Place the print side (page 1) face up. 

 Place pre-punched paper with the holes toward the right side of the tray. 

 Place letterhead or the top of the page toward the front of the tray. 
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5. Slide the guides so they touch the edges of the paper. 

6. Close the tray. 

7. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 

8. On the printer touch screen, touch Confirm. 

 
 
 

Loading Paper in Tray 5 (Bypass Tray) 

The bypass tray supports the widest variety of media types. It is primarily intended for small quantity jobs 
using special media. The tray extension provides support for larger paper. 
 

Notes: 

 For faster print speeds, load paper 320 mm (12.6 in.) or shorter with the long edge going into 
the printer (LEF). 

 Load paper longer than 320 mm (12.6 in.) with the short edge going into the printer (SEF). 

 Load hole punched paper with the holes on the trailing edge (left). 

 Do not load paper above the maximum fill line. 
 

1. Open the bypass tray by rotating it outward. 
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2. Insert the paper either long edge or short edge first. 

 
3. Center the paper, then slide the guides until they are just touching the edges of the stack. 

4. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 

5. On the printer touch screen, touch Confirm. 
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Printing on Special Paper 

This section includes: 

 Envelopes ................................................................................................................................................................................. 52

 Labels ........................................................................................................................................................................................ 54

 Gloss Paper ............................................................................................................................................................................. 55

 Transparencies ...................................................................................................................................................................... 56

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/WC75xxsupplies. 
 

See also:  

www.xerox.com/paper Recommended Media List (United States) 

www.xerox.com/europaper Recommended Media List (Europe) 
 

 
 

Envelopes 

Envelopes can be printed only from tray 1 (envelope tray) or tray 5 (bypass tray). 
 

Guidelines for Printing Envelopes 

 Print quality depends on the quality and construction of the envelopes. Try another envelope brand 
if you do not get desired results. 

 Maintain constant temperatures and relative humidity. 

 Store unused envelopes in their packaging to avoid the excess moisture and dryness which can affect 
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

 Do not use padded envelopes. Use envelopes that lie flat on a surface. 

 Do not use envelopes with heat activated glue. 

 Do not use envelopes with press and seal flaps. 

 Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on 
top of them. 

 In the print driver software, select Envelope as the paper type. 
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Loading Envelopes in Tray 5 (Bypass Tray) 

1. Open the bypass tray by rotating it outward. 

2. Load envelopes in the bypass tray with the flaps closed, flaps up, and flaps on the leading edge, 
toward the right. 

 
3. Center the stack, then slide the guides until they are just touching the edges of the stack. 

4. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 

5. On the printer touch screen, touch Confirm. 

 
 
 

Loading the Envelope Tray 

1. Pull out the envelope tray until it stops. 

2. Load the envelopes in the envelope tray with the flaps closed, flaps down, and on the leading edge, 
toward the left. 
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3. Adjust the guides so they touch the edges of the stack. 

4. Close the tray. 

5. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 

6. On the printer touch screen, touch Confirm. 

 
 
 

Labels 

Labels can be printed from trays 1–5. 
 

Guidelines for Printing Labels 

 Use labels designed for laser printing. 

 Do not use vinyl labels. 

 Do not feed a sheet of labels through the printer more than once. 

 Do not use dry gum labels. 

 Print only on one side of the sheet of labels. Use full sheet labels only. 

 Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 
packaging until ready to use. Return any unused sheets of labels to the original packaging and reseal 
it. 

 Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

 Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 

 Extra Heavyweight Labels can only be fed from tray 5 (bypass tray). 

 In the print driver software, select Labels, Heavyweight Labels, or Extra Heavyweight Labels as the 
paper type. 

 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing 
sheet. It could damage the printer. 
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Loading Labels in Tray 5 (Bypass Tray) 

1. Remove all paper from the tray before loading labels. 

2. Load labels face down with the top of the sheet toward the front of the printer. 

3. Adjust the guides so they touch the edges of the stack. 

4. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 

5. On the printer touch screen, touch Confirm. 

 
 
 

Gloss Paper 

Gloss paper can be printed from any tray. 
 

Guidelines for Printing on Gloss Paper 

 Do not open sealed packages of gloss paper until you are ready to load them into the printer. 

 Leave gloss paper in the original wrapper, and leave the packages in the shipping carton until ready 
to use. 

 Remove all other paper from the tray before loading gloss paper. 

 Load only the amount of gloss paper you are planning to use. Do not leave gloss paper in the tray 
when you are finished printing. Reinsert unused paper in the original wrapper and seal. 

 Rotate stock frequently. Long periods of storage in extreme conditions can cause gloss paper to curl 
and jam in the printer. 

 In the print driver software, select the desired gloss paper type or select the tray loaded with the 
desired paper. 
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Loading Gloss Paper in Tray 5 (Bypass Tray) 

1. Remove all other paper from the tray before loading gloss paper. 

2. Load only the amount of paper you plan to use. 

3. Load the paper with the glossy side or print side down. 

4. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 

5. On the printer touch screen, touch Confirm. 

 
 
 

Transparencies 

Transparencies can be printed from trays 1–5. For best results, use only recommended Xerox® 
transparencies. 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

 
 

Guidelines for Printing on Transparencies 

 Remove all paper before loading transparencies in the tray. 

 Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print 
quality. 

 Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam. 

 Load transparencies face up into tray 5 (bypass tray) and face down into trays 1–4. 

 Do not use transparencies with stripes on the side. 

 Do not fan transparencies. 

 After loading transparencies, change the paper type to Transparency on the printer touch screen. 

 In the print driver software, select Transparency as the paper type. 
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This chapter includes: 

 Printing Overview ................................................................................................................................................................. 58

 Selecting Printing Options ................................................................................................................................................ 59

 Printing Features .................................................................................................................................................................. 63
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Printing Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected to an active 
network. Make sure that you have the correct print driver software installed on your computer. For details, 
see Installing the Software on page 32. 

1. Select the appropriate paper. 

2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type. 

3. Access the print settings in your software application. For most software applications, press CTRL+P 
for Windows, or CMD+P for Macintosh. 

4. Select your printer from the list. 

5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox® 
Features for Macintosh. The title of the button can vary depending on your application. 

6. Modify the print driver settings as necessary, then click OK. 

7. Click Print to send the job to the printer. 
 

See also:  

Loading Paper on page 44 

Selecting Printing Options on page 59 

Printing on Both Sides of the Paper on page 63 

Printing on Special Paper on page 52 
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Selecting Printing Options 

This section includes: 

 Print Driver Help .................................................................................................................................................................... 59

 Windows Printing Options ................................................................................................................................................ 60

 Macintosh Printing Options ............................................................................................................................................. 61

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printers and Faxes Printing Preferences 
become the default setting. Printing options that are set from within the software application are 
temporary. The application and the computer do not save the settings after the application is closed. 

 
 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help button (?) in the bottom left corner of the Printing Preferences window to see the Help. 

 

Information about Printing Preferences settings appears in the Help window on three tabs: 

 Contents provides a list of the tabs at the top and the areas at the bottom of the Printing 
Preferences window. Use the Contents tab to find explanations for each of the fields and areas in 
Printing Preferences. 

 Index provides an alphanumeric list of help topics. Click a topic and the explanation appears in the 
right-side window. 

 Search provides a field in which you can enter the topic or function for which you need information. 
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Windows Printing Options 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 

To select default printing options: 

1. In the Windows Taskbar, click Start > Settings > Printers and Faxes. 

2. In the Printers and Faxes folder, right-click the icon for your printer and click Printing Preferences. 

3. Click a tab in the Printing Preferences window, select options, then click OK to save. 
 

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 

 
 

Selecting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, change the Printing Preferences from the application 
before sending the job to the printer. For example, if you want to use the Enhanced print-quality mode 
when printing a particular document, select Enhanced in Printing Preferences before printing the job. 

1. With the document open in your software application, access the print settings. For most software 
applications, click File > Print or press CTRL+P for Windows. 

2. Select your printer and click the Properties or Preferences button to open the Printing Preferences 
window. The title of the button can vary depending on your application. 

3. Click a tab in the Printing Preferences window, then make selections. 

4. Click OK to save and close the Printing Preferences window. 

5. Click Print to send the job to the printer. 
 
 

Selecting Finishing Options for Windows 

If your printer has a finisher installed, select finishing options in the Printing Preferences of the print 
driver. In addition to stapling, the Office Finisher LX and the Professional Finisher provide hole punching. 
The Professional Finisher also provides collation, folding, and stapling. 

To select finishing options in the PostScript and PCL print drivers: 

1. In the print driver, click the Paper/Output tab. 

2. Click the arrow to the right of the Finishing section, then select the desired finishing options. 
 
 

Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 
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To save a set of printing options: 

1. With the document open in your application, click File > Print. 

2. Select the printer, then click Properties. Click the tabs in the Printing Properties window and select 
the desired settings. 

3. Click Saved Settings at the bottom of the Printing Properties window, then click Save As. 

4. Type a name for the set of printing options, then click OK to save the set of options in the Saved 
Settings list. 

5. Select the name from the list to print using these options. 
 
 

Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 

1. With the document open in your application, click File > Print. 

2. Select your printer from the Printers list. 

3. Select Xerox® Features from the Copies & Pages menu. 

4. Select the desired printing options from the drop-down lists. 

5. Click Print to send the job to the printer. 
 
 

Selecting Finishing Options for Macintosh 

If your printer has a finisher installed, select finishing options in the Printing Preferences of the print 
driver. In addition to stapling, the Office Finisher LX and the Professional Finisher provide hole punching. 
The Professional Finisher also provides collation, folding, and stapling. 

To select finishing options in the Macintosh print driver: 

1. In the print driver, click Copies & Pages, then select Xerox® Features. 

2. In the Paper/Output dialog box, click the arrow to the right of the Finishing section, then select the 
desired finishing options. 

 
 

Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 

1. With the document open in your application, click File > Print. 

2. Select your printer from the Printers list. 

3. Select the desired printing options from the drop-down lists in the Print dialog box. 

4. Click Presets > Save As. 

5. Type a name for the printing options, then click OK to save the set of options in the Presets list. 

6. To print using these options, select the name from the Presets list. 
 



Printing 

 

62 WorkCentre 7500 Series Multifunction Printer 
 User Guide 
 

 



Printing 

 

 WorkCentre 7500 Series Multifunction Printer 63 
 User Guide 
 

Printing Features 

This section includes: 

 Printing on Both Sides of the Paper ............................................................................................................................. 63

 Selecting Paper Options for Printing ............................................................................................................................ 64

 Printing Multiple Pages to a Single Sheet (N-Up) .................................................................................................. 64

 Printing Booklets................................................................................................................................................................... 65

 Using Color Options ............................................................................................................................................................ 65

 Printing Cover Pages ........................................................................................................................................................... 66

 Printing Insert Pages .......................................................................................................................................................... 66

 Printing Exception Pages .................................................................................................................................................. 67

 Scaling ...................................................................................................................................................................................... 67

 Printing Watermarks ........................................................................................................................................................... 68

 Printing Mirror Images ....................................................................................................................................................... 68

 Creating and Saving Custom Sizes ............................................................................................................................... 69

 Selecting Job Completion Notification for Windows ............................................................................................ 69

 Printing Special Job Types ................................................................................................................................................ 69

 Printing from a USB Flash Drive .................................................................................................................................... 71
 
 

Printing on Both Sides of the Paper 

Paper Types for Automatic 2-Sided Printing 

The printer can automatically print a 2-sided document on supported paper. Before printing a 2-sided 
document, verify that the paper type and weight are supported. 

Paper weights from 60 g/m² through 220 g/m² can be used for automatic 2-sided printing. For details, see 
Supported Paper Types and Weights for Automatic 2-Sided Printing on page 41. 

The printer does not support the following paper and media for automatic 2-sided printing: 

 Reload, which is paper previously laser printed or copied. 

 Envelopes 

 Labels 

 Pre-Cut Tabs 

 Gloss or Heavyweight papers heavier than 220 g/m². 
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Printing a 2-Sided Document 

Options for Automatic 2-Sided Printing are specified in the print driver. The print driver uses the settings 
for portrait or landscape orientation from the application for printing the document. 
 

2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These 
settings override the application page orientation settings. 
 

Portrait Landscape 

 

 
 

 
 

 
 

 

Portrait 
2-Sided Print 

Portrait 
2-Sided Print, Flip on Short 
Edge 

Landscape 
2-Sided Print 

Landscape 
2-Sided Print, Flip on Short 
Edge 

 
 

Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to use 
based on the document size, paper type, and paper color you specify. You can also select a specific tray 
loaded with the desired paper. 
 

Printing Multiple Pages to a Single Sheet (N-Up) 

When printing a multiple-page document, you can print more than one page on a single sheet of paper. 
Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet (N-Up) on the Layout/Watermark tab. 
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Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any 
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and 
prints four page images per sheet of paper, two page images on each side. The pages are printed in the 
correct order so that you can fold and staple the pages to create the booklet. 

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 

 Gutter specifies the horizontal distance in points between the page images. A point is 0.35 mm 
(1/72 in.). 

 Creep specifies how much the page images are shifted outward, in tenths of a point. Shifting 
compensates for the thickness of the folded paper, which would cause the page images to shift 
slightly outward when folded. You can select a value from zero to 1 point. 

 

Gutter Creep 

 

 

 
 
 
 
 

 
 

Using Color Options 

The Color Options control the way the printer uses color to produce your document. The Windows 
PostScript and the Macintosh drivers provide the widest range of color controls and corrections. Each 
system has three standard modes of color control for normal use and Custom Color Options for the more 
advanced users. 

The three standard color modes are: 

 Automatic Color applies the best color correction to text, graphics, and images. This setting is 
recommended. 

 Vivid Color applies automatic color correction to make office colors more saturated. 

 Black and White converts all color in the document to black and white or shades of gray. 

Custom Color Options provide three ways of adjusting the colors for more specific color requirements. 
Click the Custom Color Options bar to open the Custom Color Options window: 

 Color By Words provides a three step process for defining custom color correction. By making a 
selection from each of the three fields, you create a sentence for controlling the color characteristics 
of the document. You can create several sentences to more precisely control the color content of the 
document. 



Printing 

 

66 WorkCentre 7500 Series Multifunction Printer 
 User Guide 
 

The sentence structure is made of three parts: 

 What Color to Change? provides a drop-down list to select a color or range of colors to adjust, 
such as All Foliage-Green Colors. 

 How Much Change? lets you select how much effect to make, such as A Lot More, to the 
selected color. 

 What Type of Change? lets you select the type of change, such as Vivid, from the drop-down 
list. 

As you create a Color By Words sentence, it appears in the window below the selection fields. 

 Color Correction provides a list of commercial press, spot color, CIE, and gray image simulations 
from which you can select to match your document color. 

 Color Adjustments provides a set of six sliders for adjusting the individual components of the 
selected colors. Use the sliders to adjust the lightness, contrast, saturation, cyan, magenta, and 
yellow components of the color. 

  
 

Printing Cover Pages 

A cover page is the first or last page of a document. You can select paper sources for the cover pages that 
are different from the source used for the body of a document. For example, you can use your company 
letterhead for the first page of a document. You can also use heavyweight paper for the first and last 
pages of a report. You can use any applicable paper tray as the source for printing cover pages. 

Select one of these options for printing cover pages: 

 No Covers does not print cover pages. No cover pages are added to the document. 

 Front Only prints the first page on paper from the specified tray. 

 Back Only prints the back page on paper from the specified tray. 

 Front and Back: Same prints the front and back cover pages from the same tray. 

 Front and Back: Different prints the front and back cover pages from different trays. 

After making a selection for printing the cover pages, you can select the paper for the front and back 
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side 
two, or both sides of the cover pages. 
 
 

Printing Insert Pages 

You can add blank or pre-printed insert pages before page one of each document or after designated 
pages within a document. Adding an insert after designated pages within a document separates sections, 
or acts as a marker or placeholder. Make sure that you specify the paper to use for the insert pages. 

 Insert Options provides the options to place an insert After Page X, where X is the specified page, or 
Before Page 1. 

 Insert Quantity specifies the number of pages to insert at each location. 

 Page(s) specifies a page or a range of pages after which you want an insert added. Separate 
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to add inserts after pages 1, 6, 9, 10, and 11, type: 1, 6, 9-11. 
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 Paper displays the default size, color, and type of paper selected in Use Job Settings for the insert 
pages. Use the down arrow to the right of the Paper field to select a different paper by size, color, or 
type. 

 Job Settings displays the attributes of the paper selected for the print job, without the inserts. 
 

Printing Exception Pages 

You can specify the characteristics of any pages in the print job that differ from the settings used for the 
rest of the print job. 

For example, your print job contains 30 pages, 5 of which you want to print on only one side of a special 
paper. You want the remainder of the pages printed 2-sided on regular paper. 

In the Add Exceptions window, you can set the characteristics of the exception pages and select the 
alternate paper source: 

 Page(s) specifies the page or range of pages in which the exception page is inserted. Separate 
individual pages or page ranges with commas. Specify ranges with a dash. For example, to add 
inserts after pages 1, 6, 9, 10, and 11, type: 1, 6, 9-11. 

 Paper displays the Use Job Settings default size, color, and type of paper to use for the exception 
pages. Click the down arrow to the right of the Paper field to select a different paper by size, color, or 
type. 

 2-Sided Printing. Click the down arrow, then click the desired 2-sided printing option: 

 1-Sided Print prints the exception pages on one side only. 

 2-Sided Print prints the exception pages on both sides of the sheet of paper. The images are 
printed so that the job can be bound on the long edge of the sheet. 

 2-Sided Print Flip on Short Edge prints the exception pages on both sides of the sheet of paper. 
The images are printed so that the job can be bound on the short edge of the sheet. 

 Job Settings displays the attributes of the paper for the remainder of the document. 
 

Scaling 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. The 
default setting is 100%. 
 

50% 100% 200% 
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In Windows, the Scale Options are located in the print driver on the Paper/Output tab in the Paper field. 
Click the arrow at the right side of the Paper field and select Other Size to access the Scale Options: 

 No Scaling does not increase or decrease the size of the image from the original. 

 Automatic Scaling changes the print from one standard paper size to another standard paper size. 
The Original Document Size is scaled to fit on the selected output paper size shown in the Output 
Paper Size field. 

 Manual Scaling changes the output print size by the percentage entered into the field under the 
graphic to the right of the Scale Options. 

 

Printing Watermarks 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before 
distribution. 

 

Using the watermark options, you can do the following: 

 Create a watermark or edit an existing watermark using the Watermark Editor: 

 Name allows you to give the new watermark a unique name. 

 Options enables you to use text, time stamps, or graphics for the watermark. 

 Text provides a field in which you enter the text to be printed as the watermark. 

 Font and Color determine the font, size, style, and color of the watermark. 

 Angle sets the degree of rotation applied to the text or graphics used for the watermark. 

 Density defines how faint or how prominent the watermark appears on the pages. 

 Position from center determines the position of the watermark on the page. The default 
position is in the center of the printed pages. 

 Place a watermark on the first page or on every page in a document. 

 Print a watermark in the foreground or background or blend it with the print job. 
 

Printing Mirror Images 

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when 
printed. 
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Creating and Saving Custom Sizes 

You can print custom-size paper from Trays 1–5. Custom size paper settings are saved in the print driver 
and are available for you to select in all your applications. See Supported Custom Paper Sizes on page 38 
for paper sizes that are supported for each tray. 

To create and save custom sizes for Windows: 

1. Click the Paper/Output tab of the print driver. 

2. Click the arrow at the right of the Paper field, then select Other Size > Output Paper Size > New. 

3. In the New Custom Size window, enter the height and width of the new size, then select the units. 

4. Enter a title for the new size in the Name field, then click OK to save. 

To create and save custom sizes for Macintosh: 

1. In the application, click File > Page Setup. 

2. Click Paper Sizes, then select Manage Paper Sizes. 

3. In the Manage Paper Sizes window, click the plus sign (+) to add a new size. 

4. Double-click Untitled at the top of the window and type a name for the new custom size. 

5. Enter the height and width of the new custom size. 

6. Click the arrow to the right of the Non-Printable Area field and select the printer from the drop-down 
list. Or set the top, bottom, right, and left margins for User Defined margins. 

7. Click OK to save the settings. 
 
 

Selecting Job Completion Notification for Windows 

You can select to be notified when your job finishes printing. A message appears on your computer screen 
with the name of the job and the name of the printer where it was printed. 
 

Note: This feature is only available on a Windows computer printing to a network printer. 
 

To select job completion notification: 

1. In the print driver, click More Status at the bottom of any tab. 

2. In the Status window, click Notification, then click the desired option. 

3. Close the Status window. 
 
 

Printing Special Job Types 

Secure Print 

Secure Print allows the user to associate a 4–10 digit passcode number with a print job when sending it to 
the printer. The job is held at the printer until the same passcode number is entered at the control panel. 

When printing a series of Secure Print jobs, assign a default passcode number in the Printing Preferences 
of the print driver. Use the default passcode number for all print jobs sent from that computer. If you 
must use a different passcode, you can override it in the application print driver. 
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To release a Secure Print job for printing: 

1. At the control panel, press the Job Status button. 

2. Touch the Secure Print tab. 

3. Touch the corresponding print job in the list, then touch Release. 

4. Use the keypad to enter the passcode number that you assigned to the print job. 

5. Touch Release Job to start printing. 
 
 

Sample Set 

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the remaining 
copies at the printer. After you review the sample copy, you can select the job name from the printer 
control panel to print the additional copies. 

To release the remainder of prints after printing a sample set: 

1. Press the Job Status button. A list of pending print jobs appears on the Active Jobs window. 

2. Touch the corresponding print job in the list, then touch Release to start printing. 
 
 

Delay Print 

You can delay a print job for up to 24 hours from the original job submission time. Enter the time at which 
you would like the job to print. If the time you enter is earlier than the time that you submit the print job, 
it prints on the following day. The Delayed Print default time is midnight. 
 

Saved Job 

Saved Job allows you to save a print job to a folder on the printer. Using the controls in the Saved Jobs 
window, you can save the job, or you can print and save the job for future use. You can also set the access 
to the print job as follows: 

 Public requires no passcode and allows any user to print the file from the control panel of the printer. 

 Private requires a passcode so that only a user with the passcode can print the file. 

When the Saved Job is no longer needed, you can delete it from the control panel of the printer. 
 

Note: The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC75xxdocs. 

To print a saved job: 

1. Press the Services Home button. 

2. Touch the Print from icon. 
 

Note: If Print from USB is not enabled, the icon is labeled Reprint from Saved Job. If Reprint from 
Saved Job is not enabled, the icon is labeled Print from USB. If neither function is enabled, the icon 
does not appear. 

 

3. Use the arrows to the right of the list to scroll through the list and locate the printable file. 

If the print file is in a folder, touch the name to open the folder. 



Printing 

 

 WorkCentre 7500 Series Multifunction Printer 71 
 User Guide 
 

4. Touch the name of the printable file. 

5. Select the number of copies and the paper size, color, and type for the print job. 

6. Press the green Start button. 

7. Touch Back to go back to the last screen. 

8. Touch Browse to look for other folders and printable files. 

9. To delete a file, touch the file name and touch Delete. 
 
 

Fax 

Local Area Network (LAN) Fax allows you to send faxes from the print driver on your computer to a fax 
machine over a telephone line. The Fax window allows you to enter recipients, create a cover page with 
notes, and set options. Using the options you can select confirmation sheets, send speed, fax resolution, 
send time, and fax dialing options. 

Notes: 

 When Fax job type is selected, some features, such as Edge Enhancement, Thin Line 
Enhancement, and Black Enhancement, are turned off. 

 Not all printer models support this feature. 
 
 

Printing from a USB Flash Drive 

You can print PDF, TIFF, and XPS files directly from a USB Flash Drive. 
 

Notes: 

 If USB ports are disabled, you cannot use a USB card reader for authentication, update the 
software, or print from a USB Flash Drive. 

 The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC75xxdocs. 

 

To print from a USB Flash Drive: 

1. Insert the USB Flash Drive into the control panel USB port. The Print from USB window appears. 

The list at the bottom of the window displays the folders and printable files on the USB Flash Drive. 

2. Use the arrows to the right of the list to scroll through the list and locate the printable file. 

If the print file is in a folder, touch the name to open the folder. 

3. Touch the name of the printable file. 

4. Select the number of copies and the paper size, color, and type for the print job. 

5. Press the green Start button. 

6. Touch Back to go back to the last screen. 

7. Touch Browse to look for other folders and printable files. 
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This chapter includes: 

 Basic Copying ........................................................................................................................................................................ 74

 Selecting Copy Settings ..................................................................................................................................................... 76
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Basic Copying 

To make copies: 

1. On the control panel, press the yellow Clear All button to clear previous copy settings. 

2. Load your original documents: 

 Use the document glass for single pages or paper that cannot be fed using the document 
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

 Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

3. Press the Services Home button, then touch Copy. 

4. Use the alphanumeric keypad on the control panel to enter the number of copies. The number of 
copies appears in the upper right corner of the touch screen. 

 

Note: To correct the number of copies entered using the alphanumeric keypad, press the C button, 
then re-enter the number. 

 

5. If desired, change the copy settings. For details, see Selecting Copy Settings on page 76. 

6. Press the green Start button. 
 

Notes: 

 To pause or cancel a copy job, press the red Stop button on the control panel. 

 To interrupt a copy job, press the Interrupt button on the control panel. 

 On the touch screen, touch Resume to continue the job, or Cancel to cancel the job completely.
  
 

Document Glass 

 

 Lift the document feeder cover 
and place the first page face 
down in the upper left corner of 
the document glass. 

 The original must be aligned to 
the matching paper size printed 
on the edge of the glass. 

 The document glass accepts 
paper sizes up to 310 x 430 mm 
(12.25 x 17 in.). 

 The document glass 
automatically detects standard 
paper sizes. 
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Document Feeder 

 

 

 Insert originals face up, with page one 
on top. 

 The confirmation indicator illuminates 
when the originals are correctly 
loaded. 

 Adjust the paper guides so they fit 
against the originals. 

 The document feeder accepts paper 
weights from 38–128 g/m² for 1-sided 
pages, and 50–128 g/m² for 2-sided 
pages. 

 The document feeder accepts paper 
sizes from 85 x 125 mm (3.3 x 4.9 in.) 
to 297 x 432 mm (11.7 x 17 in.) for 
1-sided pages, and 110 x 125 (4.3 x 
4.9 in.) to 297 x 432 mm (11.7 x 17 in.) 
for 2-sided pages. 

 The maximum feeder capacity is 
approximately 110 sheets of 80 g/m2 
paper. 

 The document feeder automatically 
detects standard paper sizes. 
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Selecting Copy Settings 

This section includes: 

 Basic Settings ......................................................................................................................................................................... 77

 Image-Quality Settings ..................................................................................................................................................... 83

 Layout Settings ..................................................................................................................................................................... 86

 Output Format Settings .................................................................................................................................................... 89

 Advanced Copying .............................................................................................................................................................. 96
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Basic Settings 

This section includes: 

 Selecting Color or Black and White Copies ............................................................................................................... 77

 Reducing or Enlarging the Image ................................................................................................................................. 77

 Selecting the Paper Tray ................................................................................................................................................... 78

 Selecting 2-Sided Copy Options ..................................................................................................................................... 78

 Selecting Collated Copies ................................................................................................................................................. 79

 Selecting Uncollated Copies ............................................................................................................................................ 79

 Creasing Copies .................................................................................................................................................................... 79

 Folding Copies ....................................................................................................................................................................... 80

 Hole Punching Copies ......................................................................................................................................................... 81

 Stapling Copies ..................................................................................................................................................................... 81
 
 

Selecting Color or Black and White Copies 

If the original document contains color, you can create copies in full color, a single color, or in black and 
white. 

To select the output color: 

1. Press the Services Home button, then touch Copy. 

2. Under Output Color, select one of the following: 

 Auto Detect detects the color content in the original document. If the original is a color 
document, the printer makes copies in full color. If the original is a black and white document, 
the printer makes copies in black only. 

 Black & White copies in black and white only. Colors in the original are converted to shades of 
gray. 

3. For additional options, touch More, then select one of the following: 

 Auto Detect detects the color content in the original document. If the original is a color 
document, the printer makes copies in full color. If the original is a black and white document, 
the printer makes copies in black only. 

 Black & White copies in black and white only. Colors in the original are converted to shades of 
gray. 

 Color copies in full color output using all four printing colors (cyan, magenta, yellow, and black). 

 Single Color copies in shades of a single color. Under Colors, select a color. The sample page 
shows your color selection. 

4. Touch Save. 
 

Reducing or Enlarging the Image 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. 
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To reduce or enlarge the image: 

1. Press the Services Home button, then touch Copy. 

2. Under Reduce/Enlarge, touch one of the following: 

 Minus (-) or plus (+) buttons incrementally reduce or enlarge the percentage. You are ready to 
make copies. 

 Reduce/Enlarge % allows you to use the alphanumeric keypad to type a specific value. You are 
ready to make copies. 

3. Touch More for additional options. 

a. To reduce or enlarge, touch one of the following: 

 Proportional % reduces or enlarges the image proportionally. 

 Independent X-Y% allows you to reduce or enlarge the width and length of the image by 
different percentages. 

b. To select custom or preset values, touch one of the following: 

 Proportional % or Independent X-Y% allows you to specify exact values. Touch the Up or 
Down arrows, or touch the % field, then use the alphanumeric keypad to enter the value. 

 Presets (X-Y%) or Presets (X/Y%) allows you to select from a list of preset values. 

c. To center the image on the page, touch Auto Center. 

4. Touch Save. 
 

Selecting the Paper Tray 

Select a paper tray loaded with the desired paper to make copies on letterhead, colored paper, 
transparencies, or different paper sizes. 

To select the tray to use for copies: 

1. Press the Services Home button, then touch Copy. 

2. Under Paper Supply, touch the desired tray. 

3. If the desired tray is not listed, choose another tray: 

a. Touch More. 

b. Touch the desired tray. 

4. Touch Save. 
 

Note: The Auto Select setting automatically selects the tray containing the correct paper size. 
 
 

Selecting 2-Sided Copy Options 

Use the document feeder or the document glass to copy one or both sides of a 2-sided original. 

To select 2-sided copy options: 

1. Press the Services Home button, then touch Copy. 

2. Under 2-Sided Copying, select one of the following: 

 1->1 Sided scans only one side of the originals and produces 1-sided copies. 

 1->2 Sided scans only one side of the originals and produces 2-sided copies. To rotate the 
second sides, touch Rotate Side 2. 
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 2->2 Sided scans both sides of the originals and produces 2-sided copies. To rotate the second 
sides, touch Rotate Side 2. 

 2->1 Sided scans both sides of the originals and produces 1-sided copies. 

3. Press the green Start button. 

 The document feeder automatically copies both sides of the 2-sided original. 

 A message appears on the control panel when it is time to place the next original on the 
document glass. 

 

Selecting Collated Copies 

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a 
six-page document, the copies are printed in this order: 

1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6 

To select collated copies: 

1. Press the Services Home button, then touch Copy. 

2. Under Copy Output, touch Collated if it is not already selected. 
 

Selecting Uncollated Copies 

Uncollated copies print in the following order: 

1, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6 

To select uncollated copies: 

1. Press the Services Home button, then touch Copy. 

2. If your printer has a finisher, under Copy Output, touch More. 

3. Under Copy Output or Collation, touch Uncollated. 

4. Touch Save. 
 

Creasing Copies 

If your printer has the Office Finisher LX with the creasing option, you can crease your copies, and fold 
them manually. 
 

Note: The originals and the selected paper tray must be loaded short-edge first. 
 

To crease your copies: 
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1. Press the Services Home button, then touch Copy. 

2. Under Copy Output, touch Creasing. 

3. Under Creasing Options, touch Single Crease. 
 

Note: Creasing options depend on the paper size. If the desired creasing option is unavailable, touch 
Paper Supply, then select the appropriate tray, and touch Save. 

 

4. To specify how the pages are creased, select one of the following options: 

 Individually creases each page separately. 

 Together as a Set creases all the pages together. Select the Booklet Staple check box to saddle 
staple the pages. 

5. Touch Advanced Settings, and set the available options: 

a. Under Side 1 Images, select one of the following: 

 Image Inside Crease prints the image inside the crease. 

 Image Outside Crease prints the image outside the crease. 

b. Under Collation, select one of the following: 

 Collated 

 Uncollated 

c. Under Originals, select one of the following: 

 Standard images are printed full size. 

 Booklet Format images are reduced and printed in booklet format. 

6. To select the orientation of the originals, touch Original Orientation and select one of the following 
from the drop-down menu: 

 Upright Images are loaded upright into the document feeder. 

 Sideways Images are loaded into the document feeder with the top edge to the left. 

7. Touch Save. 
 

Folding Copies 

If your printer has the Professional Finisher, you can automatically fold your copies. 

To fold copies: 

1. Press the Services Home button, then touch Copy. 

2. Under Copy Output, touch Folding. 

3. Under Folding Options, select Single Fold. 
 

Note: Folding options depend on the paper size. If the desired folding option is unavailable, touch 
Paper Supply, then select the appropriate tray and touch Save. 

 

4. Under Fold Pages, select one of the following options: 

 Individually folds and stacks each page separately. 

 Together as a Set folds and stacks all the pages together. Select the Booklet Staple check box 
to staple the pages at the fold. 
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5. Touch Advanced Settings, and set the available options: 

a. Under Side 1 Image, select one of the following: 

 Image Inside Fold prints the image inside the fold. 

 Image Outside Fold prints the image outside the fold. 

b. Under Collation, select one of the following: 

 Collated 

 Uncollated 

c. Under Originals, select one of the following: 

 Standard images are printed full size. 

 Booklet Format images are reduced and printed in booklet format. 

6. To select the orientation of the originals, touch Original Orientation and select one of the following 
from the drop-down menu: 

 Upright Images are loaded upright into the document feeder. 

 Sideways Images are loaded into the document feeder with the top edge to the left. 

7. Touch Save. 
 

Hole Punching Copies 

If your printer has the Professional Finisher, or the Office Finisher LX with the hole punching option, you 
can hole punch your copies. 
 

Note: Some combinations of hole punching and stapling are not compatible. If a hole punch position 
overlaps with a staple position, that option is not available. 

 

To select hole punching: 

1. Press the Services Home button, then touch Copy. 

2. Under Copy Output, touch More. 

3. Under Hole Punch, touch one of the following: 

 2 Holes 

 3 Holes 

The sample page shows the location of the holes. 
 

Note: Hole punching options depend on the paper size. If the desired hole punching option is 
unavailable, touch Paper Supply, then select the appropriate tray and touch Save. Touch Help for 
details. 

 

4. Touch Save. 
 

Stapling Copies 

If your printer has the Professional Finisher or the Office Finisher LX, you can staple your copies. 
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Note: Some combinations of hole punching and stapling are not compatible. If a hole punch position 
overlaps with a staple position, that option is not available. 

 

To select stapling: 

1. Press the Services Home button, then touch Copy. 

2. Under Copy Output, select one of the following: 

 1 Staple (Portrait) 

 1 Staple (Landscape) 

3. For additional stapling options, touch More. 
 

Note: Stapling options depend on whether you feed the paper with the long edge or short edge 
entering the feeder. If the desired stapling option is unavailable, touch Paper Supply, then select the 
appropriate tray and touch Save. Touch Help for details. 

 

4. Under Staple, select one of the available options: 

 1 Staple 

 2 Staples 

 4 Staples 
 

Note: Stapling options vary, depending on the finisher.  
 

5. To change the orientation of the page, touch Original Orientation, and select one of the following 
from the drop-down menu: 

 Portrait Originals 

 Landscape Originals 

6. Touch Save. 
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Image-Quality Settings 

This section includes: 

 Specifying the Original Type ........................................................................................................................................... 83

 Adjusting Brightness, Sharpness, and Saturation .................................................................................................. 83

 Automatically Suppressing Background Variation ................................................................................................ 83

 Adjusting the Contrast ....................................................................................................................................................... 84

 Selecting Color Effects ....................................................................................................................................................... 84

 Adjusting the Color Balance ............................................................................................................................................ 84
 
 

Specifying the Original Type 

The printer optimizes the image quality of the copies based on the type of images in the original 
document and how the original was created. 

To specify the original type: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Image Quality tab, then touch Original Type. 

3. On the Original Type screen, select the appropriate settings: 

 On the left side of the screen, touch the content type of the original document. 

 If known, select how the original was produced. 

4. Touch Save. 
 

Adjusting Brightness, Sharpness, and Saturation 

You can lighten or darken copies and adjust the sharpness and saturation. 

To adjust the image: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Image Quality tab, then touch Image Options. 

3. On the Image Options screen, adjust the sliders up or down as necessary: 

 Lighten/Darken lightens or darkens the image. 

 Sharpness sharpens or softens the image. 

 Saturation makes the image colors more vivid or pastel. 

4. Touch Save. 
 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can 
sometimes be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the 
printer to variations in light background colors. 
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To change this setting: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Image Quality tab, then touch Image Enhancement. 

3. Under Background Suppression, touch Auto Suppression. 

4. Touch Save. 
 

Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To increase or reduce the contrast of the copies: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Image Quality tab, then touch Image Enhancement. 

3. On the Image Enhancement screen, adjust the contrast: 

 Auto Contrast allows the printer to set the contrast automatically. 

 Manual Contrast allows you to adjust the contrast manually. Move the Manual Contrast slider 
up or down to increase or decrease the contrast. The middle position on the slider, Normal, does 
not change the contrast. 

4. Touch Save. 
 

Selecting Color Effects 

If you have a color original, you can adjust the color of the copy using preset color effects. For example, 
you can adjust colors to be brighter or cooler. 

To select a preset color effect: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Image Quality tab, then touch Color Presets. 

3. On the Color Presets screen, touch the desired preset color effect. The sample images show how the 
colors are adjusted. 

4. Touch Save. 
 

Adjusting the Color Balance 

If you have a color original, you can adjust the balance of the printing colors between cyan, magenta, 
yellow, and black before printing your copy. 

To adjust the color balance: 
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1. Press the Services Home button, then touch Copy. 

2. Touch the Image Quality tab, then touch Color Balance. 

3. To adjust the density levels of all four colors: 

a. On the Color Balance screen, touch Basic Color. 

b. Move the sliders to adjust the level for each color. 

4. To adjust the highlight, midtone, and shadow density levels by color: 

a. On the Color Balance screen, touch Advanced Color. 

b. Touch the color you want to adjust. 

c. Move the sliders to adjust the levels for highlights, midtones, and shadows. 

d. Repeat the previous two steps for additional colors. 

5. Touch Save. 
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Layout Settings 

This section includes: 

 Specifying the Orientation of the Original ................................................................................................................ 86

 Specifying the Size of the Original ............................................................................................................................... 86

 Selecting Book Copying ..................................................................................................................................................... 87
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 Inverting the Image ........................................................................................................................................................... 88
 
 

Specifying the Orientation of the Original 

If you plan to have the copies automatically stapled, specify the orientation of the original: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Layout Adjustment tab, then touch Original Orientation. 

3. On the Original Orientation screen, touch the desired orientation: 

 Upright Images and Sideways Images refer to the direction the originals are loaded in the 
document feeder. 

 Portrait Originals and Landscape Originals refer to the images on the originals. 
 

Note: If you are using the document glass, the orientation of the original is as seen before turning it 
over. 

 

4. Touch Save. 
 

Specifying the Size of the Original 

To scan the correct area of the original, specify the original size: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Layout Adjustment tab, then touch Original Size. 

3. On the Original Size screen, select one of the following: 

 Auto Detect allows the printer to determine the size of the original. 

 Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the 
scrolling list, touch the desired paper size. 

 Custom Scan Area allows you to specify the height and width of the area to scan. Touch the 
Height-Y and Width-X arrows to specify the area. 

 Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the 
diagram on the screen to determine which original sizes can be mixed in the same job. 

4. Touch Save. 
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Selecting Book Copying 

When copying a book, magazine, or other bound document, you can copy either the left or right page 
onto a single sheet of paper. You can copy both the left and right pages onto two sheets of paper, or as a 
single image on one sheet of paper. 
 

Note: You must use the document glass to make copies from books, magazines, or other bound 
documents. Do not place bound originals in the document feeder. 

To set up book copying: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Layout Adjustment tab, then touch Book Copying. 

3. On the Book Copying screen, select one of the following: 

 Off copies both pages of an open book as one image on a single sheet of paper. 

 Both Pages copies the left and the right pages of an open book onto two sheets of paper. If 
Binding Edge Erase is required, touch the arrows to erase up to 2 in. 

 Left Page Only copies only the left page of an open book on a single sheet of paper. If Binding 
Edge Erase is required, touch the arrows to erase up to 1 in. 

 Right Page Only to copy only the right page of an open book on a single sheet of paper. If 
Binding Edge Erase is required, touch the arrows to erase up to 1 in. 

4. Touch Save. 
 

Shifting the Image 

You can change the placement of an image on the copy page. This is useful if the image is smaller than 
the page size. Originals must be positioned as follows for image shift to work correctly: 

 Document Feeder: Position originals face up, long edge entering the feeder first. 

 Document Glass: Position originals face down, in the back-left corner of the document glass, long 
edge to the left. 

To change the placement of the image: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Layout Adjustment tab, then touch Image Shift. 

3. On the Image Shift screen, select one of the following: 

 Auto Center centers the image on the page. 

 Margin Shift allows you to specify the position of the image. Touch the Up or Down and Left or 
Right arrows to specify the amount of shift for Side 1. Touch the Up or Down and Left or Right 
arrows to specify the amount of shift for Side 2, or select Mirror Side 1. 

 

Note: You can use preset values that were previously saved by the system administrator. Touch 
Presets in the lower left corner of the screen, and select a preset from the drop-down menu. 

 

4. Touch Save. 
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Erasing the Edges of Copies 

You can erase content from the edges of your copies by specifying the amount to erase on the right, left, 
top, and bottom edges. 

To erase edges on copies: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Layout Adjustment tab, then touch Edge Erase. 

3. On the Edge Erase screen, select one of the following: 

 All Edges erases all four edges by the same amount. Touch the All Edges arrows to specify the 
amount to erase from the edges. 

 Individual Edges specifies different amounts for the edges. Touch Side 1, then touch the Left, 
Right, Top, and Bottom arrows to specify the amount to erase from each edge. Touch Side 2, 
then touch the Left, Right, Top, and Bottom arrows to specify the amount to erase from each 
edge, or touch Mirror Side 1. 

 

Note: You can use preset values that were previously saved by the system administrator. Touch 
Presets in the lower left corner of the screen, and select a preset from the drop-down menu. 

 

4. Touch Save. 
 

Inverting the Image 

You can invert your original, as a mirror image or as a negative image. You can use one or both of these 
options. 

To invert the image: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Layout Adjustment tab, then touch Invert Image. 

3. On the Invert Image screen, select the desired options: 

 Mirror Image reflects each image left to right on the page. The default setting is Normal 
Image. 

 Negative Image reverses the black and white values. The default setting is Positive Image. 

4. Touch Save. 
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Creating a Booklet 

You can print copies in the form of a booklet. The original page images are reduced to print two images 
per side of each printed page. You can then fold and staple the pages manually, or automatically using 
the appropriate finisher. 
 

Note: In this mode, the printer scans all of the originals before printing the copies. 

To create a booklet: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Output Format tab, then touch Booklet Creation. 

3. On the Booklet Creation screen, touch On. 

4. To select a paper tray: 

a. Touch Paper Supply. 

b. Touch the desired tray. 

c. Touch Save. 

5. If your printer has the Professional Finisher or the Office Finisher LX, under Fold & Staple, select one 
of the following options: 

 Fold & Staple 

 Fold Only 
 

Note: Folding and Stapling is dependent on the paper size. If the desired option is unavailable, touch 
Paper Supply, then select the appropriate tray and touch Save. 

 

6. To specify 2-sided originals: 

a. Touch Original Input. 

b. Touch 2 Sided Originals. 

7. Touch Save. 
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Including Covers 

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight 
paper. The printer selects the paper from a different tray. The covers can be blank or printed. 
 

Note: The paper used for the covers must be the same size as the paper used for the rest of the 
document. 

To select the type of covers and the tray to use for the cover paper: 

1. Press the Services Home button, then touch Copy. 

2. Under Paper Supply, touch the tray containing the paper for the body pages of the job. 
 

Note: If the paper supply is set to Auto Select, covers are unavailable. 
 

3. Touch the Output Format tab, then touch Special Pages. 

4. On the Special Pages screen, touch Covers. 

5. Under Covers Options, select one of the following: 

 Front & Back Same includes front and back covers from the same tray. 

 Front & Back Different includes a front and a back cover from different trays. 

 Front Cover Only includes only a front cover. 

 Back Cover Only includes only a back cover. 
 

Note: The Front & Back Different option includes two Printing Options menus. 
 

6. Touch Printing Options. 

7. From the drop-down menu that appears, select one of the following: 

 Blank Cover inserts a blank cover. 

 Print on Side 1 prints on the front side of the cover. 

 Print on Side 2 prints on the back side of the cover. To rotate the image on Side 2 by 
180 degrees, touch Rotate Side 2. 

 Print on Both Sides prints on both sides of the cover. To rotate the image on Side 2 by 
180 degrees, touch Rotate Side 2. 

8. Touch Paper Supply, then touch the tray containing the cover paper. 

9. Touch Save. 

10. On the Covers screen, touch Save. 

11. On the Special Pages screen, touch Save. 
 

Specifying Chapter Start Pagination 

If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If 
necessary, the printer leaves one side of the paper blank so that the chapter starts on the specified side of 
the paper. 

To set the start side of particular pages: 
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1. Press the Services Home button, then touch Copy. 

2. Under Paper Supply, touch the tray containing the paper for the body pages of the job. 
 

Note: If the paper supply is set to Auto Select, Chapter Starts is unavailable. 
 

3. Touch the Output Format tab, then touch Special Pages > Chapter Starts. 

4. On the Chapter Starts screen, touch the Page Number field, then use the alphanumeric keypad to 
enter the page number. 

5. Under Start Chapter, select the appropriate page: 

 On Right Page specifies the front side of the paper. 

 On Left Page specifies the back side of the paper. 

6. Touch Add. That page is added to the list on the right side of the screen. 

7. Repeat the three previous steps to set other pages. 

8. Touch Close. The page settings appear in the list on the right side of the screen. 

9. Touch Save. 
 

Adding Inserts 

You can insert blank pages or pre-printed sheets in specific locations in your copy job. You must specify 
the tray containing the inserts. 
 

Note: The paper used for the inserts must have the same width as the paper used for the rest of the 
document. Inserts cannot be added if Booklet Creation is selected. 

To add inserts: 

1. Press the Services Home button, then touch Copy. 

2. Under Paper Supply, touch the tray containing the paper for the body pages of the job. 
 

Note: If the paper supply is set to Auto Select, inserts cannot be added. 
 

3. Touch the Output Format tab, then touch Special Pages > Inserts. 

4. On the Inserts screen, touch the After Page Number field, then use the alphanumeric keypad to 
enter the page number. 

5. Touch the Insert Quantity arrows to specify the number of sheets to insert at that location. 

6. To specify the paper tray to use for the insert: 

a. Touch Paper Supply. 

b. Touch the desired tray. 

c. Touch Save. 

7. Touch Add. The insert appears in the list on the right side of the screen. 

8. Repeat the three previous steps to add additional inserts. 

9. Touch Close. The inserts appear in the list on the right side of the screen. 
 

Note: To edit or delete an insert, touch the insert in the list, then touch an action in the drop-down 
menu. 

 

10. Touch Save. 
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Specifying Exception Pages 

You can print exception pages in a copy job using paper from a different tray. The paper used for the 
exception pages must be the same size as the paper used for the rest of the document. 
 

Note: You cannot add exception pages if the paper supply is set to Auto Select, or if Booklet Creation 
is selected. 

To specify the exception pages: 

1. Press the Services Home button, then touch Copy. 
 

Note: If the paper supply is set to Auto Select, exception pages are unavailable. 
 

2. Under Paper Supply, touch the tray containing the paper for the body pages of the job. 

3. Touch the Output Format tab, then touch Special Pages > Exceptions. 

4. On the Exceptions screen, touch the beginning Page Number field, then use the alphanumeric 
keypad to enter the starting value for the range of the exception pages. 

5. Touch the ending Page Number field, then use the alphanumeric keypad to enter the starting value 
for the range of exception pages. 

 

Note: To specify a single page as an exception, enter its number as the start and end of the range. 
 

6. To specify the paper used for the exception pages: 

a. Touch Paper Supply. 

b. Touch the tray containing paper for the exception pages. 

c. Touch Save. 

7. Touch Add. The exception pages are added to the list on the right side of the screen. 

8. Repeat the four previous steps to add additional exception pages. 

9. Touch Close. The exception pages appear in the list on the right side of the screen. 
 

Note: To edit or delete an exception page, touch the page in the list, then touch the desired operation 
in the drop-down menu. 

 

10. Touch Save. 
 

Adding Annotations 

You can automatically add annotations such as page numbers and the date to your copies. 
 

Notes: 

 Annotations are not added to covers, tabs, inserts, or blank chapter start pages. 

 Annotations cannot be added if Booklet Creation is selected. 

To add annotations: 
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1. Press the Services Home button, then touch Copy. 

2. Touch the Output Format tab, then touch Annotations. 

3. To insert page numbers: 

a. On the Annotation screen, touch Page Numbers > On. 

b. Touch Apply To, and select one of the following: 

 All Pages 

 All Pages Except First 

c. Touch the Starting Page Number field, then use the alphanumeric keypad to enter the page 
number. 

d. Under Position, touch an arrow to position the page number in the header or footer. The sample 
page shows the location of the page number. 

e. Touch Save. 

f. To change the text formatting, touch Format & Style, choose the desired settings, then touch 
Save. 

4. To insert a comment: 

a. Touch Comment > On. 

b. Touch Apply To, and select one of the following: 

 All Pages 

 All Pages Except First 

 First Page Only 

c. Touch an existing comment in the list. 
 

Note: To create a new comment, touch a blank row, use the touch screen keyboard to type the text, 
then touch Save. 

 

d. Under Position, touch an arrow to position the selected comment in the header or footer. The 
sample page shows the location of the comment. 

e. Touch Save. 

f. To change the text formatting, touch Format & Style, choose the desired settings, then touch 
Save. 

5. To insert the current date: 

a. Touch Date > On. 

b. Touch Apply To, and select one of the following: 

 All Pages 

 All Pages Except First 

 First Page Only 
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c. Under Format, select a format for the date. 

d. Under Position, touch an arrow to position the date in the header or footer. The sample page 
shows the location of the date. 

e. Touch Save. 

f. To change the text formatting, touch Format & Style, choose the desired settings, then touch 
Save. 

6. To insert a Bates Stamp: 

a. Touch Bates Stamp > On. 

b. Touch the Starting Page Number field, then use the alphanumeric keypad to enter the starting 
page number. Leading zeros can be included. 

c. Touch Apply To, and select one of the following: 

 All Pages 

 All Pages Except First 

d. Touch an existing prefix in the list. 
 

Note: To create a new prefix, touch a blank row, use the touch screen keyboard to type up to eight 
characters, then touch Save. 

 

e. Under Position, touch an arrow to position the Bates Stamp in the header or footer. The sample 
page shows the location of the Bates Stamp. 

f. Touch Save. 

g. To change the text formatting, touch Format & Style, choose the desired settings, then touch 
Save. 

7. Touch Save. 
 

Adding Transparency Separators 

You can add blank sheets of paper between each printed transparency. The size and orientation of the 
separators must be the same as the transparencies. 

Note: Transparency separators cannot be added if the paper supply is set to Auto Select. 
 

To add transparency separators: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Output Format tab, then touch Transparency Separators > On. 

3. Under Separator Supply, touch the tray containing the paper to use for the separators. If the tray 
containing the separator paper is not displayed, touch More, touch the desired tray, then touch 
Save. 

4. Under Transparency Supply, touch the tray containing the transparencies. If the tray containing the 
transparencies is not displayed, touch More, touch the desired tray, then touch Save. 

5. Touch Save. 
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Printing Multiple Pages per Side 

You can copy a single page and have it print multiple times onto one or both sides of the paper. The 
printer reduces the pages proportionally to fit. 

To print multiple original pages on a side: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Output Format tab, then touch Page Layout > Pages per Side. 

3. Touch the number of original pages for each side of the paper. To specify a different number: 

a. Touch Specify Rows & Columns. 

b. Touch the Rows arrows to change the number of rows. 

c. Touch the Columns arrows to change the number of columns. 

d. Select the Rotate check box to rotate the page. 
 

Note: The right side of the screen contains a diagram of the image layout. 

4. Touch Original Orientation, then touch one of the following: 

 Portrait Originals 

 Landscape Originals 

5. Touch Save. 
 

Repeating an Image 

You can make multiple copies of an original image on one or both sides of the paper. This is useful for 
duplicating a small image. 

To repeat an image on a sheet of paper: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Output Format tab, then touch Page Layout > Repeat Image. 

3. Specify the number of images to print on the page: 

 Preset buttons repeat the image two, four, six, or nine times on each side of the paper. 

 Specify Rows & Columns allows you to determine the number of images. Touch the Rows or 
Columns field, then use the alphanumeric keypad to enter the number of rows and columns, or 
touch the arrows. Select the Rotate check box to rotate the paper. 

 Auto Repeat allows the printer to determine the maximum number of images that can fit on 
the currently selected paper size. Touch Original Orientation, and select Upright Images or 
Sideways Images from the drop-down menu. The sample page shows the image layout. 

4. Touch Save. 
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Advanced Copying 

This section includes: 

 Building a Copy Job............................................................................................................................................................. 96

 Printing a Sample Copy ..................................................................................................................................................... 96

 Saving Copy Settings .......................................................................................................................................................... 97

 Retrieving Saved Copy Settings ..................................................................................................................................... 97
 
 

Building a Copy Job 

Use this feature to produce complex copy jobs that include a variety of originals requiring different copy 
settings. Each segment of the job can have different copy settings. Once all the segments are 
programmed, scanned, and temporarily stored in the printer, the copy job prints. 

To build a copy job with multiple segments: 

1. Press the Services Home button, then touch Copy. 

2. Program and scan the first segment: 

a. Load the originals for the first segment. 

b. Select the required settings, such as layout adjustments, image quality, and so on. 

c. Touch the Job Assembly tab, then touch Build Job > On. 

d. Select or clear the Display this window between segments check box. 

e. Press the green Start button on the control panel. 

3. Program and scan additional segments: 

a. Load the originals for the next segment. 

b. When the Build Job screen appears, touch Program Next Segment. 

c. Using the appropriate tabs, select the required settings. 

d. Press the green Start button to scan the originals for that segment. 

4. Repeat the previous step for each remaining segment. 

5. When all of the segments have been programmed and scanned, touch Program Next Segment. 

6. Touch the Job Assembly tab, then touch Build Job. 

7. Using the alphanumeric keypad, enter the number of copies in the Quantity for Final Job field. 

8. In the upper right corner of the Build Job screen, touch Print the Job. The Job Progress screen 
appears. 

 

Note: If necessary, touch Delete > Delete Job to cancel the job. 
 
 

Printing a Sample Copy 

You can print a test copy of a complex copy job, before printing multiple copies. This feature prints a 
single copy and holds the remaining copies. After you inspect the sample, you can print or cancel the 
remaining copies. 
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Note: The sample copy is not counted as part of the quantity selected. For example, if you select 
three copies, one sample copy prints, and three other copies are held until they are released for 
printing. The result is a total of four copies. 

To print a sample copy of your copy job: 

1. Press the Services Home button, then touch Copy. 

2. Touch the desired copy settings. 

3. Touch the Job Assembly tab, then touch Sample Job > On. 

4. Touch Save. 

5. On the control panel, press the green Start button. The sample copy is printed. 

6. Print the remaining copies or delete the job: 

 To release and print the remaining copies of the job, touch Release. 

 If the sample copy is unsatisfactory, touch Delete > Delete Job. 
 

Saving Copy Settings 

To use a particular combination of copy settings for future copy jobs, you can save the settings with a 
name and retrieve them for later use. 

To save the current copy settings: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Job Assembly tab, then touch Save Current Settings. 

3. Using the touch screen keyboard, type a name for the saved settings. 

4. Touch Save. 
 

Retrieving Saved Copy Settings 

You can retrieve and use any previously saved copy settings for current jobs. 
 

Note: To save the copy settings with a name, see Saving Copy Settings. 

To retrieve saved settings: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Job Assembly tab, then touch Retrieve Saved Settings. 

3. Touch the desired saved setting. 
 

Note: To delete a saved setting, touch the setting, then touch Delete Settings. 
 

4. Touch Load Settings. The saved settings are loaded for the current copy job. 
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Basic Scanning 

Scanning is an optional printer feature providing several methods for scanning and storing an original 
document. The scanning procedure for your printer differs from that of desktop scanners. The printer is 
normally connected to a network rather than a single computer, so you select a destination for the 
scanned image at the printer. 

The printer supports the following scanning capabilities: 

 Scan a document and store the image on the printer hard drive. 

 Scan original document to a document repository on a network server. 

 Scan original document to an email address. 

 Scan original document to your home directory. 

 Create scan templates and download scanned images to your computer using Xerox® Scan 
Utility. 

 Import scanned images into applications using TWAIN and WIA. 

To scan an image: 

1. On the control panel, press the yellow Clear All button to clear previous settings. 

2. Load your original documents: 

 Use the document glass for single pages or paper that cannot be fed using the document 
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

 Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

3. Press the Services Home button, then touch Workflow Scanning. 

4. Touch the Down arrow, then select the template group from the menu. 

5. Select the desired template from the list. 

6. To change any of the scan settings, use the options at the bottom of the touch screen: 

 Output Color 

 2-Sided Scanning 

 Original Type 

 Scan Presets 

For details, see Changing the Basic Scan Settings on page 109. 
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7. Press the green Start button. 
 

Notes: 

 The printer must be connected to a network to retrieve a scan file. 

 The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC75xxdocs. You can also view the 
Help in CentreWare Internet Services. 

 Print, copy, and fax jobs can print while you are scanning original documents or downloading 
files from the printer hard drive. 

 
 

Document Glass 

 

 Lift the document feeder cover 
and place the first page face 
down in the upper left corner of 
the document glass. 

 The original must be aligned to 
the matching paper size printed 
on the edge of the glass. 

 The document glass accepts 
paper sizes up to 310 x 430 mm 
(12.25 x 17 in.). 

 The document glass 
automatically detects standard 
paper sizes. 
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Document Feeder 

 

 

 Insert originals face up, with page one 
on top. 

 The confirmation indicator illuminates 
when the originals are correctly 
loaded. 

 Adjust the paper guides so they fit 
against the originals. 

 The document feeder accepts paper 
weights from 38–128 g/m² for 1-sided 
pages, and 50–128 g/m² for 2-sided 
pages. 

 The document feeder accepts paper 
sizes from 85 x 125 mm (3.3 x 4.9 in.) 
to 297 x 432 mm (11.7 x 17 in.) for 
1-sided pages, and 110 x 125 (4.3 x 
4.9 in.) to 297 x 432 mm (11.7 x 17 in.) 
for 2-sided pages. 

 The maximum feeder capacity is 
approximately 110 sheets of 80 g/m2 
paper. 

 The document feeder automatically 
detects standard paper sizes. 
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Scanning to a Folder 

This section includes: 

 Scanning to the Public Folder ....................................................................................................................................... 103

 Scanning to a Private Folder ......................................................................................................................................... 104

 Creating a Private Folder ................................................................................................................................................ 104

 Retrieving Scan Files ......................................................................................................................................................... 105

Scanning to a folder is the simplest scanning method. When you scan an image at the printer, the scan 
file is stored in a folder on the internal hard drive. You then use CentreWare Internet Services to retrieve 
the stored scan file to your computer. 

The default settings create a 1-sided color .pdf document. You can change these settings using the 
printer control panel, or using CentreWare Internet Services at your computer. Control panel selections 
override the settings in CentreWare Internet Services. 
 

Note: The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC75xxdocs. 

 

 
 

Scanning to the Public Folder 

The printer provides a public folder to store scanned images. You do not need a password to scan images 
to the public folder, or to retrieve them. All users can view scanned documents in the public folder. You 
can also create a password-protected private folder. For details, see Creating a Private Folder on page 
104. 

To scan an image to the public folder: 

1. Load the original on the document glass or in the document feeder. 

2. Press the Services Home button, then touch Workflow Scanning. 

3. Touch the Down arrow, then select All Templates from the menu. 

4. Select the _PUBLIC folder from the list. 

5. To change any of the scan settings, use the options at the bottom of the touch screen: 

 Output Color 

 2-Sided Scanning 

 Original Type 

 Scan Presets 

For details, see Changing the Basic Scan Settings on page 109. 
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6. For more options, touch the Advanced Settings tab. For details, see Selecting Advanced Settings on 
page 110. 

7. Press the green Start button. The Job Progress screen appears, and the original is scanned. The file is 
stored on the printer hard drive. 

8. Use CentreWare Internet Services to move the file to your computer. For details, see Retrieving Scan 
Files on page 105. 

 

Scanning to a Private Folder 

The system administrator creates private folders on the printer. Private folders can require a password. 
You can use CentreWare Internet Services to create your own private folders. For details, see Creating a 
Private Folder on page 104. 

To scan to a private folder: 

1. Load the original on the document glass or in the document feeder. 

2. Press the Services Home button, then touch Workflow Scanning. 

3. Touch the Down arrow, then select All Templates from the menu. 

4. Select the private folder from the list. 

5. On the Document Management screen, touch Enter Password for Folder, then use the touch screen 
keyboard to type the password. 

6. Touch Done. 

7. Touch Save. 
 

Creating a Private Folder 

To create a private folder with a password: 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return.  

 

Note: If you do not know the IP address for your printer, see Finding the IP Address of the Printer on 
page 25. 

 

2. Click the Scan tab. 

3. In the Display section, select Mailboxes. 

4. In the Scan to Mailbox section, click Create Folder. 

5. Click the Folder Name: field, and type a name for the folder. 

6. In the Folder Password field, type a password that adheres to the password rules. 

7. In the Confirm Folder Password field, type the password again. 

8. Click Apply. 

Your private folder appears in the folder list in CentreWare Internet Services and on the printer touch 
screen under Local Templates. The contents are stored locally on the printer hard drive. 

 



Scanning 

 

 WorkCentre 7500 Series Multifunction Printer 105 
 User Guide 
 

Retrieving Scan Files 

To retrieve your scanned images, use CentreWare Internet Services to copy the scan files from the printer 
to your computer. 

To retrieve your scan files: 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return.  

 

Note: If you do not know the IP address for your printer, see Finding the IP Address of the Printer on 
page 25. 

2. Click the Scan tab. 

3. In the Display section, select Mailboxes. 

4. In the Scan to Mailbox section, click the folder you scanned to. 

5. For a private folder, click the Folder Password field, type the password, then click OK. The Folder 
Contents window shows your scan file. 

 

Note: If your image file does not appear, click Update View. 
 

6. Under Action, select one of the following options from the drop-down menu, then click Go: 

 Download saves a copy of the file to your computer. When prompted, click Save, then navigate 
to the location on your computer to save the file. Open the file or close the dialog box. 

 Reprint prints the file on the printer without saving a copy of the file to your computer. 

 Delete deletes the file from the mailbox. When prompted, click OK to delete the file or Cancel to 
cancel the operation. 
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Scanning to Network File Repositories 

This section includes: 

 Scanning to a Predefined Network File Repository ............................................................................................. 106

 Adding a Scan Destination ............................................................................................................................................ 106

When using this feature, the images you scan are sent to a file repository on a network server. The system 
administrator configures the file repository settings. 

Using CentreWare Internet Services, you can add your own scan destinations to templates. 
 

Note: The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC75xxdocs. 

 

 
 

Scanning to a Predefined Network File Repository 

To scan an image and send it to a predefined network file repository: 

1. Load the original on the document glass or in the document feeder. 

2. Press the Services Home button, then touch Workflow Scanning. 

3. Touch the Down arrow, then select All Templates from the drop-down menu. 

4. Select the template created by the system administrator from the list. The template defines the scan 
settings as well as the destination of the image. 

5. To change any of the scan settings, use the options at the bottom of the touch screen: 

 Output Color 

 2-Sided Scanning 

 Original Type 

 Scan Presets 

For details, see Changing the Basic Scan Settings on page 109. 

6. Press the green Start button. 
 

Adding a Scan Destination 

To add a scan destination to a template: 
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1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return.  

2. Click the Scan tab. 

3. In the Display area, select Templates. 

4. Under Template Operations, click Create New Template. 

5. In the New Distribution Template area, under Add Destination to Template, select the Enter a Scan 
Destination option. 

6. Click the Friendly Name: field, and create a name for the template. 

7. Under Protocol, select one of the following options: 

 FTP 

 SMB 

 HTTP 

 HTTPS 

8. Select and define the appropriate settings, such as: 

 Name, IP address, and port information 

 Script path and file name 

 Document path 

 Filing policy 

 Login credentials to access the destination 

 Login name 

 Password 
 

Note: For details, see the System Administration Guide at www.xerox.com/office/WC75xxdocs. 
 

9. Click Add. 

The template is stored on the printer hard drive. 
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Scanning to Your Home Directory 

The Scan to Home feature allows you to scan an image to your home directory. 
 

Note: The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC75xxdocs. 

To scan an image to your home directory: 

1. Load the original on the document glass or in the document feeder. 

2. Press the Services Home button, then touch Workflow Scanning. 

3. Touch the Down arrow, then select Scan to Home Templates from the menu. 

4. Select the template created by the system administrator from the list. 

5. To change any of the scan settings, use the options at the bottom of the touch screen: 

 Output Color 

 2-Sided Scanning 

 Original Type 

 Scan Presets 

For details, see Changing the Basic Scan Settings on page 109. 

6. For more options, touch the Advanced Settings tab. For details, see Selecting Advanced Settings on 
page 110. 

7. Press the green Start button. 
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Setting Scan Options 

This section includes: 

 Changing the Basic Scan Settings .............................................................................................................................. 109

 Selecting Advanced Settings ......................................................................................................................................... 110

 Selecting Layout Adjustments ...................................................................................................................................... 111

 Selecting Filing Options ................................................................................................................................................... 112

 Building a Scan Job ........................................................................................................................................................... 113

The scanning features in your printer use templates that define the scan settings and the destination for 
an image. 

 
 

Changing the Basic Scan Settings 

To change the basic scan settings: 

1. Press the Services Home button, then touch Workflow Scanning. 

2. Touch Output Color and select one of the following options: 

 Auto Detect detects the color content in the original image. If the original image is color, the 
printer scans in full color. If the original is a black and white document, the printer scans in black 
only. 

 Black & White scans in black and while only. 

 Grayscale detects and scans various shades of gray. 

 Color scans in full color. 

3. Touch 2-Sided Scanning and select one of the following options: 

 1-Sided scans only one side of the original image and produces 1-sided output files. 

 2-Sided scans both sides of the original image. 

 2-Sided, Rotate Side 2 scans both sides of the original image, rotating the second side. 

4. Touch Original Type and select one of the following options: 

 Photo & Text 

 Photo 

 Text 

 Map 

 Newspaper/Magazine 
 

Note: The photo and text options allow you to specify the type of original, such as printed, 
photocopied, photograph, inkjet, or solid ink. 

 

5. Touch Scan Presets and select one of the following options: 

 Sharing & Printing produces small file size and normal image quality. 
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 Archival - Small File Size produces smallest file size and normal image quality. 

 OCR Optical Character Recognition (OCR) produces large file size and highest image quality. 

 High Quality Printing produces large file size and highest image quality. 

 Simple Scan produces large file size with minimal image processing and compression. 
 

Selecting Advanced Settings 

Advanced settings allow you to control image options, image enhancements, scan resolution, file size, 
and updating of templates. 

To select advanced settings: 

1. Press the Services Home button, then touch Workflow Scanning. 

2. Touch the Advanced Settings tab. 

3. To adjust brightness, sharpness, and saturation: 

a. Touch Image Options. 

b. On the Image Options screen, adjust the sliders up or down as necessary: 

 Lighten/Darken lightens or darkens the image. 

 Sharpness sharpens or softens the image. 

 Saturation makes the image colors more vivid or pastel. 

c. Touch Save. 

4. To suppress background variation: 

a. Touch Image Enhancement. 

b. Under Background Suppression, touch Auto Suppression. 

c. Touch Save. 

5. To adjust the contrast: 

a. Touch Image Enhancement. 

b. On the Image Enhancement screen, select one of the following: 

 Auto Contrast allows the printer to set the contrast automatically. 

 Manual Contrast allows you to adjust the contrast manually. Move the Manual Contrast 
slider up or down to increase or decrease the contrast. The middle position on the slider, 
Normal, does not change the contrast. 
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c. Touch Save. 

6. To set the resolution: 

a. Touch Resolution. 

b. On the Resolution screen, select a resolution from 72 dpi through 600 dpi. 

c. Touch Save. 

7. To set the quality and file size: 

a. Touch Quality/File Size. 

b. On the Quality/File Size screen, use the slider to select a setting. The settings range from Normal 
Quality and Small File Size to Highest Quality and Largest File Size. 

c. Touch Save. 

8. To retrieve new templates and remove outdated ones: 

a. Touch Update Templates > Update Now. 

b. Touch Confirm. 
 

Selecting Layout Adjustments 

Layout adjustments provide additional settings for the size and orientation of the original, and erasing 
the edges. 

To select layout adjustments: 

1. Press the Services Home button, then touch Workflow Scanning. 

2. Touch the Layout Adjustment tab. 

3. To specify the orientation of the original image: 

a. Touch Original Orientation. 

b. On the Original Orientation screen, select one of the following options: 

 Upright Images and Sideways Images refer to the direction the originals are loaded in the 
document feeder. 

 Portrait Originals and Landscape Originals refer to the images on the originals. 

c. Touch Save. 

4. To scan the correct area of the original image: 

a. Touch Original Size. 

b. On the Original Size screen, select one of the following options: 

 Auto Detect allows the printer to determine the size of the original. 

 Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the 
scrolling list, touch the desired paper size. 

 Custom Scan Area allows you to specify the height and width of the area to scan. Touch 
the Height-Y and Width-X arrows to specify the area. 

 Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the 
diagram on the screen to determine which original sizes can be mixed in the same job. 
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c. Touch Save. 

5. To specify the amount to erase from the edges of your image: 

a. Touch Edge Erase. 

b. On the Edge Erase screen, select one of the following options: 

 All Edges erases all four edges by the same amount. Touch the All Edges arrows to specify 
the amount to erase from the edges. 

 Individual Edges specifies different amounts for the edges. Touch Side 1, then touch the 
Left, Right, Top, and Bottom arrows to specify the amount to erase from each edge. Touch 
Side 2, then touch the Left, Right, Top, and Bottom arrows to specify the amount to erase 
from each edge, or touch Mirror Side 1. 

c. Touch Save. 
 

Selecting Filing Options 

Filing Options provide additional settings for naming images, selecting image formats, and selecting 
behavior when a file name exists. 

To select filing options: 

1. Press the Services Home button, then touch Workflow Scanning. 

2. Touch the Filing Options tab. 

3. To define a file name prefix: 

a. Touch File Name. 

b. Use the touch screen keyboard to type a name for your image file. 

c. Touch Save. 

4. To select a file format: 

a. Touch File Format. 

b. On the File Format screen, select one of the following options: 

 PDF 

 PDF/A 

 XPS 

 Multi-Page TIFF 

 TIFF (1 File per Page) 

 JPEG (1 File per Page) 

c. For PDF, PDF/A, or XPS, select one of the following options: 

 Image Only 

 Searchable 
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d. For the searchable option, touch Document Language, then select a language from the 
drop-down menu. 

e. Touch Save. 

5. To select the action to take if a file already exists: 

a. Touch If File Already Exists. 

b. On the If File Already Exists screen, select one of the following options: 

 Add Number to Name 

 Add Date & Time to Name 

 Add to TIFF/JPEG Folder 

 Overwrite Existing File 

 Do Not Save 

c. Touch Save. 

6. To define additional network locations as destinations for scanned documents: 

a. Touch Add File Destinations. 

b. On the Add File Destinations screen, touch the desired destinations. 

c. Touch Save. 
 

Note: Document Management and Add File Destinations can only be modified after scanning to 
network file repositories or scanning to home have been set up. For details, see the System 
Administrator Guide at www.xerox.com/office/WC75xxdocs. 

 
 

Building a Scan Job 

Use this feature to combine an assorted group of originals for assembly into a single scan job. 

To build a scan job: 
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1. Press the Services Home button, then touch Workflow Scanning. 

2. Touch the Job Assembly tab, then touch Build Job > On. 

3. Select or clear the Display this window between segments check box. 

4. Program and scan the first segment: 

a. Load the originals for the first segment. 

b. Press the green Start button on the control panel. 
 

Note: If a password is required, contact the system administrator. 
 

5. Program and scan additional segments: 

a. Load the originals for the next segment. 

b. When the Build Job screen appears, touch Program Next Segment. 

c. Press the green Start button to scan the originals for that segment. 

6. Repeat the previous step for each remaining segment. 
 

Note: At any time, you can touch Delete Last Segment or Delete All Segments to modify the job. 
 

7. When all of the segments have been programmed and scanned, touch Submit the Job. The Job 
Progress screen appears, and the individual segments are scanned as a single job. 

8. On the Job Progress screen, touch Job Details to view a summary of the job. 
 

Note: If necessary, touch Delete > Delete Job to cancel the job. 
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Scanning to a USB Flash Drive 

You can insert a USB Flash Drive into the printer, scan a document, and store the scanned file on the USB 
Flash Drive. 
 

Note: The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC75xxdocs. 

To scan to a USB Flash Drive: 

1. Load the original on the document glass or in the document feeder. 

2. Insert your USB Flash Drive in the USB port on the printer control panel. 

3. On the USB Drive Detected screen, touch Store to USB. 

4. To change any of the scan settings, use the options at the bottom of the touch screen: 

 Output Color 

 2-Sided Scanning 

 Original Type 

 Scan Presets 

For details, see Changing the Basic Scan Settings on page 109. 

5. Press the green Start button. 

The Job Progress screen appears, and the original is scanned. The file is stored on your USB Flash 
Drive in the root directory. 

6. Remove your USB Flash Drive from the printer. 
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Scanning to an Email Address 

This section includes: 

 Sending a Scanned Image to an Email Address ................................................................................................... 116

 Setting Email Options ...................................................................................................................................................... 117

When using this feature, the images you scan are sent as email attachments. 
 

Note: The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC75xxdocs. 

 

 
 

Sending a Scanned Image to an Email Address 

To scan an image and send it to an email address: 

1. Load the original on the document glass or in the document feeder. 

2. Press the Services Home button, then touch E-mail. 

3. To enter an email address: 

a. Touch New Recipient. 

b. Touch the Down arrow, then select To: or Cc: or Bcc: from the menu. 

c. Touch the Enter email address and select Add field, then use the touch screen keyboard to 
type the email address. 

d. Touch Add. 

e. Use the touch screen keyboard to type additional email addresses. 

f. When you are finished, touch Close. 

4. To enter an email address from the network address book: 

a. Touch Address Book. 

b. Use the touch screen keyboard to type part of the name, then touch Search. 

c. Select the desired name from the list, then touch Add. 

5. To add a subject line: 

a. Touch Subject, then use the touch screen keyboard to type the desired text. 
 

Note: To modify the default subject that appears, touch Clear Text to clear the field, or use the Left 
and Right arrows to edit the text. 

 

b. Touch Save. 

6. To change any of the scan settings, use the options at the bottom of the touch screen: 

 Output Color 

 2-Sided Scanning 



Scanning 

 

 WorkCentre 7500 Series Multifunction Printer 117 
 User Guide 
 

 Original Type 

 Scan Presets 

For details, see Changing the Basic Scan Settings on page 109. 

7. Press the green Start button. 
 

Setting Email Options 

You can change the following email settings: 

 File Name 

 File Format 

 Message 

 Reply To 

To change the email options: 

1. Load the original on the document glass or in the document feeder. 

2. Press the Services Home button, then touch E-mail. 

3. To change any of the scan settings, use the options at the bottom of the touch screen: 

 Output Color 

 2-Sided Scanning 

 Original Type 

 Scan Presets 

For details, see Changing the Basic Scan Settings on page 109. 

4. Touch the E-mail Options tab. 

5. Change the file name: 

a. Touch File Name. 

b. On the File Name screen, use the touch screen keyboard to delete or modify the default text. 

c. Touch Save. 

6. Change the file format: 

a. Touch File Format. 

b. On the File Format screen, select one of the following options: 

 PDF 

 PDF/A 

 XPS 

 Multi-Page TIFF 

 TIFF (1 File per Page) 

 JPEG (1 File per Page) 

c. For PDF, PDF/A, or XPS, select one of the following options: 

 Image Only 

 Searchable 
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d. For the searchable option, touch Document Language, then select a language from the 
drop-down menu. 

e. Touch Save. 

7. Change the message: 

a. Touch Message. 

b. On the Message screen, use the touch screen keyboard to type a message to appear with the 
images. 

c. Touch Save. 

8. Change the Reply To address: 

a. Touch Reply To. 

b. On the Reply To screen, use the touch screen keyboard to type an email address. 

c. Touch Save. 

9. Press the green Start button. 
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Scanning with the Xerox® Scan Utility 

This section includes: 

 Scanning Directly to Your Computer ......................................................................................................................... 119

 Creating and Deleting Scan Templates ................................................................................................................... 121

 Managing Xerox® Scan Utility Folder and Email Profiles ................................................................................ 125

 Using the Scan to Email and Copy to Folder Tools ............................................................................................. 128

The Xerox® Scan Utility allows you to scan images from the printer directly to your computer. Scanned 
images are not stored in the printer. You can create scan templates, preview images, copy images to a 
folder on your computer, and copy images to email. You can also import images into Windows 
applications using their import and image management functions. 
 

Note: You must install the scan drivers to use the Xerox® Scan Utility. For details, see Installing the 
Software on page 32. 

  

 
 

Scanning Directly to Your Computer 

To scan directly to your computer using your own template: 

1. Load the original on the document glass or in the document feeder. 

2. Press the Services Home button, then touch Workflow Scanning. 

3. Touch the Down arrow, then select All Templates from the menu. 

4. In the list, touch the scan template you created. For details about creating a template, see Creating 
and Deleting Scan Templates on page 121. 

 

Note: Control panel selections override the settings in CentreWare Internet Services. 
 

5. To change any of the scan settings, use the options at the bottom of the touch screen: 

 Output Color 

 2-Sided Scanning 

 Original Type 

 Scan Presets 

For details, see Changing the Basic Scan Settings on page 109. 

6. Press the green Start button. 

7. Enter your user credentials: 

a. On the Login Required screen, touch OK. 

b. Use the touch screen keyboard to type your user name, then touch Next. 

c. Type your password, then touch Done. 

The touch screen shows the job progress. Your file is stored in the selected folder on your computer. 
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Note: If scanning fails, a Workflow Scanning Confirmation Report prints, showing the failed status. 
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Creating and Deleting Scan Templates 

This section includes: 

 Creating a Template with Image Preview ............................................................................................................... 121

 Creating a Template to Scan Images to a Folder ................................................................................................ 122

 Deleting a Scan Template .............................................................................................................................................. 124

Scan driver templates include settings for output color, original size and type, resolution, file format, and 
sides to scan. You can also specify settings to preview images, or specify a destination folder on your 
computer for scanned images. 

 
 

Creating a Template with Image Preview 

To create a template that retains thumbnail preview images in the Xerox® Scan Utility: 

1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 

 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Scan Settings tab, then select the desired settings for the template: 

a. Under Output Color, select one of the following: 

 Auto 

 Black and White 

 Color 

 Grayscale 

b. Under Original Size, select one of the following: 

 Auto 

 Mixed Size Originals 

 Letter (8.5 x 11") LEF 

 Letter (8.5 x 11") SEF 

 Legal (8.5 x 14") SEF 

c. Under Resolution, select one of the following: 

 150x150 

 200x200 

 300x300 

 400x400 

 600x600 

d. Under Original Type, select one of the following: 

 Photo and Text 
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 Photo 

 Text 

 Graphics 

e. Under File Format, select one of the following: 

 Multi-page TIFF 

 Single-page TIFF 

 JPEG 

 BMP 

 GIF 

f. Under Sides to Scan, select one of the following: 

 1 Sided 

 2 Sided 

 2 Sided, Rotate Side 2 

3. Click the Preview image in Xerox® Scan Utility option. This option sends the scanned image to the 
folder you specify, and the image appears on the Scan to Email and Copy to Folder tabs. 

4. Under Saved Template Settings, click the < New Saved Template Name > field, then type a name 
for the new template. 

 

Note: Spaces are not permitted in template names. 
 

5. Specify a folder destination. 

6. Click Save. 

The template appears in the list on the touch screen. 
 

Note: To edit an existing template with the settings you selected, select a template from the Saved 
Template Settings drop-down list. 

 
 

Creating a Template to Scan Images to a Folder 

To create a template that places scanned images in a specific folder on your computer: 

1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 

 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Scan Settings tab, then select the desired settings for the template: 

a. Under Output Color, select one of the following: 

 Auto 

 Black and White 

 Color 

 Grayscale 
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b. Under Original Size, select one of the following: 

 Auto 

 Mixed Size Originals 

 Letter (8.5 x 11") LEF 

 Letter (8.5 x 11") SEF 

 Legal (8.5 x 14") SEF 

c. Under Resolution, select one of the following: 

 150x150 

 200x200 

 300x300 

 400x400 

 600x600 

d. Under Original Type, select one of the following: 

 Photo and Text 

 Photo 

 Text 

 Graphics 

e. Under File Format, select one of the following: 

 Multi-page TIFF 

 Single-page TIFF 

 JPEG 

 BMP 

 GIF 

f. Under Sides to Scan, select one of the following: 

 1 Sided 

 2 Sided 

 2 Sided, Rotate Side 2 

3. Click the Send image directly to Folder option. This option allows you to send the scanned images 
directly to a designated folder without first viewing the images. 

4. To create a unique file name for the scanned images in the thumbnail view, click the Base File Name 
field, then type a file name. 

The Xerox® Scan Utility adds the scan date and time information for each image to the end of the 
file name. 

5. Under Save to Folder, do one of the following to specify the destination folder: 

 Type the path to the folder. 

 Click Browse to locate the folder. 
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Note: Some folders always cause the scan job to fail. 
 

6. Select or clear the Save a copy in Xerox® Scan Utility check box. This option allows you to save 
thumbnail views in the Copy to Folder and Scan to Email tabs. 

7. Under Saved Template Settings, click the < New Saved Template Name > field, then type a name 
for the new template. 

 

Note: Spaces are not permitted in template names. 
 

8. Click Save. 

The template appears in the list on the printer touch screen. 
 

Note: To edit an existing template with the settings you selected, select a template from the Saved 
Template Settings drop-down list. 

 
 

Deleting a Scan Template 

To delete a scan template from the Xerox® Scan Utility and the printer touch screen: 

1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 

 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Scan Settings tab. 

3. Under Saved Template Settings, click the < New Saved Template Name > field, then select the 
template you want to delete from the drop-down list. 

4. Click Delete. 

5. When prompted, click Yes to delete the template. 

The template is removed from the template list in the Xerox® Scan Utility and from the template list 
on the printer touch screen. 
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Managing Xerox® Scan Utility Folder and Email Profiles 

This section includes: 

 Creating or Editing Email Profiles ............................................................................................................................... 125

 Deleting Email Profiles ..................................................................................................................................................... 125

 Creating or Editing Folder Profiles .............................................................................................................................. 126

 Deleting Folder Profiles ................................................................................................................................................... 126

With the Xerox® Scan Utility, you can create profiles containing email or folder destination information. 
Use the profiles when sending scanned images as email attachments or copying scanned images to 
specific folders. 

 
 

Creating or Editing Email Profiles 

To create or revise an email profile: 

1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 

 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Scan to Email tab. 

3. Select one of the following options: 

 To create a new profile, type the name in the Email Profiles field. 

 To edit an existing profile, select a profile from the Email Profiles drop-down list. 

4. To create a unique name for one or more of the scanned images in the thumbnail view: 

a. Select the images. 

b. Click the Base Attachment Name field, then type a file name. 
 

Note: The Xerox® Scan Utility adds the scan date and time information for each image to the end of 
the file name. 

 

5. Type the appropriate information in the following fields: 

 To: 

 CC: 

 Subject: 

 Message: 

6. Click Save. 
 

Deleting Email Profiles 

To delete an email profile: 
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1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 

 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Scan to Email tab. 

3. Select the profile you want to delete from the Email Profiles drop-down list. 

4. Click Delete. 

5. When prompted, click Yes to delete the profile. 
 

Creating or Editing Folder Profiles 

To create or revise a folder profile: 

1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 

 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Copy to Folder tab. 

3. Select one of the following options: 

 To create a new profile, type the name in the Folder Profiles field. 

 To edit an existing profile, select a profile from the Folder Profiles drop-down list. 

4. To create a unique name for one or more of the scanned images in the thumbnail view: 

a. Select the images. 

b. Click the Base File Name field, then type a file name. 
 

Note: The Xerox® Scan Utility adds the scan date and time information for each image to the end of 
the file name. 

 

5. Under Save to Folder, do one of the following to specify the destination folder: 

 Type the path to the folder. 

 Click Browse to locate the folder. 

6. Click Save. 
 

Deleting Folder Profiles 

To delete a folder profile: 

1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 
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 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Copy to Folder tab. 

3. Select the profile you want to delete in the Folder Profiles drop-down list. 

4. Click Delete. 

5. When prompted, click Yes to delete the profile. 
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Using the Scan to Email and Copy to Folder Tools 

This section includes: 

 Using an Email Profile ...................................................................................................................................................... 128

 Selecting New Email Settings ....................................................................................................................................... 129

 Using a Folder Profile ....................................................................................................................................................... 129

 Deleting Image Files ......................................................................................................................................................... 130

Use the Scan to Email or Copy to Folder tools to attach scanned images to email messages or copy them 
to local or network folders. 

When sending scanned images as email attachments, you can use a saved email profile or manually 
enter the email addresses, subject line, and message text. 

When copying scanned images to a folder, you can use a folder profile that has been saved with specific 
settings. 

 
 

Using an Email Profile 

To send scanned images as attachments in an email using an email profile: 

1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 

 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Scan to Email tab. 

3. Select one or more thumbnail images to send with an email. 

4. Select a profile from the Email Profiles drop-down list. 
The Attachment Base Name, To, CC, Subject, and Message fields display information from the saved 
profile. 

 

Note: The Xerox® Scan Utility adds the scan date and time information for each image to the end of 
the file name. 

 

5. If desired, click any of the fields, then type new email settings. 

6. Click Copy to Email to open your email application. 

The selected images are attached to the email message. 

7. If desired, make additional changes to the email settings. 

8. Send the email. 
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Selecting New Email Settings 

To send scanned images as attachments in an email without using a profile: 

1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 

 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Scan to Email tab. 

3. Select one or more images to send with an email. 

4. Click the Base Attachment Name field, then type a file name. 

The Xerox® Scan Utility adds the scan date and time information for each image to the end of the 
file name. 

5. Type the appropriate information in the following fields: 

 To: 

 CC: 

 Subject: 

 Message: 

6. Click Copy to Email to open your email application. 

The selected images are attached to the email message. 

7. If desired, make additional changes to the email settings. 

8. Send the email. 
 

Using a Folder Profile 

You can create a folder profile to save folder destinations that you frequently use. 

To copy scanned images to a folder using a folder profile: 

1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 

 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Copy to Folder tab. 

3. Select one or more images to copy. 

4. Select a profile from the Folder Profiles drop-down list. 

5. If desired, click the Base File Name field, then type a different file name. 

The Xerox® Scan Utility adds the scan date and time information for each image to the end of the 
file name. 

6. Under Save to Folder, do one of the following to specify the destination folder: 

 Type the path to the folder. 
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 Click Browse to locate the folder. 

7. Click Copy to Folder to copy the selected images to the folder. 
 

Deleting Image Files 

Scanned images displayed in the Xerox® Scan Utility are stored on your computer hard drive. 

To delete scanned images that are no longer needed: 

1. Access the Xerox® Scan Utility on your computer using one of the following methods: 

 Windows: Right-click the Xerox® Scan Utility Menu icon in the taskbar, then select Open 
Xerox® Scan Utility. If the icon does not appear in the taskbar, click Start > Programs > Xerox® 
Office Printing > Scanning > Xerox® Scan Utility. 

 Macintosh: Navigate to Applications > Xerox® > Xerox® Scan Utility, then double-click Xerox® 
Scan Utility. 

2. Click the Scan to Email or Copy to Folder tab. 

3. Select the images you want to delete. 

4. Click Delete Scanned Image. 
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This chapter includes: 

 Basic Faxing .......................................................................................................................................................................... 132

 Sending an Embedded Fax ............................................................................................................................................ 134

 Sending a Server Fax ........................................................................................................................................................ 144

 Sending an Internet Fax ................................................................................................................................................. 148

 Using the Address Book ................................................................................................................................................... 155

The system administrator must set up some fax features before you can use them. For details, see the 
System Administrator Guide at www.xerox.com/office/WC75xxdocs. 
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Basic Faxing 

You can send a fax in one of four ways: 

 Embedded Fax: The document is scanned and sent directly to a fax machine. 

 Server Fax: The document is scanned and sent through an Ethernet network to a fax server, which 
sends the fax to a fax machine. 

 Internet Fax: The document is scanned and emailed to a recipient. 

 Faxing from your computer: The current print job is sent as a fax. For details, see the print driver 
software. 

To send a fax: 

1. Load your original documents: 

 Use the document glass for single pages or paper that cannot be fed using the document 
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

 Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

2. Press the Services Home button, then touch the appropriate fax: 

 Fax scans the document and sends it directly to a fax machine. 

 Server Fax scans the document and sends it through an Ethernet network to a fax server, which 
sends the fax to a fax machine. 

 Internet Fax scans the document and emails it to a recipient. 

3. Address the fax using one or more of the available options: 

 Enter Number and Press Add 

 Dialing Characters 

 Address Book 

 Speed Dial 

 Fax Directory 

 New Recipient 

4. On the Fax tab, adjust the available fax options as needed: 

 2-Sided Scanning 

 Original Type 

 Resolution 

 Output Color 

5. Adjust additional fax options if required. For details, see Selecting Embedded Fax Options on page 
136, Selecting Server Fax Options on page 145, or Selecting Internet Fax Options on page 150. 

6. Press the green Start button. The printer scans the pages and transmits the document when all 
pages have been scanned. 
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Document Glass 

 

 Lift the document feeder cover 
and place the first page face 
down in the upper left corner of 
the document glass. 

 The original must be aligned to 
the matching paper size printed 
on the edge of the glass. 

 The document glass accepts 
paper sizes up to 310 x 430 mm 
(12.25 x 17 in.). 

 The document glass 
automatically detects standard 
paper sizes. 

 
 

Document Feeder 

 

 

 Insert originals face up, with page one 
on top. 

 The confirmation indicator illuminates 
when the originals are correctly 
loaded. 

 Adjust the paper guides so they fit 
against the originals. 

 The document feeder accepts paper 
weights from 38–128 g/m² for 1-sided 
pages, and 50–128 g/m² for 2-sided 
pages. 

 The document feeder accepts paper 
sizes from 85 x 125 mm (3.3 x 4.9 in.) 
to 297 x 432 mm (11.7 x 17 in.) for 
1-sided pages, and 110 x 125 (4.3 x 
4.9 in.) to 297 x 432 mm (11.7 x 17 in.) 
for 2-sided pages. 

 The maximum feeder capacity is 
approximately 110 sheets of 80 g/m2 
paper. 

 The document feeder automatically 
detects standard paper sizes. 
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Sending an Embedded Fax 

The system administrator must set up this feature before you can use it. For details, see the System 
Administrator Guide at www.xerox.com/office/WC75xxdocs. 

To send an embedded fax: 

1. Load the original document in the document feeder or on the document glass. 

2. Press the Services Home button, then touch Fax. 

3. To address the fax, touch one or more of the following: 

 The Enter Number and Press Add field allows you to enter a fax number manually. Use the 
alphanumeric keypad to enter the number, then touch Add. 

 Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Add. Add more numbers, 
or touch Close. 

 Address Book allows you to select fax numbers from your Address Book. Touch the Down arrow, 
then select Individual or Group from the drop-down menu. Touch the Up or Down arrows to 
scroll through the list, touch the desired contact, then select Add to Recipients from the 
drop-down menu. Select and add more contacts, or touch Close. 

 The Speed Dial check box allows you to select recipients from your address book. Touch the 
Enter Number and Press Add field, then use the alphanumeric keypad to enter the three-digit 
speed dial number. Touch Add. 

4. To include a cover sheet: 

a. Touch Cover Sheet > On. 

b. Touch the To field, use the touch screen keyboard to type the name of the recipient, then touch 
Save. 

c. Touch the From field, use the touch screen keyboard to type the name of the sender, then touch 
Save. 

d. To add a comment, do one of the following: 

 Touch an existing comment, then touch Save. 

 Touch an <Available> comment, touch Edit, use the touch screen keyboard to type the 
text, then touch Save. 

 

Notes: 

 To delete an existing comment, touch the comment, then touch Clear. Touch Clear to confirm 
the action. 

 To edit an existing comment, touch the comment, then touch Edit. Use the touch screen 
keyboard to change the comment, then touch Save. 

 

5. Adjust the fax scanning options if necessary: 

a. Touch 2-sided Scanning and select from the drop-down menu: 

 1-Sided 

 2-Sided 
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 2-Sided, Rotate Side 2 

b. Touch Original Type and select from the drop-down menu: 

 Photo & Text 

 Photo 

 Text 

c. Touch Resolution and select from the drop-down menu: 

 Standard (200x100 dpi) 

 Fine (200 dpi) 

 Super Fine (600 dpi) 

6. If desired, select more options. For details, see Selecting Embedded Fax Options on page 136. 

7. Press the green Start button. The printer scans the pages and transmits the document when all 
pages have been scanned. 
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Selecting Embedded Fax Options 

This section includes: 

 Adjusting Brightness and Sharpness ......................................................................................................................... 136

 Automatically Suppressing Background Variation .............................................................................................. 136

 Adjusting the Contrast ..................................................................................................................................................... 137

 Specifying the Size of the Original ............................................................................................................................. 137

 Selecting Reducing or Splitting .................................................................................................................................... 137

 Setting Up Book Faxing ................................................................................................................................................... 138

 Requesting a Confirmation Report ............................................................................................................................. 138

 Selecting the Starting Rate ............................................................................................................................................ 138

 Sending a Delayed Fax .................................................................................................................................................... 138

 Sending Header Text ........................................................................................................................................................ 139

 Sending a Fax to a Remote Mailbox .......................................................................................................................... 139

 Storing a Fax in a Local Mailbox ................................................................................................................................. 140

 Printing Local Mailbox Documents ............................................................................................................................. 140

 Deleting Local Mailbox Documents ........................................................................................................................... 140

 Storing a Fax for Local or Remote Polling ............................................................................................................... 140

 Printing or Deleting Faxes Stored for Polling ......................................................................................................... 141

 Polling a Remote Fax ........................................................................................................................................................ 141

 Polling a Remote Mailbox............................................................................................................................................... 142

 Building a Fax Job .............................................................................................................................................................. 142
 
 

Adjusting Brightness and Sharpness 

You can lighten or darken the image, and adjust the sharpness. 

To adjust the image: 

1. Touch the Image Quality tab, then touch Image Options. 

2. On the Image Options screen, adjust the sliders up or down as necessary: 

 Lighten/Darken lightens or darkens the image. 

 Sharpness sharpens or softens the image. 

 Touch Save. 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can 
sometimes be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the 
printer to variations in light background colors. 
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To change this setting: 

1. Touch the Image Quality tab, then touch Image Enhancement. 

2. Under Background Suppression, touch Auto Suppression. 

3. Touch Save. 
 

Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To increase or reduce the contrast: 

1. Touch the Image Quality tab, then touch Image Enhancement. 

2. On the Image Enhancement screen, adjust the contrast: 

 Manual Contrast allows you to adjust the contrast manually. Under Manual Contrast, move the 
slider up or down to increase or decrease the contrast. The middle position on the slider, Normal, 
does not change the contrast. 

 Auto Contrast allows the printer to set the contrast automatically. 

3. Touch Save. 
 

Specifying the Size of the Original 

To scan the correct area of the original, specify the original size: 

1. Touch the Layout Adjustment tab, then touch Original Size. 

2. On the Original Size screen, select one of the following: 

 Auto Detect allows the printer to determine the size of the original. 

 Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the 
scrolling list, touch the desired paper size. 

 Custom Scan Area allows you to specify the height and width of the area to scan. Touch the 
Height-Y and Width-X arrows to specify the area. 

 Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the 
diagram on the screen to determine which original sizes can be mixed in the same job. 

3. Touch Save. 
 

Selecting Reducing or Splitting 

You can determine the method to use for handling images that are too large. 

To select Reducing or Splitting: 

1. Touch the Layout Adjustment tab, then touch Reduce/Split. 

2. Touch one of the following options: 

 Reduce to Fit shrinks large documents to fit on smaller paper. 

 Split Across Pages continues a single image across several pages. 

3. Touch Save. 
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Setting Up Book Faxing 

You can determine the method used for scanning images in a book. 

To select Book Faxing: 

1. Touch the Layout Adjustment tab, then touch Book Faxing. 

2. Touch one of the following options: 

 Off is the default setting. 

 Both Pages scans both pages of the book. If necessary, touch the Binding Edge Erase arrows to 
set the amount to erase from the binding edge. 

 Left Page Only scans the left page of the book. If necessary, touch the Binding Edge Erase 
arrows to set the amount to erase from the binding edge. 

 Right Page Only scans the right page of the book. If necessary, touch the Binding Edge Erase 
arrows to set the amount to erase from the binding edge. 

3. Touch Save. 
 

Requesting a Confirmation Report 

You can request a report that confirms when your faxes are sent or received. The report contains 
information on timeouts, busy signals, and retry failures. 

To set up a Confirmation Report: 

1. Touch the Fax Options tab, then touch Confirmation Report. 

2. Touch one of the following options: 

 Always Print generates a report for all fax jobs. 

 Print on Error Only only generates a report for fax jobs that fail to send. 

3. Touch Save. 
 

Selecting the Starting Rate 

Select the highest starting rate unless the destination for the fax you are sending has special 
requirements. 

To select the transmission speed for a fax: 

1. Touch the Fax Options tab, then touch Starting Rate. 

2. Touch one of the following options: 

 Super G3 (33.6 Kbps) 

 G3 (14.4 Kbps) 

 Forced (4800 bps) 

3. Touch Save. 
 

Sending a Delayed Fax 

You can set a time in the future for the printer to send your fax job. The time delay can be from 15 
minutes to 24 hours from the current time. 
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Note: The printer must be set to the current time before you can use this feature. 
 

To specify the time to send your fax: 

1. Touch the Fax Options tab, then touch Delay Send. 

2. Touch Specified Time and set the time: 

a. Touch the Hour field and use the keypad or touch the arrows to set a number. 

b. Touch the Minute field and use the keypad or touch the arrows to set a number. 

c. If your printer is set to display the 12-hour clock, touch AM or PM. 

3. Touch Save. The fax is sent at the specified time. 
 

Sending Header Text 
 

Note: The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC75xxdocs. 

To include the fax header text: 

1. Touch the Fax Options tab, then touch Send Header Text. 

2. Touch one of the following options: 

 Off is the default setting. 

 On sends the header text with the fax. 

3. Touch Save. 
 

Sending a Fax to a Remote Mailbox 

To store a fax in a remote mailbox: 

1. Touch the Fax Options tab, then touch Mailboxes. 

2. Touch Send to Remote Mailbox. 

3. Select one of the following options to address the fax: 

 The Fax Number field allows you to manually enter a fax number. Use the alphanumeric 
keypad to enter the number, then touch Add. 

 Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Save. 

 Address Book allows you to select fax numbers from your Fax Address Book. Touch the Up or 
Down arrows to scroll through the list, touch the desired contact, then select Add to Recipients 
from the drop-down menu. Select and add more contacts, or touch Close. 

4. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number. 

5. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit mailbox 
passcode. 

6. Touch Save. 
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Storing a Fax in a Local Mailbox 

Note: The system administrator must create a mailbox before you can use this feature. For details, 
see the System Administrator Guide at www.xerox.com/office/WC75xxdocs. 

To store a fax in a local mailbox: 

1. Touch the Fax Options tab, then touch Mailboxes. 

2. Touch Store to Local Mailbox. 

3. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number. 

4. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit mailbox 
passcode. 

5. Touch Save. 
 

Printing Local Mailbox Documents 

Note: You must have documents stored in a mailbox in order to use this feature. For details, see 
Storing a Fax in a Local Mailbox on page 140. 

To print local mailbox documents: 

1. Touch the Fax Options tab, then touch Mailboxes. 

2. Touch Print Local Mailbox Documents. 

3. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number. 

4. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit mailbox 
passcode. 

5. Touch Print All Documents. The documents in the mailbox are printed. 
 

Deleting Local Mailbox Documents 

To delete all of the documents in a local mailbox: 

1. Touch the Fax Options tab, then touch Mailboxes. 

2. Touch Delete Local Mailbox Documents. 

3. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number. 

4. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit mailbox 
passcode. 

5. Touch Delete All Documents. 

6. Touch Delete All to confirm the action. All documents in the mailbox are deleted. 
 
 

Storing a Fax for Local or Remote Polling 

Turn on Secure or Non-Secure Local Polling to make fax documents stored on one printer available for 
remote polling by other printers. When Secure Local Polling is on, you create a list of fax numbers that are 
allowed to access the stored faxes on the printer. 

To store a fax: 
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1. Touch the Fax Options tab, then touch Local Polling. 

2. Under Store for Local Polling, touch one of the following options: 

 Non-Secure Polling scans your originals and stores them as documents. Anyone with this fax 
number can access the documents. 

 Secure Polling scans your originals and stores them as documents. You specify the fax numbers 
that can access the documents. 

3. For secure polling, touch one or more of the following to add fax numbers to the access list: 

 Fax Number field allows you to enter a fax number manually. Use the alphanumeric keyboard 
to enter the number, and touch Add. 

 Address Book allows you to add individual stored fax numbers to the list. Select a fax number, 
and select Add to Recipients from the drop-down menu. Touch Close. 

 The Allow all Address Book fax numbers access check box adds all stored fax numbers to the 
list. 

 

Note: To modify existing entries in the access list, touch the entry, then select Edit, Remove, or 
Remove All from the drop-down menu. 

 

4. Touch Save. 
 

Printing or Deleting Faxes Stored for Polling 

To print or delete stored faxes: 

1. Touch the Fax Options tab, then touch Local Polling. 

2. Under Stored Local Documents, touch one of the Local Polling options: 

 Print All prints all stored fax documents. 

 Delete All deletes all stored fax documents. Touch Delete All to confirm the action. 
 

Polling a Remote Fax 

If remote polling is turned on, you can retrieve documents that were stored using local polling on another 
fax machine. 
 

Note: If Local Polling is turned on, Remote Polling is not available. To turn off Local Polling, touch 
Local Polling > Off > Save. 

 

To poll a remote fax: 

1. Touch the Fax Options tab, then touch Remote Polling. 

2. Touch Poll a Remote Fax. 

3. Select one or more options for addressing the fax: 

 The Enter Number and Press Add field allows you to enter a fax number manually. Use the 
alphanumeric keypad to enter the number, then touch Add. 

 The Speed Dial check box allows you to select recipients from your address book. Touch the 
Enter Number and Press Add field, then use the alphanumeric keypad to enter the three-digit 
speed dial number. Touch Add. 
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 Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Save. 

 Address Book allows you to select fax numbers from your Fax Address Book. Touch the Up or 
Down arrows to scroll through the list, touch the desired contact, then select Add to Recipients 
from the drop-down menu. Select and add more contacts, or touch Close. 

4. To set a later time when you want your printer to retrieve faxes from other fax machines: 

a. Touch Delay Send. 

b. Touch Specified Time to set the time. 

c. Touch Save. 

5. Touch Poll Now to retrieve and print the faxes. 
 

Note: Touch Close to cancel the operation. 
 
 

Polling a Remote Mailbox 

If remote polling is turned on, you can retrieve documents that are stored in a fax mailbox on another fax 
machine. 
 

Note: If Local Polling is turned on, Remote Polling is not available. To turn off Local Polling, touch 
Local Polling > Off > Save. 

 

To poll a remote mailbox: 

1. Touch the Fax Options tab, then touch Remote Polling. 

2. Touch Poll a Remote Mailbox. 

3. To specify the fax number you want to access, do one of the following: 

 The Fax Number field allows you to use the alphanumeric keypad to enter the number. 

 Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Save. 

 Address Book allows you to select fax numbers from your Fax Address Book. Touch the Up or 
Down arrows to scroll through the list, touch the desired contact, then select Add to Recipients 
from the drop-down menu. Select and add more contacts, or touch Close. 

4. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number. 

5. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit mailbox 
passcode. 

6. Touch Poll Now to retrieve and print the faxes in the mailbox. 
 

Note: Touch Close to cancel the operation. 
 
 

Building a Fax Job 

Use this feature to fax an assorted group of originals, each with different settings. Each segment is 
programmed and scanned, and the images are stored temporarily in the printer. Once all segments have 
been stored, the individual segments are faxed as a single job. 
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Note: You must address the fax before using this feature. 

To build a fax job: 

1. Touch the Job Assembly tab, then touch Build Job > On. 

2. Select or clear the Display this window between segments check box. 

3. Program and scan the first segment: 

a. Load the originals for the first segment. 

b. Select the required settings, such as layout adjustments, image quality, and so on. 

c. Press the green Start button on the control panel. 

4. Program and scan additional segments: 

a. Load the originals for the next segment. 

b. When the Build Job screen appears, touch Program Next Segment. 

c. Using the appropriate tabs, select the required settings. 

d. Press the green Start button to scan the originals for that segment. 

5. Repeat the previous step for each remaining segment. 
 

Note: At any time, you can touch Delete Last Segment or Delete All Segments to modify the job. 
 

6. When all of the segments have been programmed and scanned, touch Submit the Job. The Job 
Progress screen appears, and the individual segments are faxed as a single job. 

7. On the Job Progress screen, touch Job Details to view a summary of the job. 
 

Note: If necessary, touch Delete > Delete Job to cancel the job. 
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Sending a Server Fax 

If a fax server is connected to the network, you can send a document to a fax machine without requiring 
a dedicated telephone line. 

When using the Server Fax, a document is scanned and sent to a fax repository located on the network. 
The fax server then sends the fax over a telephone line to a fax machine. 

The system administrator must enable the Server Fax service and configure a fax repository, or filing 
location, before you can use this feature. For details, see the System Administrator Guide at 
www.xerox.com/office/WC75xxdocs. 

To send a server fax: 

1. Load the original document in the document feeder or on the document glass. 

2. Press the Services Home button, then touch Server Fax. 

3. To address the fax, touch one or more options: 

 The Enter Number and Press Add field allows you to enter a fax number manually. Use the 
alphanumeric keypad to enter the number, then touch Add. 

 Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Add. Add more numbers, 
or touch Close. 

 Fax Directory allows you to select fax numbers from your Fax Directory. Touch the Up or Down 
arrows to scroll through the list, touch the desired contact, then select Add to Recipients from 
the drop-down menu. Select and add more contacts, or touch Close. 

4. Adjust the fax scanning options if necessary: 

a. Touch 2-sided Scanning and select from the drop-down menu: 

 1-Sided 

 2-Sided 

 2-Sided, Rotate Side 2 

b. Touch Original Type and select from the drop-down menu: 

 Photo & Text 

 Photo 

 Text 

c. Touch Resolution and select from the drop-down menu: 

 Standard (200x100 dpi) 

 Fine (200 dpi) 

5. If desired, select more options. For details, see Selecting Server Fax Options on page 145. 

6. Press the green Start button. The printer scans the pages and transmits the document when all 
pages have been scanned. 
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Selecting Server Fax Options 

This section includes: 

 Adjusting Brightness ......................................................................................................................................................... 145

 Automatically Suppressing Background Variation .............................................................................................. 145

 Adjusting the Contrast ..................................................................................................................................................... 145

 Specifying the Orientation of the Original .............................................................................................................. 146

 Specifying the Size of the Original ............................................................................................................................. 146

 Sending a Delayed Fax .................................................................................................................................................... 146

 Building a Fax Job .............................................................................................................................................................. 147
 
 

Adjusting Brightness 

You can lighten or darken the image. 

To adjust the image: 

1. Touch the Image Quality tab, then touch Image Options. 

2. On the Image Options screen, adjust the Lighten/Darken slider up or down as necessary. 

3. Touch Save. 
 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can 
sometimes be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the 
printer to variations in light background colors. 

To change this setting: 

1. Touch the Image Quality tab, then touch Image Enhancement. 

2. Under Background Suppression, touch Auto Suppression. 

3. Touch Save. 
 

Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To increase or reduce the contrast: 

1. Touch the Image Quality tab, then touch Image Enhancement. 

2. On the Image Enhancement screen, adjust the contrast: 

 Manual Contrast allows you to adjust the contrast manually. Under Manual Contrast, move the 
slider up or down to increase or decrease the contrast. The middle position on the slider, Normal, 
does not change the contrast. 

 Auto Contrast allows the printer to set the contrast automatically. 
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3. Touch Save. 
 

Specifying the Orientation of the Original 

To specify the orientation of the original document: 

1. Touch the Layout Adjustment tab, then touch Original Orientation. 

2. On the Original Orientation screen, touch the desired orientation: 

 Upright Images and Sideways Images refer to the direction the originals are loaded in the 
document feeder. 

 Portrait Originals and Landscape Originals refer to the images on the originals. 
 

Note: If you are using the document glass, the orientation of the original is as seen before turning it 
over. 

 

3. Touch Save. 
 

Specifying the Size of the Original 

To scan the correct area of the original, specify the original size: 

1. Touch the Layout Adjustment tab, then touch Original Size. 

2. On the Original Size screen, select one of the following: 

 Auto Detect allows the printer to determine the size of the original. 

 Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the 
scrolling list, touch the desired paper size. 

 Custom Scan Area allows you to specify the height and width of the area to scan. Touch the 
Height-Y and Width-X arrows to specify the area. 

 Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the 
diagram on the screen to determine which original sizes can be mixed in the same job. 

3. Touch Save. 
 

Sending a Delayed Fax 

You can set a time in the future for the printer to send your fax job. The time delay can be from 15 
minutes to 24 hours from the current time. 
 

Note: The printer must be set to the current time before you can use this feature. 
 

To specify the time to send your fax: 

1. Touch the Fax Options tab, then touch Delay Send. 

2. Touch Specified Time and set the time: 

a. Touch the Hour field and use the keypad or touch the arrows to set a number. 

b. Touch the Minute field and use the keypad or touch the arrows to set a number. 

c. If your printer is set to display the 12-hour clock, touch AM or PM. 

3. Touch Save. The fax is sent at the specified time. 
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Building a Fax Job 

Use this feature to fax an assorted group of originals, each with different settings. Each segment is 
programmed and scanned, and the images are stored temporarily in the printer. Once all segments have 
been stored, the individual segments are faxed as a single job. 
 

Note: You must address the fax before using this feature. 

To build a fax job: 

1. Touch the Job Assembly tab, then touch Build Job > On. 

2. Select or clear the Display this window between segments check box. 

3. Program and scan the first segment: 

a. Load the originals for the first segment. 

b. Select the required settings, such as layout adjustments, image quality, and so on. 

c. Press the green Start button on the control panel. 

4. Program and scan additional segments: 

a. Load the originals for the next segment. 

b. When the Build Job screen appears, touch Program Next Segment. 

c. Using the appropriate tabs, select the required settings. 

d. Press the green Start button to scan the originals for that segment. 

5. Repeat the previous step for each remaining segment. 
 

Note: At any time, you can touch Delete Last Segment or Delete All Segments to modify the job. 
 

6. When all of the segments have been programmed and scanned, touch Submit the Job. The Job 
Progress screen appears, and the individual segments are faxed as a single job. 

7. On the Job Progress screen, touch Job Details to view a summary of the job. 
 

Note: If necessary, touch Delete > Delete Job to cancel the job. 
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Sending an Internet Fax 

If an SMTP (email) server is connected to the network, a document can be sent to an email address. This 
feature eliminates the need for a dedicated telephone line and the associated service costs. When 
sending an Internet Fax, the document is scanned and sent to an email address. 
 

Note: The system administrator must enable Internet Fax and configure an SMTP server before you 
can use this feature. For details, see the System Administrator Guide at 
www.xerox.com/office/WC75xxdocs. 

 

To send an Internet fax: 

1. Load the original on the document glass or in the document feeder. 

2. Touch the Services Home button, then touch Internet Fax. 

3. Address the fax: 

a. Touch New Recipient. 

b. Touch the Down arrow, then select To: or Cc: from the menu. 

c. Touch the Enter email address and select Add field, then use the touch screen keyboard to 
type the email address. 

d. Touch Add. 

e. Use the touch screen keyboard to type additional email addresses. 

f. When you are finished, touch Close. 

4. To add a subject line: 

a. Touch Subject, then use the touch screen keyboard to type the desired text. 
 

Note: To modify the default subject that appears, touch Clear Text to clear the field, or use the Left 
and Right arrows to edit the text. 

 

b. Touch Save. 

5. Adjust the Internet fax options if necessary: 

a. Touch Output Color and select from the drop-down menu: 

 Auto Detect 

 Black & White 

 Grayscale 

 Color 

b. Touch 2-sided Scanning and select from the drop-down menu: 

 1-Sided 

 2-Sided 

 2-Sided, Rotate Side 2 

c. Touch Original Type and select from the drop-down menu: 

 Photo & Text 

 Photo 
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 Text 

 Map 

 Newspaper/Magazine 

6. Adjust fax options if necessary. 

7. Press the green Start button. The printer scans the pages and sends the document as an email 
attachment in PDF or TIFF format, when all pages have been scanned. 

 

See also:  

Selecting Internet Fax Options on page 150. 
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Selecting Internet Fax Options 

This section includes: 

 Adjusting Brightness and Sharpness ......................................................................................................................... 150

 Automatically Suppressing Background Variation .............................................................................................. 150

 Adjusting the Contrast ..................................................................................................................................................... 151

 Specifying the Orientation of the Original .............................................................................................................. 151

 Specifying the Size of the Original ............................................................................................................................. 151

 Setting the Resolution...................................................................................................................................................... 151

 Setting the Quality and File Size ................................................................................................................................. 152

 Specifying a File Format ................................................................................................................................................. 152

 Including a Message......................................................................................................................................................... 152

 Specifying a Reply To Address ..................................................................................................................................... 153

 Printing an Acknowledgment Report ......................................................................................................................... 153

 Building a Fax Job .............................................................................................................................................................. 153
 
 

Adjusting Brightness and Sharpness 

You can lighten or darken the image, and adjust the sharpness. 

To adjust the image: 

1. Touch the Advanced Settings tab, then touch Image Options. 

2. On the Image Options screen, adjust the sliders up or down as necessary: 

 Lighten/Darken lightens or darkens the image. 

 Sharpness sharpens or softens the image. 

3. Touch Save. 
 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can 
sometimes be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the 
printer to variations in light background colors. 

To change this setting: 

1. Touch the Advanced Settings tab, then touch Image Enhancement. 

2. Under Background Suppression, touch Auto Suppression. 

3. Touch Save. 
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Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To increase or decrease the contrast: 

1. Touch the Advanced Settings tab, then touch Image Enhancement. 

2. On the Image Enhancement screen, adjust the contrast: 

 Manual Contrast allows you to adjust the contrast manually. Move the slider up or down to 
increase or decrease the contrast. The middle position on the slider, Normal, does not change 
the contrast. 

 Auto Contrast allows the printer to set the contrast automatically. 

3. Touch Save. 
 

Specifying the Orientation of the Original 

To specify the orientation of the original document: 

1. Touch the Layout Adjustment tab, then touch Original Orientation. 

2. On the Original Orientation screen, touch the desired orientation: 

 Upright Images and Sideways Images refer to the direction the originals are loaded in the 
document feeder. 

 Portrait Originals and Landscape Originals refer to the images on the originals. 
 

Note: If you are using the document glass, the orientation of the original is as seen before turning it 
over. 

 

3. Touch Save. 
 

Specifying the Size of the Original 

To scan the correct area of the original, specify the original size: 

1. Press the Services Home button, then touch Copy. 

2. Touch the Layout Adjustment tab, then touch Original Size. 

3. On the Original Size screen, select one of the following: 

 Auto Detect allows the printer to determine the size of the original. 

 Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the 
scrolling list, touch the desired paper size. 

 Custom Scan Area allows you to specify the height and width of the area to scan. Touch the 
Height-Y and Width-X arrows to specify the area. 

 Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the 
diagram on the screen to determine which original sizes can be mixed in the same job. 

4. Touch Save. 
 

Setting the Resolution 

To set the Internet fax resolution: 
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1. Touch the Advanced Settings tab, then touch Resolution. 

2. On the Resolution screen, touch the desired resolution: 

 72 dpi produces acceptable image quality for onscreen viewing. Smallest file size. 

 100 dpi produces good image quality for onscreen viewing. Small file size. 

 150 dpi produces good image quality for onscreen viewing. Small file size. 

 200x100 dpi produces good image quality. Moderate file size. 

 200 dpi produces good image quality. Moderate file size. The default setting. 

 300 dpi produces high image quality. Large file size. 

 400 dpi produces higher image quality. Larger file size. 

 600 dpi produces highest image quality. Largest file size. 

3. Touch Save. 
 
 

Setting the Quality and File Size 

The Quality/File Size option lets you choose from three settings that balance the quality of the image and 
the size of the file. Higher quality images result in larger file sizes, which are not ideal for sharing and 
transmitting over the network. 

To set the Internet fax quality and file size: 

1. Touch the Advanced Settings tab, then touch Quality/File Size. 

2. On the Quality/File Size screen, use the slider to select a setting. The settings range from Normal 
Quality and Small File Size to Highest Quality and Largest File Size. 

3. Touch Save. 
 
 

Specifying a File Format 

To specify the Internet fax file format: 

1. Touch the Internet Fax Options tab, then touch File Format. 

2. On the File Format screen, select one of the following: 

 Multi-Page TIFF produces a multi-page Tagged Image File Format (TIFF). 

 PDF produces a Portable Document Format (PDF). 

 PDF/A produces a Portable Document Format (PDF) with embedded fonts. 

3. Touch Save. 
 
 

Including a Message 

To include a message with your Internet fax: 

1. Touch the Internet Fax Options tab, then touch Message. 

2. Use the touch screen keyboard to type a message. 

3. Touch Save. 
 
 



Faxing 

 

 WorkCentre 7500 Series Multifunction Printer 153 
 User Guide 
 

Specifying a Reply To Address 

To specify a reply to email address: 

1. Touch the Internet Fax Options tab, then touch Reply To. 

2. Use the touch screen keyboard to type an email address. 

3. Touch Save. 
 

Printing an Acknowledgment Report 

If the status of each recipient is known, you can print a delivery status report. The printer waits for a 
delivery receipt from each recipient, then prints the report. 
 

Note: The report could be delayed depending on the response time of the recipients. 
 

To print an acknowledgment report: 

1. Touch the Internet Fax Options tab, then touch Acknowledgment Report. 

2. Touch Print Report. 

3. Touch Save. 
 

Building a Fax Job 

Use this feature to fax an assorted group of originals, each with different settings. Each segment is 
programmed and scanned, and the images are stored temporarily in the printer. Once all segments have 
been stored, the individual segments are faxed as a single job. 
 

Note: You must address the fax before using this feature. 

To build a fax job: 
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1. Touch the Job Assembly tab, then touch Build Job > On. 

2. Select or clear the Display this window between segments check box. 

3. Program and scan the first segment: 

a. Load the originals for the first segment. 

b. Select the required settings, such as layout adjustments, image quality, and so on. 

c. Press the green Start button on the control panel. 

4. Program and scan additional segments: 

a. Load the originals for the next segment. 

b. When the Build Job screen appears, touch Program Next Segment. 

c. Using the appropriate tabs, select the required settings. 

d. Press the green Start button to scan the originals for that segment. 

5. Repeat the previous step for each remaining segment. 
 

Note: At any time, you can touch Delete Last Segment or Delete All Segments to modify the job. 
 

6. When all of the segments have been programmed and scanned, touch Submit the Job. The Job 
Progress screen appears, and the individual segments are faxed as a single job. 

7. On the Job Progress screen, touch Job Details to view a summary of the job. 
 

Note: If necessary, touch Delete > Delete Job to cancel the job. 
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Using the Address Book 

This section includes: 

 Adding an Individual Entry ............................................................................................................................................ 155

 Adding a Group Entry ....................................................................................................................................................... 156

 Editing or Deleting Speed Dial Entries ...................................................................................................................... 157

 Using Chain Dial ................................................................................................................................................................. 157
 
 

Adding an Individual Entry 

A total of 1000 speed dial entries can be stored in the printer. 

To store multiple recipients in one speed dial entry, store the recipients as a group entry. For details, see 
Adding a Group on page 156. 

To add an individual speed dial entry: 

1. Press the Services Home button, then touch Fax. 

2. Touch Address Book. 

3. Touch the Down arrow, then touch Individuals. 

4. Touch an available Speed Dial entry, using the scroll arrows if necessary. 

5. Assign a name to the entry: 

a. Touch the Entry Name field, then use the touch screen keyboard to type the name. 

b. Touch Save. 

6. Assign a fax number to the entry: 

a. Touch the Fax Number field. 

b. Use the alphanumeric keypad to enter the number: 
 

Note: If the fax number requires characters such as a Dial Pause, touch Dialing Characters to enter 
the characters, then touch Save. 

 

7. Set the starting rate: 

a. Under Starting Rate, touch one of the following: 

 Super G3 

 G3 

 Forced 
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b. Touch the corresponding speed at the bottom of the screen. 

c. Select a rate from the drop-down menu, using the Up and Down arrows to scroll if necessary. 

8. To include a cover sheet: 

a. Touch Cover Sheet > On. 

b. Touch the To field, use the touch screen keyboard to type the name of the recipient, then touch 
Save. 

c. Touch the From field, use the touch screen keyboard to type the name of the sender, then touch 
Save. 

d. To add a comment, do one of the following: 

 Touch an existing comment, then touch Save. 

 Touch an <Available> comment, touch Edit, use the touch screen keyboard to type the 
text, then touch Save. 

 

Notes: 

 To delete an existing comment, touch the comment, then touch Clear. Touch Clear to confirm 
the action. 

 To edit an existing comment, touch the comment, then touch Edit. Use the touch screen 
keyboard to change the comment, then touch Save. 

 

9. Touch Save. 
 

Adding a Group Entry 

To send a fax to multiple individuals, create a group speed dial entry. Groups can include both previously 
stored individual and group entries. 
 

Note: Individual entries must be set up before groups can be defined. For details, see Adding an 
Individual Entry on page 155. 

  

To add a group speed dial entry: 

1. Press the Services Home button, then touch Fax. 

2. Touch Address Book. 

3. Touch the Down arrow, then touch Groups. 

4. Touch an available Speed Dial entry, using the scroll arrows if necessary. 

5. Assign a name to the entry: 

a. Touch the Group Name field, then use the touch screen keyboard to type the name. 

b. Touch Save. 

6. Touch Add Recipients. 

7. Touch the Down arrow, then touch Individuals to add individual speed dial entries, or touch Groups 
to add speed dial groups. 

8. Touch the desired speed dial entry, then touch Add to Group. 

9. When all entries have been added, touch Save. 

10. Touch Close. 
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Editing or Deleting Speed Dial Entries 

To modify or delete existing speed dial entries: 

1. Press the Services Home button, then touch Fax. 

2. Touch Address Book. 

3. Touch the Down arrow, then touch Individuals or Groups. 

4. Touch the desired Speed Dial entry, using the scroll arrows if necessary. 

5. Touch one of the following: 

 Edit Details allows you to modify the properties of the speed dial entry. For details, see Adding 
an Individual on page 155 or Adding a Group on page 156. Touch Save. 

 Clear Entry removes the entry from the address book. Touch Clear Entry to confirm the action. 

6. Touch Close. 
 

Using Chain Dial 

Chain dial creates a single fax recipient telephone number by adding two or more numbers together. For 
example, an area code or extension number can be stored separately from the rest of the telephone 
number. Access chain dialing from the Address Book. 

To create a chain dial number: 

1. Press the Services Home button, then touch Fax. 

2. Touch Address Book. 

3. Touch the Down arrow, then touch Individuals. 

4. Touch Chain Dial. 

5. To combine numbers with an existing speed dial entry, use any combination of the following: 

a. Touch the Recipient field, then use the touch screen keypad to enter numbers. 

b. Touch the desired speed dial entry from the list, using the scroll arrows if necessary. Touch Add 
to Recipient. The numbers are added together in the Recipient field. 

6. Touch Save. The combined number appears as a single recipient in the Recipients list. 

7. Touch Close. You can now send the fax. 
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Maintenance and Cleaning 

This section includes: 

 General Precautions .......................................................................................................................................................... 160

 Cleaning the Printer .......................................................................................................................................................... 161

 Routine Maintenance ....................................................................................................................................................... 166
 
 

General Precautions 
 

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol 
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed 
in this documentation. 

  

 WARNING: Keep all cleaning materials out of the reach of children. 
  

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays 
contain explosive mixtures and are not suitable for use in electrical applications. Use of such cleaners 
increase the risk of fire and explosion. 

  

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

 Do not place anything on top of the printer. 

 Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 
exposure can damage the drum cartridges. 

 Do not open covers and doors during printing. 

 Do not tilt the printer while in use. 

 Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 
quality to deteriorate. 

 Make sure any parts removed during cleaning are replaced before you plug in the printer. 
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Cleaning the Printer 

This section includes: 

 Cleaning the Printer Exterior ......................................................................................................................................... 161

 Cleaning the Document Glass and Document Cover ......................................................................................... 161

 Cleaning the Feed Rollers ............................................................................................................................................... 162

 Cleaning the Printhead Lenses ..................................................................................................................................... 162
 
 

Cleaning the Printer Exterior 

Regular cleaning keeps the touch screen and control panel free from dust and dirt. To remove finger 
prints and smudges, clean the touch screen and control panel with a soft, lint-free cloth. 
 

 

Use a lightly dampened cloth to clean the outside of the document feeder, output trays, paper trays, and 
outside areas of your printer. 

 
 

Cleaning the Document Glass and Document Cover 

To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output with 
streaks, smears, and other marks that transfer from the glass while scanning documents. 
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1. Use a lint-free cloth lightly dampened with Xerox® Anti-Static or another suitable non-abrasive glass 
cleaner. Clean the document glass and the Constant Velocity Transport (CVT) glass to its left. 

2. Use a lint-free cloth and Xerox® Cleaning Fluid or Xerox® Film Remover to clean the underside of the 
document cover and the document feeder. 

 

 
 

Cleaning the Feed Rollers 

Dirt on the document feed rollers can cause paper jams or deteriorate print quality. For best performance, 
clean the document feed rollers once a month. 

1. Lift the lever and open the top cover of the document feeder. 

 
2. While turning the rollers, wipe them with a clean, lint free cloth moistened with water. 

 
 

Cleaning the Printhead Lenses 

The printer is constructed with four printhead lenses. Clean all lenses as described in the following 
procedure. 
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 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front cover of the printer. 

 
2. Turn the orange lever to the left. 

 
3. Pull the drum cartridge cover down until it clicks into the open position. 
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4. Each of the four printheads has its own cleaning tool. Slowly pull the printhead lens cleaner out until 
the three dots are visible. 

 

Note: The printhead lens cleaner does not detach from the printer. 

 
5. Slowly push the printhead lens cleaner back into the printhead until it stops. 

 
6. Repeat Steps 4 and 5 for each printhead. 

7. Close the drum cartridge cover. 

 
8. Turn the orange lever to the right to return it to the locked position. 
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9. Close the printer front cover. 
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Routine Maintenance 

This section includes: 

 Replacing the Toner Cartridges ................................................................................................................................... 166

 Replacing the Waste Toner Container ...................................................................................................................... 168

 Replacing the Drum Cartridges .................................................................................................................................... 170

 Replacing the Transfer Belt Cleaner .......................................................................................................................... 173

 Replacing the Second Bias Transfer Roll .................................................................................................................. 175

 Resetting Supply Life Counters .................................................................................................................................... 178

 Emptying the Hole Punch Waste Container ........................................................................................................... 179

 Replacing Staple Cartridges .......................................................................................................................................... 182
 
 

Replacing the Toner Cartridges 

A message appears on the control panel when a toner cartridge must be replaced. 
 

 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front cover of the printer. 

 



Maintenance 

 

 WorkCentre 7500 Series Multifunction Printer 167 
 User Guide 
 

2. Place your fingers under the lip of the toner cartridge, then pull the toner cartridge straight out of the 
printer. 

 

 
3. Remove the new toner cartridge from the packaging. Tilt the cartridge up and down, then left and 

right 10 times. 

 
4. Hold the new toner cartridge with the arrow facing up, then push the cartridge in slowly until it stops. 
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5. Push gently on the toner cartridge to ensure that it is seated. 

 
6. Close the printer front cover. 
 
 

Replacing the Waste Toner Container 

A message appears on the control panel when the waste toner container must be replaced. 

When replacing the waste toner container, clean the printhead lenses. For details, see Cleaning the 
Printhead Lenses on page 162. 
 

 CAUTION: Spread paper on the floor to catch possible toner spills. 
  

 WARNING: If you spill any toner in the printer, wipe it up using a moist cloth. Never use a vacuum 
cleaner to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or explosion. 

 
 

 WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If 
some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on 
your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out 
immediately with cool water then consult a doctor. 

  

 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front cover of the printer. 
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2. Remove the new waste toner container from the packaging. Retain the packaging. 

 
3. Pull the used waste toner container out slowly while supporting it with your other hand. 

 
4. Place the used waste toner container in the plastic bag, then seal it firmly using the zipper. 

 
5. Place the used waste toner container in the empty box. 
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6. Hold the left side of the new waste toner container and slide it into the printer until it clicks. 

 
7. Clean the printhead lenses. For details, see Cleaning the Printhead Lenses on page 162. 

8. Close the front cover. 
 
 

Replacing the Drum Cartridges 

A message appears on the control panel when a drum cartridge must be replaced. 
 

 CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting. 
Do not touch or scratch the surface of the drum. 

  

 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front cover of the printer. 
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2. Grip the orange handle of the drum cartridge as shown and pull the drum cartridge straight out of 
the printer. Place the used drum cartridge in the plastic bag and place in the box. 

 

 WARNING: Do not touch any toner adhering to the drum cartridge. 
  

Note: To return used supplies for recycling, follow the instructions included with the new supplies. If 
the instructions or shipping label are not available, go to www.xerox.com/gwa for additional 
information. 

 

 
3. Remove the packing material from the end of the new drum cartridge. 

4. Rest the new cartridge, along with its black plastic protective shield, in the cartridge slot. Make sure 
to load the cartridge in the direction of the arrow on the top of the shield. 

 
5. While keeping the guides inserted in the slot, remove the black paper sheet by pulling it in the 

direction shown. 

6. Remove the tape from the top of the cartridge shield. 

7. Hold the shield and push the cartridge into the printer using the orange handle. 
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8. Continue pushing the orange handle until it stops. 

 
9. Carefully remove the protective shield. 

10. Push the drum cartridge until it stops. 

 
11. Close the drum cartridge cover. 

 
12. Turn the orange lever to the right to return it to the locked position. 

 
13. Close the printer front cover. 

14. Dispose of the protective shield and tape as normal office waste. 
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Replacing the Transfer Belt Cleaner 

A message appears on the control panel when the transfer belt cleaner must be replaced. 
 

 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front cover of the printer. 

 
2. Turn the orange lever to the right to unlock the belt cleaner. 

 
3. Turn the orange knob counterclockwise until it releases. 
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4. Pull the transfer belt cleaner straight out of the printer. 
 

 WARNING: Do not touch any toner adhering to the transfer belt cleaner. Do not tilt the transfer belt 
cleaner or toner could spill. 

 
5. Remove the new transfer belt cleaner from the packaging. Retain the packaging. 

6. Place the used transfer belt cleaner in the plastic bag. 

 
7. Remove the protective cover from the new transfer belt cleaner. 
 

 CAUTION: Do not touch the surface of the transfer belt cleaner. Doing so could deteriorate image 
quality. 
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8. Support the new transfer belt cleaner with your left hand and slide it straight into the opening until it 
stops. 

 
9. Push the orange knob in, then turn it clockwise until snug. 

 
10. Turn the orange lever to the left to lock the belt cleaner. 

 
11. Close the printer front cover. 
 
 

Replacing the Second Bias Transfer Roll 

A message appears on the control panel when the second bias transfer roll must be replaced. 

1. Remove paper from the left tray, then fold up the tray. 
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2. Open tray 5 (bypass) as shown (1). 

3. While lifting up the release lever (2), open the top left cover A as shown (3). 

3

1

2

 
 

 WARNING: The area around the fuser can be hot. Use caution to avoid injury. 
  

 CAUTION: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the 
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality. 

 

 
4. Remove the new second bias transfer roll from the packaging. Retain the packaging. 

5. Push the orange lever in the direction shown. 
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6. Lift the used second bias transfer roll out of the printer. 
 

Note: Do not touch any toner adhering to the second bias transfer roll. 

 
7. Place the used second bias transfer roll in the plastic bag. 

1 2 3

 
8. Place the new second bias transfer roll in the printer as shown. Press down until the transfer roller 

clicks into place. 

3

1
2

 
9. Remove the protective cover from the second bias transfer roll. 
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10. Close top left cover A. 
 
 

Resetting Supply Life Counters 

You must reset the supply life counters when you replace some supplies. 
 

Note: To access this feature at the control panel, log in as an administrator. 
 

1. Press the Log In/Out button, enter the system administrator login information, and then press Enter. 
For details, see the System Administrator Guide. 

2. On the control panel, press Machine Status. 

3. Touch the Tools tab, then touch Device Settings. 

4. Touch General > Supply Counter Reset. Touch the scroll arrows if necessary. 

5. Touch the desired supply item, then touch Reset Counter. 

6. In the confirmation screen, touch Reset. 

7. Touch Close. 

8. Press the Log In/Out button, then touch Logout. 
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Emptying the Hole Punch Waste Container 

This section includes: 

 Emptying the Hole Punch Waste Container in the Office Finisher LX ......................................................... 179

 Emptying the Hole Punch Waste Container in the Professional Finisher .................................................. 180

A message appears on the control panel when the hole punch waste container is full. 

 
 

Emptying the Hole Punch Waste Container in the Office Finisher LX 
 

 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Lift the finisher transport top cover, then open the front transport cover. 

 
2. Pull out the hole punch waste container. 
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3. Empty the container. 

 
4. Insert the container and slide it all the way into the finisher. 

 
5. Close the finisher front transport cover, then close the top cover. 
 

Emptying the Hole Punch Waste Container in the Professional Finisher 
 

 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Open the front door of the finisher. 
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2. Pull out the waste container at R4. 

 
3. Empty the container. 

 
4. Insert the container all the way into the finisher. 

 
5. Close the finisher front door. 
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Replacing Staple Cartridges 

This section includes: 

 Replacing Staples in the Integrated Finisher ......................................................................................................... 182

 Replacing Staples in the Main Stapler of the Office Finisher LX ................................................................... 183

 Replacing Staples in the Booklet Maker of the Office Finisher LX ................................................................ 185

 Replacing Staples in the Main Stapler of the Professional Finisher ............................................................. 186

 Replacing Staples in the Booklet Maker of the Professional Finisher .......................................................... 188

A message appears on the control panel when a staple cartridge is empty. 

 
 

Replacing Staples in the Integrated Finisher 
 

 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Open the finisher door as shown. 

 
2. Grip the staple cartridge by the orange handle and remove the cartridge by pulling it firmly toward 

you. 
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3. Remove any loose staples or other debris from inside the finisher. 

4. Pinch both sides of the staple case (1) and remove the staple case from the cartridge (2). 

1

1

2

 
5. Insert the front side of the new staple case into the staple cartridge (1), then push the rear side into 

the cartridge (2). 

1

2

 
6. Grip the staple cartridge by the orange handle and insert the cartridge into the stapler until it clicks. 

 
7. Close the finisher front cover. 
 
 

Replacing Staples in the Main Stapler of the Office Finisher LX 
 

 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Open the finisher door as shown. 
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2. Reach into the finisher cabinet and pull the stapler toward you until it stops. 

3. Push the stapler to the right as shown. 

 
4. Grip the staple cartridge by the orange handle and remove the cartridge by pulling it firmly toward 

you. 

 
5. Remove any loose staples or other debris from inside the finisher. 

6. Pinch both sides of the staple case (1) and remove the staple case from the cartridge (2). 

1

1

2

 
7. Insert the front side of the new staple case into the staple cartridge (1), then push the rear side into 

the cartridge (2). 

1

2
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8. Grip the staple cartridge by the orange handle and insert it into the stapler until it clicks to lock in 
place. 

 
9. Close the finisher front door. 
 
 

Replacing Staples in the Booklet Maker of the Office Finisher LX 
 

 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Open the finisher side cover. 

 
2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening and 

slide them to the center. 

 



Maintenance 

 

186 WorkCentre 7500 Series Multifunction Printer 
 User Guide 
 

3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher. 

 
4. Hold the tabs on both sides of the new staple cartridge and insert it into the original position in the 

finisher. 
 

Note: If you have trouble inserting the cartridge, make sure the staples are positioned correctly in the 
cartridge. 

 
 

Note: The Booklet Maker uses two staple cartridges. Booklet stapling requires that both staple 
cartridges contain staples. 

 

5. Starting at Step 2, repeat the procedure for the other staple cartridge. 

6. Close the side cover of the finisher. 
 
 

Replacing Staples in the Main Stapler of the Professional Finisher 

1. Open the front door of the finisher. 
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2. Hold the staple cartridge unit by orange lever R1 and push it to the right. 

 
3. Grip the staple cartridge by the orange tabs and remove the cartridge by pulling it firmly toward you. 

Check inside the finisher for any loose staples and remove them. 

 
4. Pinch both sides of the staple case (1) and remove the staple case from the cartridge (2). 

1

1

2

 
5. Insert the front side of the new staple case into the staple cartridge (1), then push the rear side into 

the cartridge (2). 

1

2
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6. Grip the staple cartridge by the orange tabs and insert it into the staple cartridge unit until it clicks. 

 
7. Close the finisher front door. 
 
 

Replacing Staples in the Booklet Maker of the Professional Finisher 

1. Open the front door of the finisher. 

 
2. While squeezing orange levers R2 and R3 together (1), pull the staple cartridge unit out of the 

finisher until it stops (2). 
 

Note: The staple cartridge unit does not detach from the finisher. 

1 2
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3. Grip the orange tabs on both sides of the staple cartridge. 

 
4. While gripping the orange tabs of the staple cartridge, rotate it in the direction shown. 

 
5. Lift the staple cartridge out of the staple cartridge unit. 

 
6. Push the staple cartridge into the staple cartridge unit. 
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7. If you find no jammed staples, repeat the preceding steps for the other staple cartridge. 

8. Return the staple cartridge unit to its original position. 

 
9. Close the finisher front door. 
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Billing and Usage Information 

Billing and printer usage information appears on the Billing Information screen. 

1. At the printer control panel, press the Machine Status button. 

2. Touch the Billing Information tab to see basic impression counts. 

3. Touch Usage Counters, then touch the Impression Counters drop-down list to see detailed usage 
information. 

4. Touch Close. 
 

 



Maintenance 

 

192 WorkCentre 7500 Series Multifunction Printer 
 User Guide 
 

Ordering Supplies 

This section includes: 

 Locating the Serial Number ........................................................................................................................................... 192

 Consumables ........................................................................................................................................................................ 192

 Routine Maintenance Items ......................................................................................................................................... 192

 When to Order Supplies ................................................................................................................................................... 193

 Recycling Supplies .............................................................................................................................................................. 193
 
 

Locating the Serial Number 

You need the printer serial number to order supplies or to contact Xerox® for assistance. The serial 
number is located on the left side of the printer frame under cover A. The serial number also appears on 
the control panel. Press the Machine Status button to view the serial number on the control panel. 
 

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. Consumable 
supplies for this printer are the Genuine Xerox® Toner Cartridges (Cyan, Magenta, Yellow, and Black). 
 

Note: Each toner cartridge includes installation instructions. 
  

 CAUTION: Use of toner other than Genuine Xerox® Toner can affect print quality and printer 
reliability. It is the only toner designed and manufactured under strict quality controls by Xerox for 
specific use with this printer. 

 
 

Routine Maintenance Items 

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. 
 

Note: Each routine maintenance item includes installation instructions. 
 

Routine maintenance items for this printer include the following: 

 Drum Cartridge 

 Waste Toner Container 

 Second Bias Transfer Roll 

 Transfer Belt Cleaner 

 Staple Cartridge 
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 Booklet Staple Cartridge 
 

When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must be 
replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/WC75xxsupplies. 
 

 CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of 
performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this 
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage 
could vary outside these areas. Please contact your Xerox representative for details. 

 
 

Recycling Supplies 

For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa. 

Supplies include a prepaid return label. Please use it to return used components in their original boxes for 
recycling. 
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This chapter includes: 

 General Troubleshooting ................................................................................................................................................ 196

 Jams ......................................................................................................................................................................................... 201

 Print-Quality Problems ..................................................................................................................................................... 238

 Copy and Scan Problems ................................................................................................................................................ 244

 Fax Problems ........................................................................................................................................................................ 245

 Getting Help ......................................................................................................................................................................... 247
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General Troubleshooting 

This section includes: 

 Printer has Two Power Switches .................................................................................................................................. 196

 Restarting the Printer ....................................................................................................................................................... 197

 Printer Does Not Turn On ............................................................................................................................................... 197

 Printer Resets or Turns Off Frequently ...................................................................................................................... 197

 Printing Takes Too Long.................................................................................................................................................. 198

 Document Prints From Wrong Tray ........................................................................................................................... 198

 Document Fails to Print ................................................................................................................................................... 198

 Printer is Making Unusual Noises ................................................................................................................................ 199

 Automatic 2-Sided Printing Problems ....................................................................................................................... 199

 Date and Time are Incorrect ......................................................................................................................................... 199

 Scanner Errors ...................................................................................................................................................................... 200

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 

 
 

Printer has Two Power Switches 

This printer has two power switches. The switch located on the top of the printer, beneath the control 
panel, controls power only to the electronic components of the printer. The second switch, located behind 
the front cover, controls the power into the printer. Turn on both switches to operate the printer. First turn 
on the power switch behind the front cover, then turn on the top switch. 

 
 



Troubleshooting 

 

 WorkCentre 7500 Series Multifunction Printer 197 
 User Guide 
 

Restarting the Printer 
1. Locate the two power switches. 

2. Turn off the switch on the top of the printer. A message appears on the control panel that warns that 
the printer is turning off. 

3. If the printer turns off, then turn on the switch to restart the printer. 

4. If the printer does not turn off after two minutes, then open the front cover and turn off the second 
switch. 

5. Turn on the bottom switch, then turn on the top switch to restart the printer. 

If the problem is not resolved by restarting the printer, see the table in this chapter that best describes the 
problem. 
 

Printer Does Not Turn On 
 

Probable Causes Solutions 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer, and plug the power cord securely into the outlet.

Something is wrong with the outlet connected 
to the printer. 

 Plug another electrical appliance into the outlet and see if it 
operates properly. 

 Try a different outlet. 

One of the power switches is not turned on. Turn off both of the power switches. Wait two minutes then turn on 
both of the switches. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in Electrical 
Specifications on page 258. 

 

 CAUTION: Plug the three-wire cord (with grounding prong) directly into a grounded AC outlet only. 
Do not use a power strip. If necessary, contact a licensed electrician to install a properly grounded 
outlet. 

 
 

Printer Resets or Turns Off Frequently 
 

Probable Causes Solutions 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer, confirm that the power cord is correctly plugged 
into the printer and the outlet, then turn on the printer. 

A system error occurred. Contact your Xerox® service representative with the error message. 
Check the control panel fault history. For details, see Viewing Faults 
and Error Messages on the Control Panel on page 248.  
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Printing Takes Too Long 
 

Probable Causes Solutions 

The printer is set to a slower printing mode, 
for example, for printing on heavyweight 
paper or transparencies. 

It takes more time to print on certain types of special media. Make 
sure that the paper type is set properly in the driver and at the 
printer control panel. 

The printer is in Energy Saver mode. Wait. It takes time for printing to start when the printer is coming 
out of Energy Saver mode. 

The way the printer was installed on the 
network could be an issue. 

Determine if a print spooler or a computer sharing the printer is 
buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. To test the speed of the printer, print 
some Information pages such as the Office Demo Page. If the page 
prints at the rated speed of the printer, you could have a network or 
printer installation issue. 

The job is complex. Wait. No action needed. 
  
 

Document Prints From Wrong Tray 
 

Probable Causes Solutions 

Application and print driver have conflicting 
tray selections. 

1. Check the tray selected in the print driver. 
2. Go to the page setup or printer settings of the application from 

which you are printing. 
3. Set the paper source to match the tray selected in the print driver 

or set the paper source to Automatically Select. 
 

Note: Set the paper source tray selection to Automatic to have the 
print driver select the tray. 

 

  
 

Document Fails to Print 
 

Probable Causes Solutions 

Selected tray has wrong paper size installed. To view the Job Status for a failed print on the touch screen: 
1. Press the Job Status button, then touch the Active Jobs tab. 
2. Find the failed print job in the list. 
3. Note the status of the failed print job, such as Held: Resources 

Required. 
4. Touch to select the print job for more details, then touch Job 

Details. 
5. Note the Tray number listed under Resources and the Status of 

the selected tray. 
6. Load the proper size paper in the tray or select another tray. 

Application and print driver have conflicting 
tray selections. 

See Document Prints from Wrong Tray on page 198. 
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Printer is Making Unusual Noises 
 

Probable Causes Solutions 

One of the trays is not installed correctly. Open and close the tray from which you are printing. 

There is an obstruction or debris inside the 
printer. 

Turn off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox® service representative. 

  
 

Automatic 2-Sided Printing Problems 
 

Probable Causes Solutions 

Unsupported or incorrect media. Make sure that you are using the correct paper. For details, see 
Supported Paper on page 38. Envelopes, labels, transparencies, 
reloaded paper, and paper heavier than 220 g/m2 cannot be used 
for 2-sided printing.  

Incorrect setting. In the print driver Properties,select 2-Sided Print on the 
Paper/Output tab. 

  
 

Date and Time are Incorrect 

The date and time are set automatically when the printer is connected to a network that has a Network 
Time Protocol (NTP) server. NTP is used to synchronize the internal clocks of computers over a network 
connection at system startup and every subsequent 24-hour period thereafter. This feature ensures that 
the internal clock of the printer stays synchronized with the NTP server you specify. 
 

Note: To access this feature at the control panel, log in as an administrator. 
  

Probable Causes Solutions 

The time zone, date, or time is set incorrectly. 1. At the printer control panel, press the Machine Status 
button, then touch the Tools tab. 

2. Touch Device Settings > General > Date & Time. 
3. To set the time zone, touch Time Zone and touch the 

arrows to adjust the time zone. 
4. To set the date, touch Date, select a format and set 

the date. 
5. To set the time, touch Time and set the time. Select 

Display 24 hour clock to use 24 hour format. 
6. Touch Save. 
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Scanner Errors 
 

Probable Causes Solutions 

Scanner is not communicating. Turn off the printer, and check the scanner cable. Wait two minutes 
and turn the printer on again. 
If the problem is not resolved, contact your Xerox® service 
representative. 
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Jams 

This section includes: 

 Clearing Paper Jams ......................................................................................................................................................... 202

 Minimizing Paper Jams .................................................................................................................................................... 223

 Troubleshooting Paper Jams ......................................................................................................................................... 225

 Clearing Staple Jams ........................................................................................................................................................ 228

 Clearing Hole Punch Jams .............................................................................................................................................. 237
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Clearing Paper Jams 

This section includes: 

 Clearing Jams at Tray 1, Tray 2, Tray 3, or Tray 4 ............................................................................................... 202

 Clearing Jams at Tray 5 (Bypass Tray) ..................................................................................................................... 203

 Clearing Jams in Top Left Cover A .............................................................................................................................. 204

 Clearing Jams in Duplex Unit B .................................................................................................................................... 207

 Clearing Jams at Bottom Left Cover C ...................................................................................................................... 207

 Clearing Jams in Top Left Cover D ............................................................................................................................. 208

 Clearing Jams in the Document Feeder ................................................................................................................... 210

 Clearing Jams in the Integrated Finisher ................................................................................................................ 212

 Clearing Jams in the Office Finisher LX .................................................................................................................... 213

 Clearing Jams in the Professional Finisher .............................................................................................................. 214

To avoid damage, always remove jammed paper carefully, without tearing it. Try to remove the paper in 
the direction that it would normally feed. Any piece of paper left in the printer, whether large or small, can 
obstruct the paper path and cause further jams. Do not reload paper that has jammed. 
 

Note: Do not touch the printed side of the paper when removing it. The printed side of jammed 
pages could smudge, and the toner could stick to your hands. Avoid spilling any toner inside the 
printer. 

  

 WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If 
some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on 
your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out 
immediately with cool water then consult a doctor. 

 

 
 

Clearing Jams at Tray 1, Tray 2, Tray 3, or Tray 4 

1. Before removing the tray from the printer, look at the jam message on the control panel. If another 
jam is shown, clear that jam inside the printer first. 

2. Pull the tray out toward you until it stops. 
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3. Remove the paper from the tray. 

4. If the paper is torn, remove the tray completely and check inside the printer for torn pieces of paper. 

 
5. Reload the tray with undamaged paper, then push the tray in until it stops. Paper Settings - Tray X 

appears on the control panel. 

6. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 

7. On the printer touch screen, touch Confirm. 

 

 
 

Clearing Jams at Tray 5 (Bypass Tray) 

1. Remove the jammed paper from the tray. Make sure the paper feed entrance where the tray 
connects to the printer is clear. 
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2. If the paper is torn, check inside the printer for torn pieces of paper. 

3. Fan the paper you removed and make sure that all four corners are neatly aligned. 

4. Insert the paper into tray 5 with the printing side face down. The leading edge of the paper should 
lightly touch the paper feed entrance. 

 
Paper Settings - Tray 5 (Bypass) appears on the control panel. 

5. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 

6. On the printer touch screen, touch Confirm. 

 

 
 

Clearing Jams in Top Left Cover A 

1. Remove paper from the left tray, then fold up the tray. 
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2. Open tray 5 (bypass) as shown (1). 

3. While lifting up the release lever (2), open the top left cover A as shown (3). 

3

1

2

 
 

 WARNING: The area around the fuser can be hot. Use caution to avoid injury. 
  

 CAUTION: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the 
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality. 

 

 
4. If paper is jammed at the exit to the output tray, remove the paper by carefully pulling it straight out 

in the direction shown. 
 

Note: Toner can adhere to the transfer roller. This does not affect print quality. 
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5. If paper is jammed in the fuser, pull green lever A1 to open the fuser exit gate. 

 
6. Remove the paper as shown. 

 
 

Note: If the paper is torn, remove all torn pieces from the printer. 
 

7. If the paper is jammed at the bottom entry of the fuser, remove it as shown. 

 
8. Return the green lever A1 to its normal position. 

9. Close cover A, then close tray 5. 
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Clearing Jams in Duplex Unit B 

1. Open tray 5 (bypass tray) as shown (1). 

1

2

3

 
2. While lifting the release lever (2), open the top left cover B as shown (3). 

3. Remove the jammed paper as shown. 
 

Note: If the paper is torn, remove all torn pieces from the printer. 
 

 
4. Close the duplex unit cover B, then close tray 5 (bypass tray). 
 

Clearing Jams at Bottom Left Cover C 

1. Pull the release lever and open the left bottom cover C as shown. 
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2. Remove the jammed paper as shown. 
 

Note: If the paper is torn, remove all torn pieces from the printer. 
 

 
3. For paper jammed in the upper position, look inside the printer to remove it. 
 

Note: If the paper is inaccessible, see Clearing Jams in Top Left Cover A on page 204. 
 

4. For paper jammed in the tray feed roller, open the tray and remove the paper. 

 
5. Close the left bottom cover C. 
 

Clearing Jams in Top Left Cover D 

1. Remove paper from the left tray, then fold up the tray. 
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2. Open tray 5 (bypass) as shown (1). 

3. While lifting up the release lever (2), open the top left cover A as shown (3). 

3

1

2

 
 

 WARNING: The area around the fuser can be hot. Use caution to avoid injury. 
  

 CAUTION: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the 
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality. 

 

 
4. Open the left tray as shown. 

5. Lift the lever up to open top left cover D. 
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6. Remove the jammed paper as shown. 
 

Note: If the paper is torn, remove all torn pieces from the printer. 
 

 
7. Close the top left cover D. 

8. Close the top left cover A, then close tray 5 (bypass tray). 
 

Clearing Jams in the Document Feeder 

1. Lift the lever and open the top cover of the document feeder as shown. 

 
2. If the original is not caught in the entry to the document feeder, pull it straight out in the direction 

shown. 
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3. If the message on the control panel instructs you to turn the green wheel, turn it in the direction 
shown. Turning the green wheel moves the original out of the feeder. 

 
4. If the message instructs you to open the inner cover, lift the lever with the green tab to open the 

inner cover. 

5. Turn the green wheel in the direction shown to move the original out of the feeder. Carefully remove 
the jammed original. 

 
6. Close the inner cover, then close the top cover, pressing it down until it clicks into place. 

7. If the original is not visible when the top cover is opened, lift the document cover and remove the 
original. 
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8. If the original is not visible when the document cover is opened, lift up the document feeder tray, 
then remove the paper. 

 
9. Lower the document feeder tray. 

10. If the original is not wrinkled or torn, load it into the feeder again following the instructions on the 
touch screen. 

 

Note: After clearing a document feeder jam, reload the entire document, including the pages already 
scanned. The printer automatically skips the scanned pages and scans the remaining pages. 

 

 CAUTION: Torn, wrinkled, or folded originals can cause jams and damage the printer. To copy torn, 
wrinkled, or folded originals, use the document glass. 

 
 

Clearing Jams in the Integrated Finisher 

1. Locate the Integrated Finisher mounted beneath the Scanner and Control Panel. 

2. Open the top cover of the finisher (1). 

3. Turn the green knob in the direction shown to remove the paper (2). 

4. Remove the paper by pulling it in the direction shown. 
 

Note: If the paper is torn, remove all torn pieces from the printer. 
 

2

1

 
5. Close the top cover of the Integrated Finisher. 
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Clearing Jams in the Office Finisher LX 

Clearing Jams Under the Finisher Top Cover 
1. Pull up the lever on the top cover. 

 
2. Open the top cover by rotating it to the left. 

 
3. Remove the jammed paper. 
 

Note: If the paper is torn, remove all torn pieces from the finisher. 
 

 
4. Close the top cover of the finisher. 
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Clearing Jams in the Finisher Transport 
1. Locate the handle on the right front of the center tray. 

 
2. Lift the handle of the center tray straight up to open the transport cover. 

 
3. Remove the jammed paper. 
 

Note: If the paper is torn, remove all torn pieces from the finisher. 
 

4. Close the transport cover. 
 

Clearing Jams in the Professional Finisher 

Clearing Jams in the Center Tray 

1. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown. 
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2. Open, then close, the finisher transport cover. 

 
 

Clearing Jams in the Finisher Transport 
1. Open the finisher transport cover. 

 
2. Remove the jammed paper. 
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Note: If the paper is torn, remove all torn pieces from the finisher. 
 

3. If no paper is visible, turn green knob 1 in the direction shown and carefully pull out the jammed 
paper. 

 
4. Close the finisher transport cover. 
 

Clearing Jams at 2a in the Finisher 

1. If the paper is visible at the output tray exit, remove the paper by pulling it in the direction shown. 

 
2. Open the front door of the finisher. 
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3. Move green lever 2a to the right. 

 
4. Remove the jammed paper. 

 
5. If the paper is inaccessible or if the control panel displays a message to do so, turn knob 2c in the 

direction shown to release the paper. 

 
6. Carefully remove the paper. 
 

Note: If the paper is torn, remove all torn pieces from the finisher. 
 

 
7. Return lever 2a to its original position. 

8. Close the front door of the finisher. 
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Clearing Jams at 2b in the Finisher 
1. Open the front door of the finisher. 

 
2. Move green lever 2b to the right. 

 
3. Remove the jammed paper. 

4. If the paper is inaccessible or if the control panel displays a message to do so, turn knob 2c in the 
direction shown to release the paper. 

 
5. Carefully remove the paper. 
 

Note: If the paper is torn, remove all torn pieces from the finisher. 
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6. Return lever 2b to its original position. 

7. Close the front door of the finisher. 
 

Clearing Jams at 3 in the Finisher 

1. Open the front door of the finisher. 

 
2. Pull down green lever 3. 

 
3. Carefully remove the jammed paper. 
 

Note: If the paper is torn, remove all torn pieces from the finisher. 
 

 
4. Return lever 3 to its original position. 

5. Close the front door of the finisher. 
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Clearing Jams at 4a in the Finisher 
1. Open the front door of the finisher. 

 
2. Using the green handle, pull out unit 4 until it stops. 

 
3. Turn green knob 4a in the direction shown to release the jammed paper. 

 
4. Carefully remove the paper as shown. 
 

Note: If the paper is torn, remove all torn pieces from the finisher. 
 

5. Return unit 4 to its original position. 

6. Close the front door of the finisher. 
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Clearing Jams at 4b in the Finisher 
1. Open the front door of the finisher. 

 
2. Move green lever 4b to the left. 

 
3. If paper is visible, remove the jammed paper by pulling in the direction shown. 

 
4. Using the green handle, pull out unit 4 until it stops. 
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5. Turn green knob 4a in the direction shown to release the jammed paper. 

6. Carefully remove the paper from the upper left side and from inside the unit. 
 

Note: If the paper is torn, remove all torn pieces from the finisher. 
 

 
7. Return unit 4 to its original position. 

8. Return lever 4b to its original position. 

9. Close the front door of the finisher. 
 

Clearing Jams at 5 in the Finisher 

1. Open finisher exit door 5 by lifting up at green label 5. 

 
2. Remove the paper by pulling it in the direction shown. 
 

Note: If the paper is torn, remove all torn pieces from the finisher. 
 

 
3. Return exit cover 5 to its original position. 
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Clearing Jams in the Booklet Tray 
1. Open the front door of the finisher. 

 
2. Turn green knob 4a in the direction shown to release the jammed paper. 

 
3. Remove the jammed paper by pulling in the direction shown. 
 

Note: If the paper is torn, remove all torn pieces from the finisher. 
 

 
4. Close the front door of the finisher. 
 

Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox® supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path or have the printer repaired. 

The following can cause paper jams: 

 Selecting the incorrect paper type in the print driver. 

 Using damaged paper. 

 Using unsupported paper. 
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 Loading paper incorrectly. 

 Overfilling the tray. 

 Adjusting the paper guides improperly. 

Most jams can be prevented by following a simple set of rules: 

 Use only supported paper. For details, see Supported Paper on page 38. 

 Follow proper paper handling and loading techniques. 

 Always use clean, undamaged paper. 

 Avoid paper that is curled, torn, moist, creased, or folded. 

 Fan the paper to separate the sheets before loading it into the tray. 

 Remove transparencies from the output tray immediately after printing. 

 Observe the paper tray fill line; never overfill the tray. 

 Adjust the paper guides in all trays after inserting the media. A guide that is not properly adjusted 
can cause poor print quality, misfeeds, skewed prints, and printer damage. 

 After loading the trays, select the correct paper type and size on the control panel. 

 When printing, select the correct type and size in the print driver. 

 Store paper in a dry location. 

 Use only Xerox® paper and transparencies designed for the printer. 

Avoid the following: 

 Paper that is specially designed for ink-jet printers with polyester coating. 

 Paper that is folded, wrinkled, or excessively curled. 

 Fanning transparencies before loading in the tray. 

 Loading more than one type, size, or weight of paper in a tray at the same time. 

 Loading punched paper or paper with folded corners or staples in the document feeder. 

 Overfilling the trays. 

 Allowing the output tray to overfill. 

 Allowing the output tray to fill with more than a few transparencies. 

Refer to the control panel Paper and Media Information Pages for information on supported paper, or go 
to www.xerox.com/paper. 
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Troubleshooting Paper Jams 

This section includes: 

 Multiple Sheets Pulled Together .................................................................................................................................. 225

 Paper Misfeeds .................................................................................................................................................................... 225

 Jams in the Document Feeder ...................................................................................................................................... 226

 Paper Jam Message Stays On ....................................................................................................................................... 226

 Duplex Unit Jams ...............................................................................................................................................................226
 
 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry paper. 

Too much static electricity is present.  Try a new ream of paper. 
 Do not fan transparencies before loading in tray. 

Using unsupported paper. Use only Xerox®-approved paper. For details, see Supported Paper 
on page 38. 

Humidity is too high for coated paper. Feed paper one sheet at a time. 
  
 

Paper Misfeeds 
 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

 Remove the misfed paper and reposition it properly in the tray. 
 Ensure that the paper guides in the tray are set correctly. 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The paper guides are not correctly adjusted to 
the media size. 

Adjust the paper guides in the tray to match the size of the media. 

Warped or wrinkled paper is loaded in the 
tray. 

Remove the paper, smooth it out, and reload it. If it still misfeeds, do 
not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Unsupported paper of the wrong size, 
thickness, or type. 

Use only Xerox®-approved paper. For details, see Supported Paper 
on page 38. 
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The label sheet is facing the wrong way in the 
tray. 

 Load label sheets according to the instructions from the 
manufacturer. 

 Load labels face down in tray 5 (bypass tray). 
 Load labels face up in tray 1, tray 2, tray 3, and tray 4. 

Envelopes are loaded incorrectly in tray 5 
(bypass tray). 

Load the envelopes in tray 5 (bypass tray) with the flaps closed, 
flap-side up, and the flaps leading into the printer. 

Envelopes are loaded incorrectly in the 
envelope tray.  

Load the envelopes in the envelope tray with the flaps closed, 
flap-side down, and the flaps toward the left side of the tray. 

  
 

Jams in the Document Feeder 
 

Probable Causes Solutions 

Unsupported paper of the wrong size, 
thickness, or type. 

Use only Xerox®-approved paper. For details, see Supported Paper 
on page 38. 

The documents loaded in the document 
feeder exceed the maximum capacity 
allowed. 

Place fewer documents in the document feeder. 

The document feeder guides are improperly 
adjusted. 

Adjust the paper guides to fit snugly against the media loaded in 
the document feeder. 

  
 

Paper Jam Message Stays On 
 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and make sure that you have removed all of 
the jammed paper. 

One of the printer doors is open. Check the doors on the printer. Close any door that is open. 
  
 

Duplex Unit Jams 
 

Probable Causes Solutions 

Unsupported paper of the wrong size, 
thickness, or type. 

 Use only Xerox®-approved paper. For details, see Supported 
Paper on page 38. 

 Do not use transparencies, envelopes, labels, reloaded paper, or 
paper heavier than 220 g/m2 for automatic 2-sided printing. 
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Paper type is set incorrectly in the print driver. The following types of paper can be used for automatic 2-sided 
printing: 
 Plain paper 
 Recycled paper 
 Bond 
 Letterhead 
 Heavyweight 
 Extra-heavyweight 
 Preprinted 
 Gloss 
 Heavyweight gloss 
 Extra heavyweight gloss 
Make sure that the paper type is set correctly in the driver and the 
paper is loaded in the correct tray. For details, see Supported Paper 
on page 38. 

Paper is loaded in the wrong tray. The paper must be loaded in the correct tray. For details, see 
Supported Paper on page 38. 

Tray is loaded with mixed paper. Load the tray with only one type and size of paper. 
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Clearing Staple Jams 

This section includes: 

 Clearing Staple Jams in the Integrated Finisher .................................................................................................. 228

 Clearing Staple Jams in Office Finisher LX .............................................................................................................. 230

 Clearing Booklet Staple Jams in the Office Finisher LX ..................................................................................... 231

 Clearing Main Staple Jams in the Professional Finisher .................................................................................... 233

 Clearing Booklet Staple Jams in the Professional Finisher...............................................................................235
 
 

Clearing Staple Jams in the Integrated Finisher 
 

 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Open the finisher door as shown. 

 
2. Grip the staple cartridge by the orange handle and remove the cartridge by pulling it firmly toward 

you. 
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3. Remove any loose staples or other debris from inside the finisher. 

4. Open the staple cartridge clamp by pulling firmly in the direction shown. 

 
5. Remove the jammed staples (1), then push the clamp in the direction shown until it snaps into the 

locked position (2). 
 

 WARNING: The points of the jammed staples are sharp. Remove the jammed staples carefully. 
 

1

2

 
6. Grip the staple cartridge by the orange handle and insert the cartridge into the stapler until it clicks. 

 
7. Close the finisher front cover. 
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Clearing Staple Jams in Office Finisher LX 
 

 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Open the finisher door as shown. 

 
2. Reach into the finisher cabinet and pull the stapler toward you until it stops. 

3. Push the stapler to the right as shown. 

 
4. Grip the staple cartridge by the orange handle and remove the cartridge by pulling it firmly toward 

you. 
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5. Remove any loose staples or other debris from inside the finisher. 

6. Open the staple cartridge clamp by pulling firmly in the direction shown. 

 
7. Remove the jammed staples (1), then push the clamp in the direction shown until it snaps into the 

locked position (2). 
 

 WARNING: The points of the jammed staples are sharp. Remove the jammed staples carefully. 
 

1

2

 
8. Grip the staple cartridge by the orange handle and insert it into the stapler until it clicks to lock in 

place. 

 
9. Close the finisher front door. 
 
 

Clearing Booklet Staple Jams in the Office Finisher LX 

The stapler in the booklet maker uses two staple cartridges labeled R2 and R3. Booklet stapling requires 
that both staple cartridges be free of jammed staples. 
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 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Open the finisher side cover. 

 
2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening and 

slide them to the center. 

 
3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher. 

 
4. Remove the jammed staples by pulling them in the direction shown. 
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5. Hold the tabs on both sides of the new staple cartridge and insert it into the original position in the 
finisher. 

 

Note: If you have trouble inserting the cartridge, make sure the staples are positioned correctly in the 
cartridge. 

 
 

Note: The Booklet Maker uses two staple cartridges. Booklet stapling requires that both staple 
cartridges contain staples. 

 

6. Starting at Step 2, repeat the procedure for the other staple cartridge. 

7. Close the side cover of the finisher. 
 
 

Clearing Main Staple Jams in the Professional Finisher 
 

 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Open the front door of the finisher. 

 
2. Hold the staple cartridge unit by orange lever R1 and push it to the right. 
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3. Grip the staple cartridge by the orange tabs and remove the cartridge by pulling it firmly toward you. 
Check inside the finisher for any loose staples and remove them. 

 
4. Open the staple cartridge clamp by pulling firmly in the direction shown. 

 
5. Remove the jammed staples (1), then push the clamp in the direction shown until it snaps into the 

locked position (2). 
 

 WARNING: The points of the jammed staples are sharp. Remove the jammed staples carefully. 
 

1

2

 
6. Grip the staple cartridge by the orange tabs and insert it into the staple cartridge unit until it clicks. 

 
7. Close the finisher front door. 
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Clearing Booklet Staple Jams in the Professional Finisher 

The stapler in the booklet maker uses two staple cartridges labeled R2 and R3. Booklet stapling requires 
that both staple cartridges be free of jammed staples. 
  

 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Open the front door of the finisher. 

 
2. While squeezing orange levers R2 and R3 together (1), pull the staple cartridge unit out of the 

finisher until it stops (2). 
 

Note: The staple cartridge unit does not detach from the finisher. 

1 2

 
3. Grip the orange tabs on both sides of the staple cartridge. 
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4. While gripping the orange tabs of the staple cartridge, rotate it in the direction shown. 

 
5. Lift the staple cartridge out of the staple cartridge unit. 

 

 

6. Remove the jammed staples by pulling them in the direction shown. 
 

 WARNING: The points of the jammed staples are sharp. Remove the jammed staples carefully. 

 
7. Push the staple cartridge into the staple cartridge unit. 
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8. If you find no jammed staples, repeat the preceding steps for the other staple cartridge. 

9. Return the staple cartridge unit to its original position. 

 
10. Close the finisher front door. 
 
 

Clearing Hole Punch Jams 

Clearing Hole Punch Jams in Office Finisher LX 

If the printer stops printing and reports a hole punch jam, empty the hole punch waste container. For 
details, see Emptying the Hole Punch Waste Container on page 179. 

After emptying the hole punch waste container, locate and remove any paper jams. 
 

Clearing Hole Punch Jams in the Professional Finisher 

If the printer stops printing and reports a hole punch jam, empty the hole punch waste container. For 
details, see Emptying the Hole Punch Waste Container on page 179. 

After emptying the hole punch waste container, locate and remove any paper jams. 
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Print-Quality Problems 

This section includes: 

 Controlling Print Quality .................................................................................................................................................. 238

 Troubleshooting Print-Quality Problems .................................................................................................................. 241

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/WC75xxsupport. 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

  

Notes: 

 To enhance print quality, the toner/print/drum cartridges for many models of equipment are 
designed to cease functioning at a predetermined point. 

 Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 

  

 
 

Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color 
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer. 
 

Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 

 Use only Xerox® supported paper types and sizes. For details, see Supported Paper on page 38. 

 Use only dry, undamaged paper. 
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 CAUTION: Some paper and other media types can cause poor output quality, increased paper jams, 
or damage your printer. Do not use the following: 

 Rough or porous paper. 

 Inkjet paper. 

 Non-laser glossy or coated paper. 

 Paper that has been photocopied. 

 Paper that has been folded or wrinkled. 

 Paper with cutouts or perforations. 

 Stapled paper. 

 Envelopes with windows, metal clasps, side seams, or adhesives with release strips. 

 Padded envelopes. 

 Plastic media. 
 

 Make sure the paper type selected in your print driver matches the paper type on which you are 
printing. 

 If you have the same size paper loaded in more than one of the trays, make sure that the proper tray 
is selected in the print driver. 

 Store your paper and other media properly for optimum print quality. For details, see Paper Storage 
Guidelines on page 39. 

 

Print-Quality Modes 

Select the correct Print-Quality Mode for your print job from the print driver. For instructions on setting 
the Print-Quality Mode, see Selecting Printing Options on page 59. To control the Print-Quality Mode: 

 Make sure that the Print-Quality Mode is set to the correct mode. For example, if the print appears 
too light, make sure the Print-Quality Mode is not set to Toner Saver mode. The default setting is 
Standard. 

 Use the Print-Quality Mode settings in the print driver to control print quality. If the print quality is 
not suitable, adjust the Print-Quality Mode setting to a higher level. 

 Use only Xerox® supported paper types and sizes. For details, see Supported Paper on page 38. 
 

Color Corrections and Color Adjustments 

Color Correction is set to Automatic at the factory for best printing results of mixed text, graphics, and 
images on a range of supported paper. For instructions on setting the Color Correction, see Using Color 
Corrections on page 65. Follow these guidelines to control the Color Corrections and Color Adjustments: 

 Make sure that the Color Correction in the print driver is set to Automatic for best results on most 
paper. 

 Select a mode of Color Correction to produce more vivid results. For example, when printing graphics 
in which the sky does not look blue enough, select Vivid for more vibrant blue skies. 

 Select a Custom Color Adjustment, such as Office Color, Press Match, or Spot Color, to match the 
color output to another output device. 
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 Select Color Adjustments to adjust particular characteristics of the printed color, such as Lightness, 
Contrast, Saturation, and Color Casts, to achieve a desired result. 
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Troubleshooting Print-Quality Problems 

This section includes: 

 Printing the Troubleshooting Print-Quality Pages ............................................................................................... 241

 Eliminating the Paper or Media as the Problem ................................................................................................... 241

 Isolating the Problem to the Printer or to the Application ............................................................................... 242

 Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server .................... 242

 Troubleshooting Print-Quality Problems in the Printer ...................................................................................... 243

 Performing the Print Calibration Procedure ........................................................................................................... 243

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/WC75xxsupport. 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

  

Note: To enhance the print quality, toner/print/drum cartridges for many models of equipment are 
designed to cease functioning at a predetermined point. 

 

 
 

Printing the Troubleshooting Print-Quality Pages 

1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 

2. Touch Troubleshooting > Support Pages. 

3. Touch Troubleshooting Print Quality Page, then touch Print. 

4. Compare your print-quality problems to the examples on the pages. 
 
 

Eliminating the Paper or Media as the Problem 

Damaged or unsupported paper or media can cause print-quality problems even when the printer, 
application, and print driver are working perfectly. Use the following guidelines to eliminate the paper as 
the source of the print-quality problem: 

 Make sure that the printer supports the paper or media. 

 Make sure that the printer is loaded with undamaged, dry paper. 

 If the condition of the paper or media is in doubt, replace it with new paper or media. 

 Make sure that you have the proper tray selected in the print driver and from the control panel. 

 Make sure that you have the correct paper type selected in the print driver and in the control panel of 
the printer. 
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Isolating the Problem to the Printer or to the Application 

When you are sure that the paper is supported and in good condition, use the following steps to isolate 
the problem: 

1. From the control panel of the printer, print the pages for Diagnosing Print Quality. For details, see 
Printing the Troubleshooting Print Quality Pages on page 241. 

 If the pages printed properly, the printer is working properly and the print-quality problem is an 
application, print driver, or print server problem. 

 If the pages still have print-quality problems, the problem is in the printer. 

2. If the pages printed properly, see Troubleshooting Print-Quality Problems in the Application, Print 
Driver, or Print Server. 

3. If the pages still had print-quality issues, or did not print, see Troubleshooting Print-Quality Problems 
in the Printer. 

 
 

Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print 
Server 

If the printer is printing properly from the control panel but you still have print-quality problems, the 
application, print driver, or print server could be the cause. 

To isolate the problem: 

1. Print a similar document from another application and look for the same print-quality problems. 

 If the document still has the same print-quality problems, it is probably a print driver or print 
server problem. If the problem persists, go to step 2. 

 If the document printed without print-quality problems, the application is probably the cause. 
Restart your printer, restart the application, and print the document again. If the problem 
persists, go to step 5. For more information, see Restarting the Printer on page 197. 

2. Check the print driver used for the print job. 

3. Click Start > Settings > Printers and Faxes. 

4. Right-click on the name of the printer. 

5. Select Properties from the drop-down list. 

 Make sure the model name in the middle of the driver matches the model name of the printer. 

 If the names do not match, install the proper print driver for the printer. 

6. If the print driver is correct, see Selecting Printing Options on page 59 to set the Print Quality Mode 
and Color Correction. 

 Set the Print Quality Mode to Standard or Enhanced. 

 Set the Color Correction to Automatic Color Correction. 

7. If the problem persists, delete then reinstall the print driver. 

8. If the problem still persists, make sure that you are not printing through a print server. 

Try printing directly to the printer. 

If the problem persists, go to www.xerox.com/office/WC75xxsupport for online support information. 
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Troubleshooting Print-Quality Problems in the Printer 

If you have print-quality problems when printing a Demo Page or the Configuration Report from the 
control panel, the problem is in the printer. 

To find the source of the problem: 

1. At the control panel, print the Troubleshooting Print-Quality Pages. For details, see Printing the 
Troubleshooting Print Quality Pages on page 241. 

2. If the prints are too light to see print details, verify the following: 

 The printer is loaded with undamaged, dry supported paper. 

 The toner levels of one or more of the toner cartridges is not too low. 

3. If the pages are printed with a solid color, one or more of the drum cartridges could be defective. 
Correct the problem before continuing. 

4. If the colors of the pages do not match your expectations, run the control panel Print Calibration. 

5. Compare the print-quality problems in your document to each of the examples in the 
Troubleshooting Print-Quality Pages. 

If you find a match in the Troubleshooting Print-Quality Pages, look in the Solutions column for the action 
to take to resolve the problem. 

If the problem persists, go to www.xerox.com/office/WC75xxsupport for online support information. 

 
 

Performing the Print Calibration Procedure 

1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 

2. Touch Troubleshooting > Calibration > Print Calibration. 

3. Follow the onscreen instructions to run the Print Calibration procedure. 
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Copy and Scan Problems 

If the copy or scan quality is poor, refer to the following table. 
 

Symptoms Solutions 

Lines or streaks only present in copies made 
from the document feeder. 

There is debris on the document glass. When scanning, the paper 
from the document feeder passes over the debris creating lines or 
streaks. Clean all glass surfaces with a lint free cloth. 

Spots present in copies taken from the 
document glass. 

There is debris on the document glass. When scanning, the debris 
creates a spot on the image. Clean all glass surfaces with a lint free 
cloth. 

The reverse side of the original is showing on 
the copy or scan. 

Turn on Background Suppression. 

Image is too light or too dark.  Copy: Use the Image Quality settings to lighten, darken, or 
adjust contrast. 

 Scan: Use the Advanced Settings Tab to lighten, darken, or 
adjust contrast. 

Colors are inaccurate.  Copy: Use the Image Quality settings to adjust color balance. 
 Scan: Confirm the correct Original Type is set. 

If the problem persists, go to www.xerox.com/office/WC75xxsupport for online support information. 
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Fax Problems 

This section includes: 

 Problems Sending Faxes ................................................................................................................................................. 245

 Problems Receiving Faxes .............................................................................................................................................. 246
 

Note: If you cannot send and receive faxes, make sure that you are connected to an approved analog 
telephone line. The fax cannot send or receive when connected to a digital phone line. 

If you cannot send or receive faxes correctly, refer to the following tables. 

 
 

Problems Sending Faxes 
 

Symptoms Causes Solutions 

The document is not scanned 
using the document feeder. 

The document is too thick, too thin, or 
too small. 

Use the document glass to send the 
fax. 

The document is scanned at an 
angle. 

The document feeder guides are not 
adjusted to the width of the document.

Adjust the document feeder guides to 
fit the width of the document. 

The fax received by the recipient 
is blurry. 

The document is incorrectly positioned. Position the document correctly. 

The document glass is dirty. Clean the document glass. 

The text in the document is too light. Adjust the resolution. Adjust the 
contrast. 

There is a problem with the telephone 
connection. 

Verify that the telephone line is 
working, then send the fax again. 

There is a problem with the fax 
machine of the caller. 

Make a copy to verify that your printer 
is operating correctly. If the copy was 
printed correctly, have the recipient 
verify the condition of their fax 
machine. 

The fax received by the recipient 
is blank. 

The document was loaded incorrectly.  Document feeder: Place the original 
document face up. 

 Document glass: Place the original 
document face down. 

Fax was not transmitted. The fax number is wrong. Verify the fax number. 

The telephone line is incorrectly 
connected. 

Verify the telephone line connection. If 
it is disconnected, connect it. 

There is a problem with the fax 
machine of the recipient. 

Contact the recipient. 

The fax is not installed or is not 
enabled. 

Verify that the fax is installed and 
enabled. 
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Server Fax is enabled. Make sure that Server Fax is disabled. 

If the problem persists, go to www.xerox.com/office/WC75xxsupport for online support information. 

 
 

Problems Receiving Faxes 
 

Symptoms Causes Solutions 

The received fax is blank. There is a problem with the telephone 
connection or with the fax machine of 
the caller. 

Verify that the printer can make clean 
copies. If it can, have the caller send the 
fax again. 

The sender loaded the pages 
incorrectly. 

Contact the sender. 

The printer answers the call, but 
does not accept incoming data. 

Not enough memory. If the job contains several graphics, the 
printer could not have enough memory. 
The printer does not answer when 
memory is low. Delete stored 
documents and jobs then wait for the 
existing job to complete. This increases 
available memory. 

The received fax size is reduced. The paper supply in the printer does 
not match the document size sent. 

Confirm the original size of the 
documents. Documents could be 
reduced based on the available paper 
supply in the printer. 

Faxes cannot be received 
automatically. 

The printer is set to receive faxes 
manually. 

Set the printer to automatic reception. 

The memory is full. Load paper if it is empty, and then print 
the faxes stored in the memory. 

The telephone line is incorrectly 
connected. 

Verify the telephone line connection. If 
it is disconnected, connect it. 

There is a problem with the fax 
machine of the sender. 

Make a copy to verify that your printer 
is operating correctly. If the copy prints 
correctly, have the recipient verify their 
fax machine is operating correctly. 

If the problem persists, go to www.xerox.com/office/WC75xxsupport for online support information. 
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Getting Help 

This section includes: 

 Control Panel Messages .................................................................................................................................................. 247

 Scan and Fax Alerts ........................................................................................................................................................... 248

 Maintenance Assistant .................................................................................................................................................... 248

 Online Support Assistant ................................................................................................................................................ 249

 More Information .............................................................................................................................................................. 249

Xerox® provides several automatic diagnostic utilities to help you maintain productivity and print quality. 

 
 

Control Panel Messages 

The printer control panel provides information and troubleshooting help. When an error or warning 
condition occurs, the control panel displays a message informing you of the problem. In many cases, the 
control panel also displays an animated graphic showing the location of the problem, such as the location 
of a paper jam. For many error and status messages, the control panel Help provides additional 
information. 
 

Control Panel Help 

Touch the Help button to view additional information about error or status messages on the control 
panel. The Help button is labeled with a question mark symbol (?). 

–

1

0

C

7

PQRS

4

GHI

2

ABC

3

DEF

5

JKL

6

MNO

8

TUV

9

WXYZ

#

 

Most of the control panel menu items also have associated help text that describes the menu item. 
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Scan and Fax Alerts 

Alerts provide messages and instructions that help you solve problems when printing, faxing, or scanning. 
Alerts appear on the control panel touch screen, or you can view them through CentreWare Internet 
Services. 
 

Note: Fax errors do not prevent scanning, copying, or printing. 
  
 

Viewing Job Status on the Control Panel 

To see the status of a list of active jobs or completed jobs, press the Job Status button. 

 Touch the Active Jobs tab to see the status of the active jobs that are printing. 

 Touch the Completed Jobs tab to see the status of the last 20 jobs that were completed. 
 

Viewing Error Messages on the Control Panel 

1. Press the Machine Status button, then touch the Faults tab. 

2. Touch one of the buttons to view a list of alerts: 

 Current Faults: Current faults that affect the operation of the printer, such as a paper jam. 

 Current Messages: Alert messages regarding the current job status of the printer, such as an 
empty paper tray. 

 Fault History: The last 20 fault alerts. 

 Fault Code: The fault code for the error that affected printer operation. 

 Date: The date when the error occurred. 

 Time: The time of the day when the error occurred. 

 Image Count: The image count on the printer when the error occurred. 

 Paper: The paper that was used when the error occurred. 
 

Viewing Alerts in CentreWare Internet Services 

See Accessing CentreWare Internet Services to access the embedded Web server in the printer. 

1. In CentreWare Internet Services, click Status > Description & Alerts. 
The Description and Alerts page appears. 

2. Click Refresh to update the page. 
 

Maintenance Assistant 

Your printer includes a built-in diagnostic capability allowing you to send diagnostic information directly 
to Xerox. Maintenance Assistant is a remote diagnostic tool that offers a fast way to resolve potential 
issues, receive assistance, and automate the troubleshooting or repair process. 

Use Maintenance Assistant only when requested to do so by a Xerox representative. 
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Online Support Assistant 

Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve 
printer problems. You can find solutions for print-quality problems, paper jams, software installation 
problems, and more. Online assistance offers the latest technical solutions and illustrated step-by-step 
operational tips. 

To access the Online Support Assistant, go to www.xerox.com/office/WC75xxsupport . 
 

More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with printer 

Quick Use Guide Packaged with printer 

System Administrator Guide www.xerox.com/office/WC75xxdocs  

Video Tutorials www.xerox.com/office/WC75xxdocs  

Recommended Media List United States: www.xerox.com/paper  
Europe: www.xerox.com/europaper  

Technical support information for your printer; includes 
online Technical Support, Online Support Assistant, and 
driver downloads. 

www.xerox.com/office/WC75xxsupport  

Information about menus or error messages Control panel Help (?) button 

Information pages Print from the control panel menu 

Order supplies for your printer www.xerox.com/office/WC75xxsupplies  

A resource for tools and information, such as interactive 
tutorials, printing templates, helpful tips, and customized 
features to meet your individual needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and support center www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
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Printer Configurations and Options 

Standard Features 

The WorkCentre 7500 Series Multifunction Printer provides the following features: 

 Copy, print, scan, fax, Internet Fax, and Server Fax 

 Scan to USB and Print from USB mass storage devices 

 Maximum copy speed of up to 50 pages per minute (ppm) for color and up to 55 ppm black and 
white copying on letter size plain paper (speed dependent on configuration) 

 1200 x 2400 dpi LED imaging and copy quality 

 Copy document sizes up to A3 or 11 x 17 in. 

 Print document size up to SRA3/12 x 18 in. 

 Automatic 2-sided printing 

 Duplex Automatic Document Feeder with 110-sheet capacity 

 Color touch screen display on control panel 

 Tray 1 with 520-sheet capacity 

 Must choose one of the following paper tray options: 

 3-Tray Module with standard SRA3/12 x 18 in. support 

 1-Tray Module with standard SRA3/12 x 18 in. support 

 High-Capacity Tandem Tray with standard SRA3/12 x 18 in. support, 2000 A4/Letter sheets 

 Bypass Tray with 100-sheet capacity 

 2 GB memory plus 1 GB page memory 

 Internal 160 GB hard drive 

 PostScript and PCL fonts 

 Ethernet 10/100/1000Base-TX 

 Universal Serial Bus (USB 2.0) 

 PostScript, PCL, and XPS support 

 Job Based Accounting 

 Data Security 

 Xerox Extensible Interface Platform® (EIP) 
 

Available Configurations 
 

Model Print Speed in ppm 

(1-sided and 2-sided) 

WorkCentre 7525 Multifunction Printer 25 color/25 monochrome 

WorkCentre 7530 Multifunction Printer 30 color/30 monochrome 
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WorkCentre 7535 Multifunction Printer 35 color/35 monochrome 

WorkCentre 7545 Multifunction Printer 45 color/45 monochrome 

WorkCentre 7556 Multifunction Printer 50 color/55 monochrome 
 
 

Options and Upgrades 
 Integrated Finisher 

 Office Finisher LX 

 Professional Finisher 

 Envelope Tray 

 3-Tray Module with standard SRA3/12 x 18 in. support 

 1-Tray Module with standard SRA3/12 x 18 in. support 

 High-Capacity Tandem Tray with standard SRA3/12 x 18 in. support, 2000 A4/Letter sheets 

 High-Capacity Feeder 

 Standard Work Surface 

 One Line and Dual Line Fax Kits 

 Xerox Secure Access Unified ID System® 

 FreeFlow SMARTsend 

 Convenience Stapler 

 Xerox® Common Access Card Enablement Kit 

 Xerox® Copier Assistant (XCA) 

 Foreign Device Interface 

 Scan to PC Desktop 

 EFI Workflow 

 Unicode Print 
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Physical Specifications 

Base Configuration 
 Width: 1063.8 mm (41.8 in.) 

 Depth: 685 mm (27 in.) 

 Height: 1127.3 mm (44.4 in.) 

 Weight: 140.2 Kg (308.4 lb.) with 3-Tray Module 
 

Configuration With Integrated Finisher 
 Width: 1129 mm (44.4 in.) 

 Depth: 685 mm (27 in.) 

 Height: 1127.3 mm (44.4 in.) 

 Weight: 152.2 Kg (335 lb.) with 3-Tray Module 
 

Configuration With Office Finisher LX and Booklet Maker 
 Width: 1666 mm (65.6 in.) 

 Depth: 685 mm (27 in.), 695 mm (27.4 in.) with Booklet Maker 

 Height: 1127.3 mm (44.4 in.) 

 Weight: 177.2 Kg (390 lb.) with 3-Tray Module 
 

Configuration With Professional Finisher 
 Width: 1922 mm (75.7 in.) 

 Depth: 685 mm (27 in.) 

 Height: 1127.3 mm (44.4 in.) 

 Weight: 228.2 Kg (502 lb.) with 3-Tray Module 
 

Configuration With Professional Finisher and High-Capacity Feeder 
 Width: 1922 mm (75.7 in.) 

 Depth: 685 mm (27 in.) 

 Height: 1127.3 mm (44.4 in.) 

 Weight: 256.4 Kg (564 lb.) with 3-Tray Module 
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Clearance Requirements 

Printer Clearance Requirements for Base Configuration 
 

Note: The clearance requirements do not change with the addition of the optional Integrated 
Finisher. 

 

30.7 cm
(12.1 in.)

10 cm
(3.9 in.)

177.8 cm
(70.0 in.)

206.7 cm
(81.4 in.)

 
 

Printer Clearance Requirements With Office Finisher LX and Booklet Maker 

10 cm
(3.9 in.)

206.7 cm
(81.4 in.) 217.4 cm

(86.0 in.)

88.5 cm
(34.8 in.)
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Printer Clearance Requirements With Professional Finisher 

243 cm
(96 in.)

10 cm
(3.9 in.)

206.7 cm
(81.4 in.)

114.1 cm
(45 in.)

 
 

Printer Clearance Requirements With Professional Finisher and High-Capacity Feeder 

243 cm
(96 in.)

10 cm
(3.9 in.)

206.7 cm
(81.4 in.)

114.1 cm
(45 in.)
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Environmental Specifications 

Temperature 
 10°–28°C 

 50°–82°F 
 

Relative Humidity 

Operating: 15% to 85% (non-condensing) 
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Electrical Specifications 

Power Supply Voltage Frequency 
 

Current Required Power Consumption 
(full system) 

110–127 VAC +/-10% 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

13.2 A 1584 VA @ 120 V (Max) 

220–240 VAC +/-10% 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

8 A 1920 VA @ 240 V (Max) 
1760 VA @ 220 V (Max) 

 
 

ENERGY STAR Qualified Product 

 
 
 
 

 

The Xerox® WorkCentre 7500 Series of Multifunction Printers are ENERGY STAR® 
qualified under the ENERGY STAR Program Requirements for Imaging Equipment. 

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between United States, 
European Union, and Japanese governments and the office equipment industry to 
promote energy-efficient copiers, printers, fax, multifunction printers, personal 
computers, and monitors. Reducing product energy consumption helps combat smog, 
acid rain, and long-term changes to the climate by decreasing the emissions that result 
from generating electricity. 

Xerox® ENERGY STAR equipment is preset at the factory to switch to Energy Saver Mode after two 
minutes from the last copy or print. For details, see Energy Saver Mode on page 24. 
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Performance Specifications 

Printing Resolution 

Maximum Resolution: 1200 x 2400 dpi 
 

Print Speed 

Print speeds are provided for printing long-edge feed (LEF) on A4 (210 x 297 mm, 8.27 x 11.69 in.) or 
Letter (216 x 279 mm, 8.5 x 11 in.) Bond 64–105 g/m2 (18–28 lb.) paper from any tray except tray 5 
(bypass tray). 
  

Printer Model Color Black and White 

WorkCentre 7525 Multifunction Printer 25 ppm 25 ppm 

WorkCentre 7530 Multifunction Printer 30 ppm 30 ppm 

WorkCentre 7535 Multifunction Printer 35 ppm 35 ppm 

WorkCentre 7545 Multifunction Printer 45 ppm 45 ppm 

WorkCentre 7556 Multifunction Printer 50 ppm 55 ppm 
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Controller Specifications 

Processor 

1.5 GHz processor 
 

Memory 
 

Memory Technology Size Clock Speed Specifications 

System Memory DDR2, non-ECC 2 GB 333 MHz 200-pin SODIMM, 
667 MWords/s 

EPC Memory DDR2, non-ECC 1 GB 133 MHz 200-pin SODIMM, 
267 MWords/s, 32 b wide 

Flash Memory EEPROM 32 MB NA Daughter card. Derived from 
the Gawain FLASH/NVM. NVM SRAM 512 KB NA 

JPEG Buffer SRAM 1 MB (256 Kb*32) 200 MHz Soldered to PWBA. 
 
 

Interfaces 
 Ethernet 10/100/1000Base-TX 

 Universal Serial Bus (USB 2.0) 
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox® product and supplies, 
contact the following customer help lines: 

United States: 1-800 828-6571 

Canada: 1-800 828-6571 

Europe: +44 1707 353 434 

For product safety information in the United States, go to www.xerox.com/environment . 

For product safety information in Europe, go to www.xerox.com/environment_europe . 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these 
instructions, it may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user will be required to correct 
the interference at his/her own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures: 

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and receiver. 

 Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected. 

 Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 
 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 
 

Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
 

European Union 
 

 CAUTION: This is a Class A product. In a domestic environment, this product can cause radio 
interference in which case the user could be required to take adequate measures. 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with 
the following applicable Directives of the European Union as of the dates indicated: 

 December 12, 2006: Low Voltage Directive 2006/95/EC 
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 December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

To ensure compliance with European Union regulations, use shielded interface cables. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment . In other 
markets, please contact your local Xerox® representative or go to www.xerox.com/environment_europe . 
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Copy Regulations 

United States 

Congress, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 

1. Obligations or Securities of the United States Government, such as: 

 Certificates of Indebtedness. 

 National Bank Currency. 

 Coupons from Bonds. 

 Federal Reserve Bank Notes. 

 Silver Certificates. 

 Gold Certificates. 

 United States Bonds. 

 Treasury Notes. 

 Federal Reserve Notes. 

 Fractional Notes. 

 Certificates of Deposit. 

 Paper Money. 

 Bonds and Obligations of certain agencies of the government, such as FHA and so on. 

 Bonds. United States Savings Bonds may be photographed only for publicity purposes in 
connection with the campaign for the sale of such bonds. 

 Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a 
canceled revenue stamp, this may be done provided the reproduction of the document is 
performed for lawful purposes. 

 Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white and is less than 75% or more 
than 150% of the linear dimensions of the original. 

 Postal Money Orders. 

 Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States. 

 Stamps and other representatives of value, of whatever denomination, which have been or may 
be issued under any Act of Congress. 

 Adjusted Compensation Certificates for Veterans of the World Wars. 
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2. Obligations or Securities of any Foreign Government, Bank, or Corporation. 

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the 
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. 
Further information of these provisions may be obtained from the Copyright Office, Library of 
Congress, Washington, D.C. 20559. Ask for Circular R21. 

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be 
photographed. 

5. Passports. Foreign Passports may be photographed. 

6. Immigration papers. 

7. Draft Registration Cards. 

8. Selective Service Induction papers that bear any of the following Registrant’s information: 

 Earnings or Income. 

 Court Record. 

 Physical or mental condition. 

 Dependency Status. 

 Previous military service. 

 Exception: United States military discharge certificates may be photographed. 

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the 
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the 
head of such department or bureau). 

Reproducing the following is also prohibited in certain states: 

 Automobile Licenses. 

 Drivers’ Licenses. 

 Automobile Certificates of Title. 

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case 
of doubt, consult your attorney. 

For more information about these provisions contact the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21. 
 

Canada 

Parliament, by stature, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 

 Current bank notes or current paper money 

 Obligations or securities of a government or bank 

 Exchequer bill paper or revenue paper 

 The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a 
court of law 

 Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause 
same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer for 
a province) 
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 Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a 
province, the government of a state other than Canada or a department, board, Commission, or 
agency established by the Government of Canada or of a province or of a government of a state 
other than Canada 

 Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a 
province or by the government of a state other than Canada 

 Documents, registers, or records kept by public officials charged with the duty of making or issuing 
certified copies thereof, where the copy falsely purports to be a certified copy thereof 

 Copyrighted material or trademarks of any manner or kind without the consent of the copyright or 
trademark owner 

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is 
assumed for its completeness or accuracy. In case of doubt, consult your solicitor. 
 

Other Countries 

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be 
imposed on those found guilty of making such reproductions. 

 Currency notes 

 Bank notes and checks 

 Bank and government bonds and securities 

 Passports and identification cards 

 Copyright material or trademarks without the consent of the owner 

 Postage stamps and other negotiable instruments 

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel. 
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Fax Regulations 

United States 

Fax Send Header Requirements 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or 
other electronic device, including a fax machine, to send any message unless such message clearly 
contains in a margin at the top or bottom of each transmitted page or on the first page of the 
transmission, the date and time it is sent and an identification of the business or other entity, or other 
individual sending the message and the telephone number of the sending machine or such business, 
other entity, or individual. The telephone number provided may not be a 900 number or any other 
number for which charges exceed local or long-distance transmission charges.  

For instructions on programming the Fax Send Header information, refer to the section of the System 
Administrator Guide on Setting Transmission Defaults. 
 

Data Coupler Information 

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the 
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, 
this number must be provided to the Telephone Company. 

A plug and jack used to connect this equipment to the premises wiring and telephone network must 
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant 
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack 
that is also compliant. See installation instructions for details. 

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the 
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation 
instructions for details. 

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected 
to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response 
to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain 
of the number of devices that can be connected to a line, as determined by the RENs, contact the local 
Telephone Company. For products approved after July 23, 2001, the REN is part of the product identifier 
that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal 
point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label. 

To order the correct service from the local Telephone Company, you could also have to quote the codes in 
the following list: 

 Facility Interface Code (FIC) = 02LS2 

 Service Order Code (SOC) = 9.0Y 
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 CAUTION: Ask your local Telephone Company for the modular jack type installed on your line. 
Connecting this machine to an unauthorized jack can damage telephone company equipment. You, 
not Xerox, assume all responsibility and/or liability for any damage caused by the connection of this 
machine to an unauthorized jack. 

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could 
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not 
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the Telephone 
Company interrupts your service, they can advise you of your right to file a complaint with the FCC if you 
believe that it is necessary. 

The Telephone Company could change its facilities, equipment, operations, or procedures which could 
affect the operation of the equipment. If the Telephone Company changes something that affects the 
operation of the equipment, they should notify you in order for you to make necessary modifications to 
maintain uninterrupted service. 

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for 
repair or warranty information. Contact information is contained in the Machine Status menu on the 
printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing 
harm to the telephone network, the Telephone Company may request you to disconnect the equipment 
until the problem is resolved. 

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make 
repairs to the printer. This applies at any time during or after the service warranty period. If unauthorized 
repair is performed, the remainder of the warranty period is null and void. 

This equipment must not be used on party lines. Connection to party line service is subject to state tariffs. 
Contact the state public utility commission, public service commission, or corporation commission for 
information. 

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that 
the installation of this Xerox® equipment does not disable your alarm equipment. 

If you have questions about what could disable alarm equipment, consult your Telephone Company or a 
qualified installer. 
 

Canada 

This product meets the applicable Industry Canada technical specifications. 

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or 
alterations made by the user to this device, or device malfunctions, could cause the telecommunications 
company to request you to disconnect the equipment. 

For user protection, make sure that the printer is properly grounded. The electrical ground connections of 
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected 
together. This precaution could be vital in rural areas. 
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 WARNING: Do not attempt to make such connections yourself. Contact the appropriate electric 
inspection authority, or electrician, to make the ground connection. 

The REN assigned to each terminal device provides an indication of the maximum number of terminals 
allowed to be connected to a telephone interface. The termination on an interface could consist of any 
combination of devices. The only limitation to the number of devices is the requirement that the sum of 
the RENs of the devices does not exceed 5. For the Canadian REN value, please see the label on the 
equipment. 
 

European Union 

Radio Equipment and Telecommunications Terminal Equipment Directive 

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European 
single terminal connection to the public switched telephone network (PSTN). However, due to differences 
between the individual PSTNs provided in different countries, the approval does not give an 
unconditional assurance of successful operation on every PSTN network terminal point. 

In the event of a problem you should contact your authorized local dealer. 

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal 
equipment for use on analog-switched telephone networks in the European Economic Area. This product 
provides a user-adjustable setting of the country code. The country code should be set prior to connecting 
this product to the network. Refer to the customer documentation for the procedure for setting the 
country code. 
 

Note: Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, we 
recommend that you set it to use DTMF signaling for more reliable and faster call setup. Modification 
of this product, connection to external control software, or connection to an external control 
apparatus not authorized by Xerox® will invalidate its certification. 

 
 

New Zealand 
1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has 

accepted that the item complies with minimum conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not 
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it 
provides no assurance that any item will work correctly in all respects with another item of 
Telepermitted equipment of a different make or model. 

The equipment may not be capable of correct operation at the higher data speeds designated. 
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to 
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such 
circumstances. 
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2. Immediately disconnect this equipment should it become physically damaged, then arrange for its 
disposal or repair. 

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom 
customers. 

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is 
no guarantee that Telecom lines will always continue to support pulse dialing. 

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may 
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems, 
do not contact the Telecom Faults Service. 

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is 
readily available on almost all New Zealand telephone exchanges. 

 

 WARNING: No '111' or other calls can be made from this device during a mains power failure. 

7. This equipment may not provide for the effective hand-over of a call to another device connected to 
the same line. 

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on 
the equipment (computer) associated with this device. The associated equipment shall be set to 
operate within the following limits for compliance with Telecom Specifications: 

For repeat calls to the same number: 

 There shall be no more than 10 call attempts to the same number within any 30 minute period 
for any single manual call initiation, and 

 The equipment shall go on-hook for a period of not less than 30 seconds between the end of 
one attempt and the beginning of the next attempt. 

For automatic calls to different numbers: 
The equipment shall be set to ensure that automatic calls to different numbers are spaced such that 
there is no less than five seconds between the end of one call attempt and the beginning of another. 

9. For correct operation, total of the RNs of all devices connected to a single line at any time should not 
exceed five. 
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Product Safety Certification 

The following Agency certified this product using the Safety standards listed: 
 

Agency Standard 

TUV UL60950-1, 2nd Edition  

IEC/EN60950-1, 2nd Edition 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 

 North America: www.xerox.com/msds  

 European Union: www.xerox.com/environment_europe  

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts . 
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All Countries 

If you are managing the disposal of your Xerox® product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply, please see 
www.dtsc.ca.gov/hazardouswaste/perchlorate . 
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox® product is part of the program. For more information 
about Xerox® environmental programs, visit www.xerox.com/environment, or for recycling and disposal 
information, contact your local authorities. 
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you 
must dispose of this equipment in compliance with agreed national 
procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents mean 
that used electrical and electronic products and batteries should not be 
mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 2002/96/EC 
and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items.  

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Note for the Battery Symbol 

Hg  

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by 
the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a MANUFACTURER-approved service facility. 
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Other Countries 

Please contact your local waste management authority to request disposal guidance. 

 


